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1 Introduction

Editor window.

Introduction to the TatukGIS Editor and free Viewer products

The TatukGIS Editor is programmable, general purpose GIS desktop mapping and data editing
application with advanced functionality. The free TatukGIS Viewer is the same as Editor with
regard to GIS viewing features, i.e., opening and viewing GIS files and projects, on-the-fly layer
reprojection between coordinate systems, spatial and attribute queries, saving projects, and much
more. Unlike the Editor, the free Viewer omits all features (and menu items) relating to editing,
creating, or exporting data and the Viewer is not programmable, i.e., it cannot be customized or
extended with the use of scripts. 

Because the Editor and Viewer products are so similar, the same documentation is provided for
both products. Each use of the term Editor in the documentation can be regarded to mean both
the Editor and Viewer products, except for the features that are omitted from the Viewer.

Viewing data
The Editor and Viewer open most GIS/CAD vector map files, raster maps, aerial images, grid data,
and SQL database layers such as Oracle Spatial or PostGIS coverages. Both products can open 
TatukGIS projects and most ESRI ArcView v.3 or MapInfo Professional projects and projects
exported from ESRI ArcGIS/ArcMap using the free Arc2TatukGIS plug-in. Each data type is
supported “natively’, so there is no need to import data into any internal format. Comprehensive
visual layer property and legend controls provide for deep customization of the appearance of each
map layer, thematic mapping, layer hierarchies, legend presentation, scale … The Editor and
Viewer support advanced selection and query features, including SQL Query Builder.

Coordinate systems
The Editor and Viewer support nearly 3,000 pre-defined map coordinate systems in use around
the world (including all the U.S. State Planes), user-defined coordinate systems based on 120
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supported projections, automatic layer coordinate system recognition and on-the-fly conversion of
vector and raster layers from multiple coordinate systems for display as a single map. The support
reflects EPSG codes and OpenGIS WKT coordinate system definition. The Editor can export map
data to any selected coordinate system. 

Editing data
The Editor contains features to create, edit, save, and import/export GIS map files and
import/export attribute data between vector map layers and external databases. The Editor can be
used as a conversion tool to translate map layers between supported file types and/or coordinate
systems. Special tools include the topology builder/corrector to systematically clear geometry
related errors (overlapping polygons, holes between polygons, missed line intersections, dangling
nodes, etc.) from vector line or polygon layers.

Scripting
The Editor is a fully scriptable IDE for writing and debugging code. Using Basic or Pascal scripts,
the Editor functionality can be enhanced or modified, including full menu redesign, custom dialog
boxes, etc., for end-user custom applications. The scripting engine exposes (inside the Editor) the
full power of the TatukGIS Developer Kernel, with its hundreds of classes and thousands of
methods, to fulfill the requirements of any kind of GIS application. Dozens of example scripts are
provided, e.g., to perform Google or Bing maps integration, GPS tracking on a projected map,
batch (command line) conversions between coordinate systems, and various tutorial examples. 
The special features or customizations can be distributed (deployed) to other Editor licensed users
just by sharing the scripts.

Databases
The Editor is compatible with leading database engines, e.g., MSSQL Server, MSJET, Oracle,
DB2, Interbase, PostgreSQL… and most 3rd party SQL database map layer formats, e.g., MSSQL
2008 Spatial, ESRI ArcSDE, ESRI ArcSDE Raster, ESRI Personal Geodatabase, MapInfo
SpatialWare, Oracle Spatial/Locator, Oracle GeoRaster, Geomedia SQL Server, PostGIS,
OpenGIS Simple Features …. The Editor supports live joins of  vector map layers to external
database tables, as well as data import/export with external databases.

Documentation and Help Material
Documentation and help material for the Editor product are available from the following places:

· The Help system provides a brief description of the feature or functionality called by each menu
item of the Editor's user interface, along with instructions how to use the feature. The Help files
are found under the Help/Help menu.

· A number of Editor/Viewer version 2.x tutorials are available on-line at the link: 
http://www.tatukgis.com/Landing/EDT/Tutorials. Additional tutorials will be added to this on-line
resource over time.

· Editor/Viewer related FAQ items are available in the searchable FAQ material on the
www.tatukgis.com web site.

· Registered licensed users have read/write access to the Editor licensed user forum, which is
located on the Forums page of the www.tatukgis.com web site.

Check for Updates
The Editor is updated from time to time with improvements, new features, and bug fixes. Product
updates may be downloaded via the internet directly from the TatukGIS web site. Information
about availability of a new version are presented on a Welcome Page. When in regular use, the
program automatically checks for the availability of an update once per week. (The automatic
check for update feature can be deactivated by unchecking the Autocheck feature under the
Help/Check for updates menu item.). 

Bug Reporting Feature
The Editor includes the bug/error reporting tool. If an error is encountered with the use of the
program, the Editor will attempt to send an e-mail documenting the problem to TatukGIS using the
default e-mail client on the user's computer. Please allow any such error reporting e-mails to be
sent. This is much more effective than attempting to manually explain a problem to TatukGIS.
Typically the sending of an error reporting e-mail results in TatukGIS having the problem fixed in

http://www.tatukgis.com/Landing/EDT/Tutorials
http://www.tatukgis.com
http://www.tatukgis.com
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the next product update.

Best performance with large data sets
As long as a few settings are properly optimized, the Editor is very fast handing even with the
largest data sets and projects. Performance optimization tips with large data sets can be found in
item Q10716/KBQ10716 in the FAQ material on the www.tatukgis.com web site. 

License
Use of the TatukGIS Editor requires the purchase of one license per each computer. The
TatukGIS Viewer is a free product which may be used without the purchase of a license. The
TatukGIS Editor and Viewer products are owned by the company TatukGIS. The terms of use of
these products are governed by the TatukGIS license agreement.

2 User Interface

The screenshot below presents the standard locations of the Editor user interface elements as well
as their names used further in this help system.

For detailed information refer to the following help topics and their subtopics:
· Menu,
· Standard toolbar,
· Map area,
· Scale panel,
· Selected panel,
· Legend panel,
· MiniMap panel,
· Data panel.

http://www.tatukgis.com
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3 Menu

Description
The Editor menu is used to invoke any of the Editor features.

3.1 File

Description
The File menu group contains basic options used to manage layer and project files, image
exporting, printing, etc.

3.1.1 Welcome Page

Description
Clicking on the File/Welcome Page menu item invokes the Welcome Page. The Welcome Page is
a panel that allows quick access:
· to recently opened files - Recent files tab,
· to favorite files - Favorites tab; those can be managed via Organize favorites feature,
· to recently used scripts - Scripts tab.

Welcome Page.

Each tab provides a list of files corresponding to its name. To switch to another tab, click on the
label displaying its name at the bottom of the Welcome page. To open a file which name is present
on any of the tabs, click on it.

At the level of the Welcome page, the user can also:

· create a new project by clicking on the New label beside the  icon (see here),
· open an existing project or layer file not present on any of the tabs by clicking on the Open label

beside the  icon (see here).

Key shortcut
This function can be initiated by pressing the F10 key.

Note
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· The Recent files tab and Scripts tab automatically keep lists of the five most recently opened
files of each kind.

3.1.2 New Project

Description
Clicking on the File/New Project menu item prepares the Editor for a new project. It closes all open
layers and resets the project file settings.

To create a new project, click on the File/New Project menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or by clicking
on the New label on the Recent files tab of the Welcome Page.

Associated functions
To add an existing vector or raster file as a layer to the current project, use the Add feature.

Note
· If the New Project function is initiated while some layers are open, the Editor will prompt for

saving any changes made to open layers before closing them.

3.1.3 Open

Description
Clicking on the File/Open menu item provides for opening of a project file or an individual vector or
raster file as a layer. Because a project file typically contains multiple layers, the opening of a
project file opens all the layers contained by the project, along with all the visual properties settings
for each layer, in a single step.

To open a layer or project file
1. Click on the File/Open menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
3. Locate the project file by entering the directory that contains this file.
4. Double-click on the file name.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Similar functions
To add an existing vector or raster file as a layer to the current project, use the Add feature.
To open a project file or an individual vector or raster layer file stored on a remote server, use the
Open from server feature.

Key shortcut
This function can be initiated by pressing the Ctrl+O key combination.

Note
· By default the Open dialog box displays files of commonly used GIS file formats, but not all

formats supported by the Editor. This can be altered by choosing a different filter from the Files
of type list in the Open dialog box.

3.1.4 Open from server

Description
Clicking on the File/Open from server menu item provides for opening a project or layer file stored
on a remote server. The opening of a file from a server requires that the user provide the exact
path to the file on the remote server with the server's network address.
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To open a file stored on a remote server
1. Click on the File/Open from server menu item - this invokes the Open from server dialog box.
2. Within the Open from server dialog box, enter the exact path to the file or select the path using

the Address list.
3. Click on the OK button.

Open from server dialog box.

Similar functions
To open a project file or an individual vector or image layer file stored on a local storage medium,
use the Open feature.

Note
· The Open from server feature supports the WMS protocol as defined by the OGC/OpenGIS

organization (http://www.opengeospatial.org/) and the ECWP protocol as defined by the ER
Mapper company (http://www.ermapper.com/). The ECWP protocol supports opening of an
ECW or JPEG2000 format map image from a server. 

· The Open from server feature is unrelated to the support for SQL server database map layers.

3.1.5 Save

Description
Clicking on the File/Save menu item provides for saving the current state of the active layer to the
file to which it was previously saved. This overwrites the existing file destroying the previous state
of the layer.

To save the current state of a layer
1. Activate (highlight) the layer that you want to save by clicking on its name in the Legend panel.
2. Click on the File/Save menu item.

Similar functions
To save a project, use the Save Project As feature.
To save all open layers and the project in one step, use the Save All feature.
To save a vector layer to a file of a different format than it was opened from, use the Export
feature.

Key shortcut
This function can be initiated by pressing the Ctrl+S key combination.

Note
· If no changes have been made to the active layer since last saving, the File/Save menu entry will

be inactive. 
· The Save feature saves only changes made to the active layer, and not the changes to any other

open layer.
· Saving is always performed in the same file format from which the layer was opened.

http://www.opengeospatial.org/
http://www.ermapper.com/
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3.1.6 Save Project As

Description
Clicking on the File/Save Project As menu item provides for saving the open project as a Editor
project file. The project file contains all the information (set-up configuration) required to pull the
project together. This includes the list of layers which compose the project, the paths to the files
containing each layer, the visual properties of each layer, label presentations, thematic rendering,
fonts, etc.

To save a new project
1. Click on the File/Save Project As menu item - this invokes the Save As dialog box.
2. Within the Save As dialog box, select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the project file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name, and
pressing the Enter key.

4. Enter a name for the project file in the File name list.
5. Click on the Save button.

To overwrite an existing project
1. Click on the File/Save Project As menu item - this invokes the Save As dialog box.
2. Within the Save As dialog box, select the appropriate drive from the Save in list.
3. Locate the folder from which the project was opened.
4. Double-click on the project file name. A message box will appear asking for confirmation of the

overwrite operation - click on the OK button.

Associated functions
To add an existing vector or raster layer file to the currently open project, use the Add feature.
To remove a layer from the current project, use the Remove feature.

Similar functions
To save the current state of the active layer, use the Save feature.
To save the current state of all the layers and the project file in a single step, use the Save All
feature.

3.1.7 Save All

Description
Clicking on the File/Save All menu item provides for saving both the changes to all the open layers
since the last save operation and the project file, in one step.

To save the current state of all open layers and project file, click on the File/Save All menu
item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Similar functions
To save the current state of the active layer, use the Save feature.
To save the current state of the project to the project file, use the Save Project As feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+S key combination.

Note
· If the project file does not already exist, then the Save As dialog box is invoked to allow the user

to set the project file name and the saving path.
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3.1.8 Print

Description
Clicking on the File/Print menu item provides the means to print or export to a PDF (Portable
Document Format) file the data currently open in the Editor, that is, the contents of the Map area,
Legend panel and MiniMap panel. The printout layout is managed through the Editor print
templates. The print templates are stored in files in the PrintTemplates subdirectory of the Editor
installation folder. The Editor comes with three standard print templates: Simple (Map area only),
With Legend (Map area with Legend panel), With Legend and MiniMap (Map area, Legend panel
and MiniMap panel). The standard templates are always listed in the Print dialog Template list. An
example of a more advanced template, including images and multi coloring, is provided in the 
TatukGISCustom.tpl file.

Print dialog box displaying sample printout setup.

To print the data open in the Editor
1. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that it displays the area to be printed.
2. [OPTIONAL] Prepare the appearance of the MiniMap panel if it is to be included in the printout.
3. Click on the File/Print menu item - this invokes the Print dialog.
4. [OPTIONAL] To display the preview of the printout, check the Preview checkbox by clicking on

it.
5. Within the Print dialog, choose a print template from the Template list. If the desired template is

not listed in the Template list then choose the From file... item - this invokes the Open dialog
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box. Within the Open dialog box, select the appropriate drive from the Look in list, locate the
template file by entering the directory that contains this file, and double-click on the file name.

6. Enter the printout title in the Title text box. [OPTIONAL] To refresh the preview with the new title,

press the Enter key or click on the  button.
7. [OPTIONAL] To customize the print settings such as the printer used to generate the printout or

the printout orientation, click on the Print Setup button - this invokes the Print Settings dialog
box.

8. [OPTIONAL] To generate the printout in draft quality, check the Draft checkbox. This option is
useful for speeding up the printing procedure but significantly lowers the quality of the printout.

9. [OPTIONAL] To generate the printout in high compatibility mode, check the Compatibility mode
checkbox. This option may have a significant impact on the printout quality and is meant to be
used only when the printer is not capable of printing in normal mode or the generated printout
contains errors.

10. Click on the Print button - this invokes the system Print dialog box.
11. Within the system Print dialog box, set the number of printout copies in the Number of copies

box.
12. Click on the OK button.

System Print dialog box.

To generate a PDF file of the data open in the Editor
1. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that it displays the area to be printed.
2. [OPTIONAL] Prepare the appearance of the MiniMap panel if it is to be included in the printout.
3. Click on the File/Print menu item - this invokes the Print dialog.
4. [OPTIONAL] To display the preview of the printout, check the Preview checkbox by clicking on

it.
5. Within the Print dialog, choose a print template from the Template list. If the desired template is

not listed in the Template list then choose the From file... item - this invokes the Open dialog
box. Within the Open dialog box, select the appropriate drive from the Look in list, locate the
template file by entering the directory that contains this file, and double-click on the file name.

6. Enter the printout title in the Title text box. [OPTIONAL] To refresh the preview with the new title,

press the Enter key or click on the  button.
7. [OPTIONAL] To change the printout orientation, click on the Print Setup button - this invokes

the Print Settings dialog box. Within the Print Settings dialog box, choose one option from the
Orientation list.

8. [OPTIONAL] To generate the printout in draft quality, check the Draft checkbox. This option is
useful for speeding up the PDF creation procedure but significantly lowers the quality of the
document.
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9. [OPTIONAL] To generate the printout in high compatibility mode, check the Compatibility mode
checkbox. This option may have a significant impact on the document quality but ensures
compatibility with almost any printer when the PDF file is meant to be printed later.

10. Click on the Print button - this invokes the Save As dialog box.
11. Within the Save As dialog box, select the appropriate drive from the Save in list.
12.Locate the folder where you would like to store the project file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

13. Enter a name for the PDF file in the File name list.
14. Click on the Save button.

Key shortcut
This function can be initiated by pressing the Ctrl+P key combination.

Note
· The process of installing and configuring a printing device is controlled by the Windows

operating system. Each type of printing device has its own properties. Detailed information about
installing and configuring a printer can be found in the manual supplied by the printer
manufacturer and in the Windows help system.

· Checking the Compatibility mode option causes the data to be converted to an image
representation before proceeding with the printing/PDF exporting procedure. This especially
affects the quality of a PDF document (which natively supports vectorial graphics) while
exporting vector type layers.

3.1.9 Export to image

Description
Clicking on the File/Export to image menu item provides for exporting any extent of the current
project map as a georeferenced image (raster) file. The Editor supports exporting to a number of
image file formats.

To export any extent of the current project as an image file
1. [OPTIONAL] The Export to image feature gives a possibility to export the extent visible within

the Map area by choosing the Select extent/Visible option further in this procedure. To take the
advantage of this option adjust the extent visible within the Map area using the Zoom mode,
Zoom extended mode and Drag mode features.

2. Click on the File/Export to image menu item - this invokes the Save As dialog box.
3. Within the Save As dialog box, select the appropriate drive from the Save in list.
4. Locate the folder where you would like to store the image file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

5. Enter a name for the image file in the File name list.
6. Choose the image file format from the Save as type list.
7. Click on the Save button - this invokes the Export to [chosen format] dialog box, where the

chosen format is the format selected in the Save as type list in previous step.
8. The Export to [chosen format] dialog box allows to adjust the image parameters: level of

compression (Compression box), resolution (Resolution box) and extent to export (Select extent
box).

9. Click on the Save button.
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Export to JPG dialog box saving world.JPG file.

Export to [chosen format] dialog box settings
· The Compression box together with the Resolution box provide the quality vs. file size settings.

While the resolution setting affects the physical size of the image the level of compression
defines the precision in which the image reflects the actual data. The higher the compression
level the smaller the exported file is with the cost of the quality drop.

· The Resolution option within the Export to [chosen format] dialog box (which influences the
export file size) may be selected from three predefined resolutions by choosing one of the
following options: best quality - 4 000 pixels in the width if source data is vector only, for
document - 300 DPI with a width of 14 cm, for web - 600 pixels in the width. The custom option
allows the user to set the custom width, height, and DPI (dots per inch) of the exported image. 

· The Select extent option within the Export to [chosen format] dialog box allows the user to
specify whether the export image is to be generated from the entire project extent (the Full
option) or only from of the portion of the project currently visible in the Map area (the Visible
option). The User defined option uses (x,y) coordinates to define the top, bottom, right, and left
limits of the extent area. The Spatial selection option is active only if a selection of shapes has
been done using any of the spatial selection tools before using the Export to image feature. The
spatial selection tools are: Select by Polygon, Select by Circle, Select by Rectangle, Select by
Clipboard.

Note
· Because of the JPEG and PNG formats inherent size limitations, exporting to this formats is

generally recommended only when the exported image does not exceed approximately 25 MB.
The export of more data to the JPEG or PNG file format can result in files that are unstable and
may not open or work properly in other programs.

· To make the exported image as compatible as possible with other software, the export operation
also generates a complimentary World File and TAB registration file which contain the
georeferencing information for the exported image. Export to the TIFF format generates a
GeoTIFF image with the georeferening information embedded.

· The program presents an estimation of the size of the image file being exported, after
considering the extent, resolution, number of colors (bit depth) the export is generated to, and
other factors. The estimation does not consider the compression which may be applied during
the export procedure (i.e. the exported image file will be not bigger than the estimation). The size
estimation is displayed at the bottom of the Export to [chosen format] dialog box.
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3.1.10 Internet Server Wizard

Description
Clicking on the File/Internet Server Wizard menu item invokes a procedure to generate an
ASP.NET web server project from the current Editor project file. The exported ASP.NET project
can then be web published using TatukGIS Internet Server product (or the Internet Server LITE
edition).

To generate an ASP.NET project for web publishing
1. Click on the File/Internet Server Wizard menu item - this invokes the TatukGIS Internet Server

Wizard dialog box.
2. Within the TatukGIS Internet Server Wizard dialog box, the automatically generated ASP.NET

project code is displayed. If necessary, this code can be edited at this point  within the text area.
3. When the project code seems satisfactory, click on the Save button - this invokes the Save As

dialog box.
4. Within the Save As dialog box, select the appropriate drive from the Save in list.
5. Locate the folder where you would like to store the project file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name, and
pressing the Enter key.

6. Enter a name for the ASP.NET project file in the File name list.
7. Click on the Save button.

TatukGIS Internet Server Wizard dialog box with the sample ASP.NET project code.

Note
· Using this feature to export the project from the Editor as an ASP.NET project can save time

and effort. The default ASP.NET project set-up can be further customized within the TatukGIS
Internet Server or Internet Server LITE products.

3.1.11 Coordinate Systems

Description
Clicking on the File/Coordinate Systems menu item provides for selecting or defining the map
coordinate system, i.e. the coordinate system in which the entirety of the vector/raster data (all
open layers) is displayed on the Map area. All layers currently open in the Editor are automatically
reprojected to the map coordinate system. The user may specify the map coordinate system by
selecting from approximately 2900 pre-defined coordinate systems or by defining a custom
coordinate system using 120 supported projections and 350 supported datums.
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IMPORTANT
The Editor automatically recognizes the coordinate system of each layer being opened as long as
the layer contains information about the coordinate system. In order to set the map coordinate
system each currently open layer must have its own coordinate system set. If a layer does not
have the coordinate system information, the coordinate system can be manually set within the
layer properties, see the Properties help topic for details.

To choose a predefined projected coordinate system
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Projected system: option.
3. Pick the geographic system form the Projected system: list.
4. Click on the OK button.

To define a custom projected coordinate system
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Projected system: option.
3. Click on the [...] button on the right hand side of the Projected system: option - this invokes the

Coordinate System Setup dialog box.
4. Within the Geographic System tab of the Coordinate System Setup dialog box define the

geographic system.
5. Within the Projection System tab of the Coordinate System Setup dialog box define the

projection system.
6. Click on the OK button.

To save a projected coordinate system to a file
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Projected system: option.
3. Click on the [...] button on the right hand side of the Projected system: option - this invokes the

Coordinate System Setup dialog box.
4. Within the WKT tab of the Coordinate System Setup dialog box click on the Export... button -

this invokes the Save As dialog box.
5. Within the Save As dialog box select the appropriate drive from the Save in list.
6. Locate the folder where you would like to store the projection system file. A new folder can be

created by clicking on the  icon at the top-right corner of the Save As dialog box, entering its
name and pressing the Enter key.

7. Enter a name for the projection system file in the File name list.
8.  Click on the Save button - this brings back the Coordinate System dialog box.
9.  Within the Coordinate System dialog box click on the OK button.

To load a projected coordinate system from a file
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Projected system: option.
3. Click on the [...] button on the right hand side of the Projected system: option - this invokes the

Coordinate System Setup dialog box.
4. Within the WKT tab of the Coordinate System Setup dialog box click on the Import... button -

this invokes the Open dialog box.
5. Within the Open dialog box select the appropriate drive from the Look in list.
6. Locate the projected system file by entering the directory that contains this file.
7. Double-click on the file name - this brings back the Coordinate System dialog box.
8. Within the Coordinate System dialog box click on the OK button.

To choose a predefined geographic coordinate system
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Geographic system: option.
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3. Pick the geographic system form the Geographic system: list.

To define a custom geographic coordinate system
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Geographic system: option.
3. Click on the [...] button on the right hand side of the Geographic system: option - this invokes

the Coordinate System Setup dialog box.
4. Within the Geographic System tab of the Coordinate System Setup dialog box define the

geographic system.
5. Click on the OK button.

To save a geographic coordinate system to a file
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Geographic system: option.
3. Click on the [...] button on the right hand side of the Geographic system: option - this invokes

the Coordinate System Setup dialog box.
4. Within the WKT tab of the Coordinate System Setup dialog box click on the Export... button -

this invokes the Save As dialog box.
5. Within the Save As dialog box select the appropriate drive from the Save in list.
6. Locate the folder where you would like to store the geographic system file. A new folder can be

created by clicking on the  icon at the top-right corner of the Save As dialog box, entering its
name and pressing the Enter key.

7. Enter a name for the geographic system file in the File name list.
8. Click on the Save button - this brings back the Coordinate System dialog box.
9.  Within the Coordinate System dialog box click on the OK button.

To load a geographic coordinate system from a file
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Geographic system: option.
3. Click on the [...] button on the right hand side of the Geographic system: option - this invokes

the Coordinate System Setup dialog box.
4. Within the WKT tab of the Coordinate System Setup dialog box click on the Import... button -

this invokes the Open dialog box.
5. Within the Open dialog box select the appropriate drive from the Look in list.
6. Locate the geographic system file by entering the directory that contains this file.
7. Double-click on the file name - this brings back the Coordinate System dialog box.
8. Within the Coordinate System dialog box click on the OK button.

To turn off the map coordinate system
1. Click on the File/Coordinate Systems menu item - this invokes the Coordinate System dialog

box.
2. Within the Coordinate System dialog box click on the Turn off (unknown system) option.

Coordinate System dialog box.
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Coordinate System Setup dialog box.

Associated functions
To set or customize the coordinate system for an individual vector layer, use the Properties
feature.
To convert a layer in to a different coordinate system, use the Export feature.

Note
· If the map coordinate system is turned off then each open layer is displayed in its own

coordinate system. If the coordinate systems of the open layers are different then all the layers
are misplaced with respect to each other.

· For top performance, best is if the coordinate systems of all the layers and the map coordinate
system are the same. This avoids the requirement to perform on-the-fly reprojection, which is
computationally demanding.

3.1.12 Scale Units

Description
Clicking on the File/Scale units menu item provides for setting the distance units used by the Scale
panel.

To set the distance units used by the Scale panel
1. Click on the File/Scale units menu item - this invokes the Scale units dialog box.
2. Within the Scale units dialog box select the desired unit from the Scale units list.
3. Click on the OK button.

Scale Units dialog box.
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3.1.13 Hierarchy

Description
Clicking on the File/Hierarchy menu item displays the list of features used to manage the
Hierarchy tab of the Legend panel.

IMPORTANT
For basic information concerning the Hierarchy tab of the Legend panel, refer to this help topic.

To display the list of features of the Legend panel Hierarchy tab, click on the File/Hierarchy
menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu.

3.1.13.1 Add main group

Description
Clicking on the File/Hierarchy/Add main group menu item creates a main group in the Hierarchy
tab of the Legend panel. A main group is a group that resides at the lowest hierarchy level. At least
one main group must exist in order to add subgroups and layers.

To create a main group, click on the File/Hierarchy/Add main group menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Add main group item on the drop down list.

Associated functions
To delete a group, use the Delete group feature.
To delete all subgroups from a group, use the Delete all subgroups feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.

Similar functions
To create a subgroup within a group, use the Add subgroup feature.
To create a main group containing all ungrouped layers, use the Add unused layers feature.

3.1.13.2 Add subgroup

Description
Clicking on the File/Hierarchy/Add subgroup menu item creates a subgroup in the Hierarchy tab of
the Legend panel. The subgroup is a group that cannot exist at the lowest hierarchy level, i.e. it
must belong to a main group or to another subgroup.

To create a subgroup within an existing group
1. Within the Hierarchy tab of the Legend panel click on the group within which a subgroup is to be

created.
2. Click on the File/Hierarchy/Add subgroup menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Add subgroup item on the drop down list.

Associated functions
To delete a group, use the Delete group feature.
To delete all subgroups from a group, use the Delete all subgroups feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.
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Similar functions
To create a main group, use the Add main group feature.
To create a main group containing all ungrouped layers, use the Add unused layers feature.

3.1.13.3 Delete group

Description
Clicking on the File/Hierarchy/Delete group menu item deletes a group from the Hierarchy tab of
the Legend panel. All layers belonging to the part of the hierarchy tree held by the group being
deleted are removed from that part.

To delete a group
1. Within the Hierarchy tab of the Legend panel click on the group to be deleted.
2. Click on the File/Hierarchy/Delete group menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Delete group item on the drop down list.

Associated functions
To create a main group, use the Add main group feature.
To create a subgroup within a group, use the Add subgroup feature.
To create a main group containing all ungrouped layers, use the Add unused layers feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.

Similar functions
To delete all subgroups from a group, use the Delete all subgroups feature.

3.1.13.4 Delete all subgroups

Description
Clicking on the File/Hierarchy/Delete all subgroups menu item deletes all subgroups of a group in
the Hierarchy tab of the Legend panel. All layers belonging to the part of the hierarchy tree held by
the subgroups being deleted are removed from that part.

To delete all subgroups of a group
1. Within the Hierarchy tab of the Legend panel click on the group from which all subgroups are to

be deleted.
2. Click on the File/Hierarchy/Delete all subgroups menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Delete all subgroups item on the drop down list.

Associated functions
To create a main group, use the Add main group feature.
To create a subgroup within a group, use the Add subgroup feature.
To create a main group containing all ungrouped layers, use the Add unused layers feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.

Similar functions
To delete a group, use the Delete group feature.
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3.1.13.5 Add layer

Description
Clicking on the File/Hierarchy/Add layer menu item displays the list of all layers currently open in
the Editor. Clicking on a layer name on this list adds the layer to a group in the Hierarchy tab of
the Legend panel.

To add a layer to a group
1. Within the Hierarchy tab of the Legend panel click on the group to which the layer is to be

added.
2. Click on the File/Hierarchy/Add layer menu item - a drop down list will appear.
3. Within the list click on the desired layer name.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Add main group item on the drop down list.

Associated functions
To create a main group, use the Add main group feature.
To create a subgroup within a group, use the Add subgroup feature.
To delete a group, use the Delete group feature.
To delete all subgroups from a group, use the Delete all subgroups feature.
To remove a layer from a group, use the Remove layer feature.

Similar functions
To create a main group containing all ungrouped layers, use the Add unused layers feature.

3.1.13.6 Add unused layers

Description
Clicking on the File/Hierarchy/Add unused layers menu item creates a main group named "Other"
in the Hierarchy tab of the Legend panel and adds to it all layers that are not associated with any
group. The main group is a group that resides at the lowest hierarchy level, i.e. at least one main
group must exist in order to add subgroups and layers.

To create a main group containing all unassociated layers, click on the File/Hierarchy/Add
unused layers menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Add unused layers item on the drop down list.

Associated functions
To delete a group, use the Delete group feature.
To delete all subgroups from a group, use the Delete all subgroups feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.

Similar functions
To create a main group, use the Add main group feature.
To create a subgroup within a group, use the Add subgroup feature.

3.1.13.7 Remove layer

Description
Clicking on the File/Hierarchy/Remove layer menu item removes a layer from selected location in
the Hierarchy tab of the Legend panel.

To remove a layer from some location in the hierarchy tree
1. Within the Hierarchy tab of the Legend panel click on the layer name in the group from which it

is to be removed.
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2. Click on the File/Hierarchy/Remove layer menu item.

Equivalent actions
The same function can be initiated by clicking on the Hierarchy item in the Legend panel context
menu and then on the Add main group item on the drop down list.

Associated functions
To create a main group, use the Add main group feature.
To create a subgroup within a group, use the Add subgroup feature.
To create a main group containing all ungrouped layers, use the Add unused layers feature.
To delete a group, use the Delete group feature.
To delete all subgroups from a group, use the Delete all subgroups feature.
To add a layer to a group, use the Add layer feature.
To remove a layer from a group, use the Remove layer feature.

3.1.14 Recent Files

Description
Clicking on the File/Recent files menu item presents a list of the 16 most recently opened files.

To open a recently opened file
1. Click on the File/Recent Files menu item - a list of the 16 most recently opened files will appear.
2. Search for the desired file in the list - if the file is not present in the list, this means that the file

has never been opened or at least 16 other files have been opened since this file was last
opened. 

3. Click on the file name.

Similar functions
The Recent files tab on the Welcome page displays a list of the 5 most recently opened files.

3.1.14.1 Clear list

Description
Clicking on the File/Recent Files/Clear list menu item clears the list of recently opened files
available under the File/Recent Files menu item (see here).

To clear the list of recently opened files available under the File/Recent Files menu item
1. Click on the File/Recent Files/Clear list menu item - a message box will appear asking for

confirmation.
2. Click on the OK button.

3.1.15 Favorites

Description
Clicking on the File/Favorites menu item displays a list of favorite layer and project files.

To open a file present on the Favorites list
1. Click on the File/Favorites menu item - a list of favorite files will appear.
2. Search for the desired file name on the list.
3. Click on the file name.
or
1. Click on the File/Favorites/Organize favorites menu item - this invokes the Organize favorites

dialog box.
2. Search for the desired file path on the list in the Organize favorites dialog box.
3. Click on the desired file path\name.
4. Click on the Open button.

Associated functions
To manage the Favorites list, use the Organize favorites feature.
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3.1.15.1 Add active layer

Description
Clicking on the File/Favorites/Add active layer menu item adds the currently active layer file to the
Favorites list.

To add a layer file to the Favorites list
1. Activate (highlight) the layer that you want to add to Favorites list by clicking on its name in the

Legend panel.
1. Click on the File/Favorites/Add active layer menu item.

3.1.15.2 Add current project

Description
Clicking on the File/Favorites/Add current project menu item adds the currently open project file to
the Favorites list.

To add the currently open project file to the Favorites list, click on the File/Favorites/Add
current project menu item.

3.1.15.3 Organize Favorites

Description
Clicking on the File/Favorites/Organize favorites menu item provides for organizing the Favorites
list.

To open a file present on the Favorites list
1. Click on the File/Favorites menu item - a list of favorite files will appear.
2. Search for the desired file on the list.
3. Click on the file name.
or
1. Click on the File/Favorites/Organize favorites menu item - this invokes the Organize favorites

dialog box.
2. Within the Organize favorites dialog box, search for the desired file on the list.
3. Click on the file path\name.
4. Click on the Open button.

To add a file to the Favorites list
1. Click on the File/Favorites/Organize favorites menu item - this invokes the Organize favorites

dialog box.
2. Within the Organize favorites dialog, box click on the Add Files button - this invokes the Open

dialog box.
3. Within the Open dialog box, select the appropriate drive from the Look in list.
4. Locate the file by entering the directory that contains this file.
5. Double-click on the file name - this brings back the Organize favorites dialog box.
6. Click on the Close button.

To remove a file from the Favorites list
1. Click on the File/Favorites/Organize favorites menu item - this invokes the Organize favorites

dialog box.
2. Within the Organize favorites dialog box, search for the desired file on the list.
3. Click on the file path\name.
4. Click on the Remove button.
5. Click on the Close button.
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Organize favorites dialog box with one favorite folder and one favorite file.

3.1.16 Exit

Description
Clicking on the File/Exit menu item terminates the program in the proper way.

To quit the program, click on the File/Exit menu item.

Note
· If the program detects unsaved changes in any of the open layers, it will prompt the user to save

the changes before exiting.
· If any layer is open, the program will ask if the user would like to save the project file.

3.2 Edit

Description
The Edit menu group contains standard editing features using the Windows operating system
clipboard and the Editor temporary clipboard layer.

3.2.1 Undo

Description
Clicking on the Edit/Undo menu item cancels the most recently performed edit operation. The
Undo feature must be used before leaving the edit mode.

To undo the most recent edit operation, click on the Edit/Undo menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Associated functions
To activate the edit mode, use the Edit object feature.
To cancel the Undo operation, use the Redo feature.

Similar functions
The Undo feature works only for the most recent edit operation. If the most recent operation
concerns an entire shape or a part within it, such as accidental deletion of a shape, use the Revert
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Shape feature to restore the previous state of the shape.

Key shortcut
This function can be initiated by pressing the Ctrl+Z key combination.

Note
· If the context of the situation is such that it is impossible to Undo the most recent edit operation,

the Edit/Undo menu item will be inactive.

3.2.2 Redo

Description
Clicking on the Edit/Redo menu item restores the state before the Undo operation was performed.
The Redo feature must be used before leaving the edit mode.

To cancel the Undo operation, click on the Edit/Redo menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Associated functions
To activate the edit mode, use the Edit object feature.

Key shortcut
This function can be initiated by pressing the Ctrl+Y key combination.

Note
· If the context of the situation is such that it is impossible to Redo the most recent Undo

operation, the Edit/Redo menu entry will be inactive.

3.2.3 Cut

Description
Clicking on the Edit/Cut menu item provides the means to transfer a shape or a group of shapes to
the temporary clipboard layer. This operation removes the shapes from the source layer.

To cut shapes from a vector layer and store them in the temporary clipboard layer
1. Activate (highlight) the layer from which shapes are to be cut. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Edit/Cut menu item.
or
1. Activate (highlight) the layer from which shapes are to be cut. Do this by clicking on its name in

the Legend panel.
2. Expand the context menu by clicking with the right mouse button on the layer name in the 

Legend panel and click on the Open layer data item - the Data panel will appear at the bottom of
the Editor window.

3. In the Data panel, click on the GIS_SELECTED property checkboxes of the desired shapes -
this operation selects these shapes.

4. Click on the Edit/Cut menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Associated functions
To transfer all the shapes from the temporary clipboard layer to a vector layer, use the Paste
feature.



23Menu

(c)2000-2010 TatukGIS. All rights Reserved

To save all the shapes stored in the temporary clipboard layer to a new vector layer file, use the
Save Clipboard feature.

Similar functions
To transfer the shapes to the temporary clipboard layer without removing them from the source
layer, use the Copy feature.

Key shortcut
This function can be initiated by pressing the Ctrl+X key combination.

Note
· The temporary clipboard layer is a virtual object (stored in memory) automatically created by the 

Cut feature and is not file type specific.
· The Cut operation erases any previous content from the temporary clipboard layer.
· The Cut operation copies all the selected shapes to the temporary clipboard layer as a single

shape, i.e. all the cut shapes are fused into a single shape.
· The Cut operation concerns only the shapes geometry, and not the attributes.

3.2.4 Copy

Description
Clicking on the Edit/Copy menu item provides the means to transfer a shape or a group of shapes
to the temporary clipboard layer. This operation does not remove the shapes from the source
layer. This feature can be also used to store an image (raster) representation of the extent
currently visible on the Map area in the operating system's clipboard.

To copy shapes to the temporary clipboard layer
1. Activate (highlight) the layer from which the shapes are to be copied. Do this by clicking on its

name in the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Edit/Copy menu item.
or
1. Activate (highlight) the layer from which the shapes are to be copied. Do this by clicking on its

name in the Legend panel.
2. Expand the context menu by clicking with the right mouse button on the layer name in the 

Legend panel and click on the Open layer data item - the Data panel will appear at the bottom of
the Editor window.

3. In the Data panel, click on the GIS_SELECTED property checkboxes of the desired shapes -
this operation selects these shapes.

4. Click on the Edit/Copy menu item.

To copy the extent currently visible on the Map area into an image stored in the operating
system's clipboard
1. Adjust the extent visible on the Map area to cover the desired area.
2. Ensure that no shapes are selected by clicking on the Select/Deselect all menu item or on the

 icon on the Standard toolbar. If no shapes are currently selected, these options will be
inactive.

3. Click on the Edit/Copy menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Copy item in the Map area context menu.

Associated functions
To transfer the shapes from the temporary clipboard layer to a vector layer, use the Paste feature.
To save all the shapes stored in the temporary clipboard layer to a new vector layer file, use the
Save Clipboard feature.
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Similar functions
To transfer all the shapes to the temporary clipboard layer and remove them from the source layer,
use the Cut feature.
There is also a more advanced way of copying shapes to the temporary clipboard layer - the Copy
Special feature.

Key shortcut
This function can be initiated by pressing the Ctrl+C key combination.

Note
· The temporary clipboard layer is a virtual object (stored in memory) automatically created by the 

Copy feature and is not file type specific.
· The Copy operation erases any previous content from the temporary clipboard layer.
· The Copy operation copies all the selected shapes to the temporary clipboard layer as a single

shape, i.e. all the cut shapes are fused into a single shape.
· The Copy operation concerns only the shapes geometry, and not the attributes.

3.2.5 Copy Special

Description
Clicking on the Edit/Copy Special menu item provides the means to copy shapes from a vector
layer to the temporary clipboard layer in a custom (advanced) manor. This operation does not
remove the shapes from the source layer.

To copy shapes to the temporary clipboard layer in a custom way
1. Activate (highlight) the layer from which the shapes are to be copied. Do this by clicking on its

name in the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Edit/Copy Special menu item - this invokes the Copy Special dialog box.
4. Within the Copy Special dialog box, choose one of the Source options to define how the

selected shapes are copied from the source layer.
5. Choose one of the Copy type options to define the way in which the copied shapes are stored to

the temporary clipboard layer.
6. Click on the OK button.
or
1. Activate (highlight) the layer from which the shapes are to be copied. Do this by clicking on its

name in the Legend panel.
2. Expand the context menu by clicking with the right mouse button on the layer name in the 

Legend panel and click on the Open layer data item - the Data panel will appear at the bottom of
the Editor window.

3. In the Data panel, click on the GIS_SELECTED property checkboxes of the desired shapes -
this operation selects these shapes.

4. Click on the Edit/Copy Special menu item - this invokes the Copy Special dialog box.
5. Within the Copy Special dialog box, choose one of the Source options to define how the

selected shapes are copied from the source layer.
6. Choose one of the Copy type options to define the way in which the copied shapes are stored to

the temporary clipboard layer.
7. Click on the OK button.

Source options
· Selection - copy only the spatial selection figure. This applies to the Select by Line, Select by

Polygon, Select by Circle and Select by Rectangle selection methods. If none of these selection
methods is used, this option will be inactive.

· Selected shapes (individual) - copy all selected shapes individually as separate objects (exactly
as they were in the source layer).

· Selected shapes (union) - copy all selected shapes as a single fused object (as when using the
regular Copy feature).
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Copy type options
· Union ( + ) - unites the newly copied shapes to any objects that already exist in the temporary

clipboard layer.
· Intersection ( * ) - places on the temporary clipboard layer the shapes that are common between

the newly copied objects and the shapes that were already in the temporary clipboard layer. 
· Difference ( Clipboard - Source ) - leaves on the temporary clipboard layer the shapes that are

not common with the newly copied shapes. 
· Difference ( Source - Clipboard ) - places on the temporary clipboard layer the part of the newly

copied shapes that is not common with the shapes already present in the temporary clipboard
layer.

· Symmetrical difference ( XOR ) - places on the temporary clipboard layer the part of the newly
copied shapes and the part of the shapes already present on the temporary clipboard layer that
are not common.

· Replace - replace all shapes present on the temporary clipboard layer with the newly copied
shapes.

· Add - adds selected shapes to the temporary clipboard layer.

Copy Special dialog box.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Copy Special item in the Map area context menu.

Associated functions
To transfer all the shapes from the temporary clipboard layer to a vector layer, use the Paste
feature.
To save all the shapes stored in the temporary clipboard layer to a new vector layer file, use the
Save Clipboard feature.

Similar functions
There is also a more simple way of copying shapes, that is, the Copy feature.

Note
· The temporary clipboard layer is a virtual object (stored in memory) automatically created by the 

Copy Special feature and is not file type specific.
· The Copy Special operation concerns only the shapes geometry, and not the attributes.
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3.2.6 Paste

Description
Clicking on the Edit/Paste menu item provides for transferring all shapes from the temporary
clipboard layer to the currently active vector layer.

To paste shapes from the temporary clipboard layer to a vector layer
1. Activate (highlight) the layer to which the shapes are to be pasted. Do this by clicking on its

name in the Legend panel.
2. Click on the Edit/Paste menu item.

Associated functions
To transfer shapes to the temporary clipboard layer, use one of the following features: Cut, Copy,
Copy Special, Load Clipboard.
To load a vector layer file to the temporary clipboard layer, use the Load Clipboard feature.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Key shortcut
This function can be initiated by pressing the Ctrl+V key combination.

Note
· The temporary clipboard layer is an automatically created virtual object (stored in memory) and

is not file type specific.
· The Paste operation concerns only the shapes geometry, and not the attributes.

3.2.7 Clear Clipboard

Description
Clicking on the Edit/Clear Clipboard menu items provides for clearing the temporary clipboard layer
of any shapes stored there.

To clear the temporary clipboard layer, click on the Edit/Clear Clipboard menu item.

Note
· The Clear Clipboard feature does not clear the Windows operating system clipboard.

3.2.8 Save Clipboard

Description
Clicking on the Edit/Save Clipboard menu item provides for saving all the shapes stored in the
temporary clipboard layer in to a new vector layer file.

To save shapes stored in the temporary clipboard layer in to a vector layer file
1. Click on the Edit/Save Clipboard menu item - this invokes the Create New Layer dialog box.
2. Within the Create New Layer dialog box, select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the layer file. A new folder can be created by

clicking on the  icon at the top-right corner of the Create New Layer dialog box, entering its
name and pressing the Enter key.

4. Enter a name for the layer file in the File name list.
5. Choose the layer file format from the Save as type list.
6. Click on the Save button.

Associated functions
To transfer shapes to the temporary clipboard layer, use one of the following features: Cut, Copy,
Copy Special, Load Clipboard.

Note
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· If the temporary clipboard layer is empty, the Save Clipboard function is inactive.

3.2.9 Load Clipboard

Description
Clicking on the Edit/Load Clipboard menu item provides for loading a vector layer file directly to the
temporary clipboard layer.

To load a vector layer file into the temporary clipboard layer
1. Click on the Edit/Load Clipboard menu item - this invokes the Load Clipboard dialog box.
2. Within the Load Clipboard dialog box, select  the appropriate drive from the Look in list.
3. Locate the layer file by entering the directory that contains this file.
4. Double-click on the file name.

Associated functions
To transfer all the shapes from the temporary clipboard layer to a vector layer, use the Paste
feature.

Note
· The Load Clipboard feature erases the previous content of the temporary clipboard layer.
· The Load Clipboard operation concerns only the shapes geometry, and not the attributes.

3.3 View

Description
The View menu group contains options used to manage the appearance of the Editor.

3.3.1 Toolbars

Description
Clicking on the View/Toolbars menu item displays the list of currently visible toolbars.

To show/hide any toolbar
1. Click on the View/Toolbars menu item - this displays the list of currently visible toolbars.
2. Check/uncheck desired toolbar name by clicking on it.

Note
· Each toolbar's visibility property is preserved until it is manually changed.

3.3.1.1 Standard

Description
Clicking on the View/Toolbars/Standard menu item toggles visibility of the Standard toolbar.

To toggle visibility of the Standard toolbar, click on the View/Toolbars/Standard menu item.

3.3.2 Panels

Description
Clicking on the View/Panels menu item displays the list of currently visible panels.

IMPORTANT
For more information concerning the panels refer to this help topic.

To show/hide any panel
1. Click on the View/Panels menu item - this displays the list of currently visible panels.
2. Check/uncheck the desired panel name by clicking on it.
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Associated functions
To restore the default panels settings and arrangement, click on the View/Panels/Default menu
item (see here).

Note
· Each panel's visibility property is preserved until it is manually changed.

3.3.2.1 Scale

Description
Clicking on the View/Panels/Scale menu item toggles the visibility of the Scale panel.

To toggle the visibility of the Scale panel, click on the View/Panels/Scale menu item.

3.3.2.2 Selected

Description
Clicking on the View/Panels/Selected menu item toggles the visibility of the Selected panel.

To toggle the visibility of the Selected panel, click on the View/Panels/Selected menu item.

3.3.2.3 Legend

Description
Clicking on the View/Panels/Legend menu item toggles the visibility of the Legend panel.

To toggle the visibility of the Legend panel, click on the View/Panels/Legend menu item.

3.3.2.4 MiniMap

Description
Clicking on the View/Panels/MiniMap menu item toggles the visibility of the MiniMap panel.

To toggle the visibility of the MiniMap panel, click on the View/Panels/MiniMap menu item.

3.3.2.5 Data

Description
Clicking on the View/Panels/Data menu item toggles the visibility of the Data panel.

To toggle the visibility of the Data panel, click on the View/Panels/Data menu item.

3.3.2.6 Default

Description
Clicking on the View/Panels/Default menu item restores the default settings and arrangement of all
panels.

To restore the default settings and arrangement of all panels, click on the View/Panels/Default
menu item.

3.3.3 MiniMap

Description
Clicking on the View/MiniMap menu item displays the list of basic options of the MiniMap panel.

IMPORTANT
For more information concerning the/MiniMap panel refer to this help topic.

To display the list of basic options of the MiniMap panel, click on the View/MiniMap menu
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item.

3.3.3.1 Draw MiniMap

Description
Clicking on the View/MiniMap/Draw MiniMap menu item transfers the extent currently visible in the
Map area into the Map tab of the MiniMap panel.

To transfer the extent visible on the Map area to the Map tab of the MiniMap panel
1. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area.
2. Click on the View/MiniMap/Draw MiniMap menu item.

Equivalent actions
The same function can be initiated by clicking on the Draw MiniMap item in the Map area context
menu or in the context menu of the MiniMap panel Map tab.

3.3.3.2 Clear

Description
Clicking on the View/MiniMap/Clear menu item removes the vector layer from the Layer tab of the
MiniMap panel. This relates only to the MiniMap panel, so if the same layer is listed in the Legend
panel it will not be closed.

To reset (clear) the Layer tab of the MiniMap panel, click on the View/MiniMap/Clear menu
item.

Equivalent actions
The same function can be initiated by expanding the context menu on the Layer tab of the MiniMap
panel (right mouse button click on the Layer tab of the MiniMap panel) and clicking on the Clear
item.

Note
· If no layer is open in the Layer tab of the MiniMap panel, the View/MiniMap/Clear menu item will

be inactive.

3.3.3.3 Export To Web Image

Description
Clicking on the View/MiniMap/Export To Web Image menu item provides for exporting the current
appearance of the Layer tab of the MiniMap panel to an image file in the JPEG format.

To export the current appearance of the Layer tab of the MiniMap panel to an image file in
the JPEG format
1. Click on the View/MiniMap/Export To Web Image menu item - this invokes the Export to image

dialog box.
2. Within the Export to image dialog box select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the image file. A new folder can be created by

clicking on the  icon at the top-right corner of the Export to image dialog box, entering its
name and pressing the Enter key.

4. Enter a name for the image file in the File name list.
5. Click on the Save button.

Equivalent actions
The same function can be initiated by expanding the context menu on the Layer tab of the MiniMap
panel (right mouse button click on the Layer tab of the MiniMap panel) and clicking on the Export
To Web Image item.

Similar functions
To export the extent currently visible within the Map area to an image file, use the Export to image
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feature.

Note
· If no layer is open in the Layer tab of the MiniMap panel, the View/MiniMap/Export To Web

Image menu item will be inactive.

3.3.4 Full Extent

Description
Clicking on the View/Full Extent menu item sets the extent visible within the Map area to contain
the entirety of all open layers.

To set the extent visible within the Map area to contain the entirety of all open layers, click
on the View/Full Extent menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Similar functions
See Layer Extent, Selected Extent, Previous Extent.

Key shortcut
This function can be initiated by pressing the F3 key.

3.3.5 Layer Extent

Description
Clicking on the View/Layer Extent menu item sets the extent visible within the Map area to contain
the entirety of the currently active layer.

To set the extent visible within the Map area to contain the entirety of the currently active
layer
1. Activate (highlight) the desired layer by clicking on its name in the Legend panel.
2. Click on the View/Layer Extent menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Similar functions
See Full Extent, Selected Extent, Previous Extent.

Key shortcut
This function can be initiated by pressing the Ctrl+F3 key combination.

3.3.6 Selected Extent

Description
Clicking on the View/Selected Extent menu item sets the extent visible within the Map area to
contain all the currently selected shapes.

To set the extent visible within the Map area to contain desired shapes
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query.

3. Click on the View/Selected Extent menu item.
or
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in
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the Legend panel.
2. Expand the context menu by clicking with the right mouse button on the selected layer's name in

the Legend panel and click on the Open layer data item - the Data panel will appear at the
bottom of the Editor window.

3. In the Data panel, click on the GIS_SELECTED property check boxes of the desired shapes -
this operation selects these shapes.

4. Click on the View/Selected Extent menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Selected Extent item in the Map area context menu.

Similar functions
See Full Extent, Layer Extent, Previous Extent.

3.3.7 Previous Extent

Description
Clicking on the View/Previous Extent menu item sets the extent visible within the Map area to as it
was prior to the last zooming or dragging event.

To set the extent visible within the Map area to as it was prior to the last zooming or
dragging event, click on the View/Previous Extent menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Previous extent item in the Map area context menu.

Similar functions
See Full Extent, Layer Extent, Selected Extent.

Key shortcut
This function can be initiated by pressing the Alt+Backspace key combination.

Note
· The Editor memorizes up to five recent extents. The first click returns to be most recent extent,

the second click to the second most recent extent, etc.
· The Previous Extent feature works as a loop. On the fifth click the extent returns to as it was

before the Previous Extent feature was used (i.e. before the first click).

3.3.8 Refresh map

Description
Clicking on the View/Refresh map menu item generates a fresh rendering of all the geometry
visible within the Map area.

To refresh the Map area, click on the View/Refresh map menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Key shortcut
This function can be initiated by pressing the F5 key.
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3.3.9 Zoom mode

Description
Clicking on the View/Zoom mode menu item activates the standard zoom mode for the Map area.

To zoom in using the standard mode
1. Click on the View/Zoom mode menu item.
2. Within the Map area choose a rectangular area to which you would like to zoom in.
3. Move the mouse pointer to the top left corner of the area and press the left mouse button.
4. Move the mouse pointer to the bottom right corner of the area and release the left mouse

button.

To zoom out using the standard mode
1. Click on the View/Zoom mode menu item.
2. Within the Map area decide how large should be the area containing the currently visible extent

and where it should be located after zooming out.
3. Move the mouse pointer to the bottom right corner of this area and press the left mouse button.
4. Move the mouse pointer to the top left corner of this area and release the left mouse button.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.

Similar functions
There is also a "smooth" zooming to point method provided by the Zoom extended mode feature.

Key shortcut
This function can be initiated by pressing the Ctrl+M key combination.

3.3.10 Zoom extended mode

Description
Clicking on the View/Zoom extended mode menu item activates the extended zoom mode for the
Map area.

To zoom in using the extended mode
1. Click on the View/Zoom extended mode menu item.
2. Within the Map area choose a rectangular area to which you would like to zoom in.
3. Move the mouse pointer to the center of the desired area and press the left mouse button.
4. Start moving the mouse pointer to the bottom of the screen until the desired zoom level is

achieved.
5. Release the left mouse button.

To zoom out using the extended mode
1. Click on the View/Zoom extended mode menu item.
2. Within the Map area choose a point from which you would like to zoom out.
3. Move the mouse pointer to the point and press the left mouse button.
4. Start moving the mouse pointer to the top of the screen until the zoom level seems to meet your

needs.
5. Release the left mouse button.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.
This feature is available at any time using the mouse wheel (if present).

Similar functions
There is also a zooming to selection method provided by the Zoom mode feature.
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3.3.11 Drag mode

Description
Clicking on the View/Drag mode menu item activates the drag mode for the Map area.

To change the extent visible within the Map area to different location (at the same zoom
level)
1. Click on the View/Drag mode menu item.
2. Press the left mouse button at any point on the Map area (preferably at its center).
3. Move the mouse pointer in any direction as far as needed.
4. Release the left mouse button.
5. Repeat the steps from 1 to 3 until the extent visible within the Map area is as desired.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar.
This feature is available at any time by pressing and holding the Shift key.

3.3.12 Map hint

Description
Clicking on the View/Map hint menu item provides for managing the hint feature for the Map area.
In the case of a vector layer the hint feature offers a possibility to display information about shape
attributes whenever the mouse pointer is stopped over a particular shape. If a pixel or grid layer is
being viewed, the hint feature automatically shows the data associated with a pixel under the
mouse pointer.

To manage the hint feature
1. Activate (highlight) the layer for which the map hint feature is to be activated. Do this by clicking

on its name in the Legend panel.
2. Click on the View/Map hint menu item - this invokes the Map hint properties dialog box.
3. Within the Map hint properties dialog box select one option from the Map hints list: auto - show

complete information about the attributes, predefined - show information about only one
attribute, off - turn off the hint feature.

4. If the predefined option was selected in the previous step then in the Map hints predefined box
choose a layer and then pick an attribute from the list below.

5. Click on the OK button.

Map hint properties dialog box - map hint feature turned off for vector layer named world.

Note
· By default the map hint feature is disabled.
· The map hint settings are saved within the project file.
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3.3.13 Map hotlinks

Description
Clicking on the View/Map hotlinks menu item provides for activating/deactivating the Hotlinks
(URL) feature. When active, the Hotlinks (URL) feature attempts to connect to a URL link that
might be specified in an attribute field whenever the user double-clicks within the Map area (with
Localize or Select by Point selection features). The linkage can  open a document or image file in
appropriate program, navigate to a web site using a web browser, or even to automatically launch
a pre-addressed e-mail via e-mail client application.

To turn on/off the Hotlinks (URL) feature
1. Click on the View/Map hotlinks menu item - this invokes the Map Hotlinks dialog box.
2. Within the Map Hotlinks dialog box check/uncheck the auto option.
3. Click on the OK button.

Map Hotlinks dialog box.

Note
· By default the Hotlinks (URL) feature is enabled.

3.3.14 Auto center

Description
Clicking on the View/Auto center menu item toggles between the two ways in which the Localize
and Select by Point selecting features behave. If the View/Auto center menu  item is checked then
a selection event automatically centers the extent visible on the Map area on the recently selected
shape, without changing the zoom level. Otherwise, a selection event affects neither the visible
extent nor the zoom level.

To activate/deactivate the Auto center feature, click on the View/Auto center menu item.

3.3.15 Auto locate record

Description
Clicking on the View/Auto locate record menu item toggles between the two ways in which the
Localize and Select by Point selecting features behave combined with the open Data panel. If the
View/Auto locate record menu item is checked then a selection event automatically makes a jump
on the Data panel list to the record corresponding to the recently selected object. Otherwise, a
selecting event does not affect the position on the Data panel list.

To activate/deactivate the Auto locate record feature, click on the View/Auto locate record
menu item.

3.3.16 Full Screen

Description
Clicking on the View/Full Screen menu item provides for the possibility to switch to the full screen
mode, i.e. make the Editor use the whole computer screen only for the menus, toolbars and the
Map area. The same menu entry is used to leave the full screen mode.

To switch on/off the full screen mode, click on the View/Full Screen menu item.
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Key shortcut
This function can be initiated by pressing the F11 key.

3.4 Select

Description
The Select menu group contains options relating to selection, deselection and visibility of shapes
displayed within the Map area.

3.4.1 Localize

Description
Clicking on the Select/Localize menu item activates the Localize selection method for the Map
area. The Localize selection method is used to select a shape or multiple shapes regardless of
which vector layer is currently the active layer.

To select a shape using the Localize selection method
1. Click on the Select/Localize menu item.
2. Within the Map area move the mouse pointer over the desired shape and click.

To select multiple shapes using the Localize selection method
1. Click on the Select/Localize menu item.
2. Press and hold down the Ctrl key.
3. Within the Map area move the mouse pointer over a shape and click. Repeat this step until all

desired shapes are selected.
4. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Localize
item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.

Similar functions
See Select by Point, Select by Line, Select by Polygon, Select by Circle, Select by Rectangle,
Select by Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.
· Shapes located in layers cannot be selected at the same time.
· The layer containing the last selected shape will be automatically activated (highlighted on the 

Legend panel).
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3.4.2 Select by Point

Description
Clicking on the Select/Select by Point menu item activates the Select by Point selection method for
the Map area. The Localize selection method is used to select a shape or multiple shapes
contained in the currently active vector layer (the one highlighted in the Legend panel).

To select a shape using the Select by Point selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Click on the Select/Select by Point menu item.
3. Within the Map area move the mouse pointer over the shape and click.

To select multiple shapes using the Select by Point selection method
1. Activate (highlight) the vector layer from which the selection is to be made. Do this by clicking on

its name in the Legend panel.
2. Click on the Select/Select by Point menu item.
3. Press and hold down the Ctrl key.
4. Within the Map area move the mouse pointer over the shape and click. Repeat this step until all

desired shapes are selected.
5. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Select
by Point item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.

Similar functions
See Localize, Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by
Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.3 Select by Line

Description
Clicking on the Select/Select by Line menu item activates the Select by Line selection method for
the Map area. The Localize selection method is used to select a shape or multiple shapes
contained in the currently active vector layer (the one highlighted in the Legend panel) that are in a
predefined spatial relation with the user drawn lines. The spatial relation model can be selected
from the Select type list.

To select a shape or multiple shapes using the Select by Line selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Line menu item.
4. Within the Map area click on a point appropriate to the selection model and location of the
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desired shapes - this fixes the starting vertex of the first segment of the line. 
5. Draw the line by moving the mouse pointer in any direction. [OPTIONAL] A single click within

the Map area fixes an intermediate vertex and starts drawing another segment of the line.
6. To fix the final vertex of the line, double-click on any point within the Map area.

To make a multiple selections using the Select by Line selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Line menu item.
4. Press and hold down the Ctrl key.
5. Within the Map area click on a point appropriate to the selection model and location of the

desired shapes - this fixes the starting vertex of the first segment of the line. 
6. Draw the line by moving the mouse pointer in any direction. [OPTIONAL] A single click within

the Map area fixes an intermediate vertex and starts drawing another segment of the line.
7. To fix the final vertex of the line, double-click on any point within the Map area.
8. Repeat the steps from 5 to 7 as many times as needed.
9. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Select
by Line item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.
To remove the selection figure, use the Clear Selection feature.

Similar functions
See Localize, Select by Point, Select by Polygon, Select by Circle, Select by Rectangle, Select by
Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.4 Select by Polygon

Description
Clicking on the Select/Select by Polygon menu item activates the Select by Polygon selection
method for the Map area. The Localize selection method is used to select a shape or multiple
shapes contained in the currently active vector layer (the one highlighted in the Legend panel) that
are in a predefined spatial relation with the user drawn polygons. The spatial relation model can be
selected from the Select type list.

To select a shape or multiple shapes using the Select by Polygon selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Polygon menu item.
4. Within the Map area click on a point appropriate to the selection model and location of the
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desired shapes - this fixes the starting vertex of the first face of the polygon. 
5. Draw the face by moving the mouse pointer in any direction. [OPTIONAL] A single click within

the Map area fixes an intermediate vertex and starts drawing another face of the polygon.
6. To fix the final vertex of the polygon double-click on any point within the Map area. If the first

and the last vertex do not equal then the Editor will complete the polygon by adding the face
connecting this vertices.

To make a multiple selections using the Select by Polygon selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Polygon menu item.
4. Press and hold down the Ctrl key.
5. Within the Map area click on a point appropriate to the selection model and location of the

desired shapes - this fixes the starting vertex of the first face of the polygon. 
6. Draw the face by moving the mouse pointer in any direction. [OPTIONAL] A single click within

the Map area fixes an intermediate vertex and starts drawing another face of the polygon.
7. To fix the final vertex of the polygon double-click on any point within the Map area. If the first

and the last vertex do not equal then the Editor will complete the polygon by adding the face
connecting this vertices.

8. Repeat the steps from 5 to 7 as many times as needed.
9. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Select
by Polygon item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.
To remove the selection figure, use the Clear Selection feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Circle, Select by Rectangle, Select by
Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.5 Select by Circle

Description
Clicking on the Select/Select by Circle menu item activates the Select by Circle selection method
for the Map area. The Localize selection method is used to select a shape or multiple shapes
contained in the currently active vector layer (the one highlighted in the Legend panel) that are in a
predefined spatial relation with the user drawn circles. The spatial relation model can be selected
from the Select type list.

To select a shape or multiple shapes using the Select by Circle selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type
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menu item.
3. Click on the Select/Select by Circle menu item.
4. Within the Map area click on a point appropriate to the selection model and location of the

desired shapes - this fixes the center vertex of the circle.
5. Adjust the length of the radius by moving the mouse pointer in any direction.
6. Click again to finish drawing the circle.

To make a multiple selections using the Select by Circle selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Circle menu item.
4. Press and hold down the Ctrl key.
5. Within the Map area click on a point appropriate to the selection model and location of the

desired shapes - this fixes the center vertex of the circle.
6. Adjust the length of the radius by moving the mouse pointer in any direction.
7. Click again to finish drawing the circle.
8. Repeat the steps from 5 to 7 as many times as needed.
9. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Select
by Circle item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.
To remove the selection figure, use the Clear Selection feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Polygon, Select by Rectangle, Select by
Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.6 Select by Rectangle

Description
Clicking on the Select/Select by Rectangle menu item activates the Select by Rectangle selection
method for the Map area. The Localize selection method is used to select a shape or multiple
shapes contained in the currently active vector layer (the one highlighted in the Legend panel) that
are in a predefined spatial relation with  the user drawn rectangles. The spatial relation model can
be selected from the Select type list.

To select a shape or multiple shapes using the Select by Rectangle selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Rectangle menu item.
4. Within the Map area click on a point appropriate to the selection model and location of the
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desired shapes - this fixes the starting vertex of the rectangle diagonal.
5. Adjust the length of the diagonal by moving the mouse pointer in any direction.
6. Click again to finish drawing the rectangle.

To make a multiple selections using the Select by Rectangle selection method
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Choose a spatial relation model from the Select type list available under the Select/Select type

menu item.
3. Click on the Select/Select by Rectangle menu item.
4. Press and hold down the Ctrl key.
5. Within the Map area click on a point appropriate to the selection model and location of the

desired shapes - this fixes the starting vertex of the rectangle diagonal.
6. Adjust the length of the diagonal by moving the mouse pointer in any direction.
7. Click again to finish drawing the rectangle.
8. Repeat the steps from 5 to 7 as many times as needed.
9. Release the Ctrl key.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If this icon is

not currently visible then click on the leftmost  icon on the same toolbar and then on the Select
by Rectangle item on the drop down list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.
To remove the selection figure, use the Clear Selection feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Polygon, Select by Circle, Select by
Clipboard, Select by Query, Select All.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.7 Select by Clipboard

Description
Clicking on the Select/Select by Clipboard menu item provides a selection method using the
temporary clipboard layer. The Localize selection method is used to select a shape or multiple
shapes contained in the currently active vector layer (the one highlighted in the Legend panel) that
are in a predefined spatial relation with the geometric data stored in the temporary clipboard layer.
The spatial relation model can be selected from the Select type list.

To select a shape or multiple shapes using the Select by Clipboard selection method
1. Prepare the shapes that will be used as selection reference and put them in the temporary

clipboard layer using one of the following functions: Cut, Copy, Copy Special. The selection
geometry can be also loaded from a vector layer file directly in to the temporary clipboard layer
using the Load Clipboard feature.

2. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking
on its name in the Legend panel.

3. Choose a spatial relation model from the Select type list available under the Select/Select type
menu item.

4. Click on the Select/Select by Clipboard menu item.
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Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar and then on
the Select by Clipboard item on the appearing list.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.
To invert the current selection, i.e. select all not selected shapes and deselect all selected shapes
in the active layer, use the Invert Selection feature.
To remove the selection figure, use the Clear Selection feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Polygon, Select by Circle, Select by
Rectangle, Select by Query, Select All.

Note
· The temporary clipboard layer is an automatically created virtual object (stored in memory) and

is not file type specific.
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.8 Clear Selection

Description
Clicking on the Select/Select by Clipboard menu item removes a selection figure created by any of
the following selection methods: Select by Line, Select by Polygon, Select by Circle, Select by
Rectangle, Select by Clipboard.

To remove a selection figure, click on the Select/Select by Clipboard menu item.

Equivalent actions

The same function can be initiated by clicking on the leftmost  icon on the Standard toolbar and
then on the Clear Selection item on the drop down list or on the Clear Selection item in the Map
area context menu.

Note
· All currently selected shapes are highlighted on the Map area.
· The Clear Selection operation will not affect the selected shapes or their selection status.

3.4.9 Select type

Description
Clicking on the Select/Select type menu item displays the list of predefined spatial relation models.
Switching to a different spatial relation model affects the behaviour of the following selection
methods: Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by
Clipboard. The spatial relation models define the geometric relationship on which the selection is
performed.

To switch to a different spatial relation model
1. Click on the Select/Select type menu item - a list of available spatial relation models will appear.
2. Within that list click on a name of the desired model.

Elements of the shapes
The following table explains how the elements of the shapes are classified.
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Object \ Group Interior Boundary Exterior

Point Point
itself

Nothing Everything except
interior

Multipoint Points
themselves

Nothing Everything except
interior

Line Line itself except
the starting and
ending points

Starting and
ending points of

the line

Everything except
interior and
boundary

Polygon Area of the
polygon

Outline of the
polygon

Everything except
interior and
boundary

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu.

3.4.9.1 Equality

Description
Clicking on the Select/Select type/Equality menu item activates the Equality spatial relation model,
i.e. the selection takes place if the selection figure and the shape to be selected match exactly.

Relation table

A \ B Interior Boundary Exterior

Interior T * F

Boundary * * *

Exterior F F *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Equality item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.2 Disjoint

Description
Clicking on the Select/Select type/Disjoint menu item activates the Disjoint spatial relation model,
i.e. the selection takes place if there is no intersection of any kind between the selection figure and
the shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior F F *

Boundary F F *
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Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Disjoint item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.3 Intersect (interior-interior)

Description
Clicking on the Select/Select type/Intersect (interior-interior) menu item activates the Intersect
(interior-interior) spatial relation model, i.e. the selection takes place if there exists an intersection
between the interior of the selection figure and the interior of the shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior T * *

Boundary * * *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Intersect (interior-interior) item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

Note
· This is the default spatial relation model.
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3.4.9.4 Intersect (interior-boundary)

Description
Clicking on the Select/Select type/Intersect (interior-boundary) menu item activates the Intersect
(interior-boundary) spatial relation model, i.e. the selection takes place if there exists an
intersection between the interior of the selection figure and the boundary of the shape to be
selected.

Relation table

A \ B Interior Boundary Exterior

Interior * T *

Boundary * * *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Intersect (interior-boundary) item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.5 Intersect (boundary-interior)

Description
Clicking on the Select/Select type/Intersect (boundary-interior) menu item activates the Intersect
(boundary-interior) spatial relation model, i.e. the selection takes place if there exists an
intersection between the boundary of the selection figure and the interior of the shape to be
selected.

Relation table

A \ B Interior Boundary Exterior

Interior * * *

Boundary T * *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
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menu and then on the Intersect (boundary-interior) item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.6 Intersect (boundary-boundary)

Description
Clicking on the Select/Select type/Intersect (boundary-boundary) menu item activates the Intersect
(boundary-boundary) spatial relation model, i.e. the selection takes place if there exists an
intersection between the boundary of the selection figure and the boundary of the shape to be
selected.

Relation table

A \ B Interior Boundary Exterior

Interior * * *

Boundary * T *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Intersect (boundary-boundary)  item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.7 Touch (boundary-interior)

Description
Clicking on the Select/Select type/Touch (boundary-interior) menu item activates the Touch
(boundary-interior) spatial relation model, i.e. the selection takes place if there exists an
intersection between the boundary of the selection figure and the interior of the shape to be
selected and there is no intersection between the interior of the selection figure and the interior of
the shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior F * *

Boundary T * *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
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1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Touch (boundary-interior) item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.8 Touch (boundary-boundary)

Description
Clicking on the Select/Select type/Touch (boundary-boundary) menu item activates the Touch
(boundary-boundary) spatial relation model, i.e. the selection takes place if there exists an
intersection between the boundary of the selection figure and the boundary of the shape to be
selected and there is no intersection between the interior of the selection figure and the interior of
the shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior F * *

Boundary * T *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Touch (boundary-interior) item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.9 Cross

Description
Clicking on the Select/Select type/Cross menu item activates the Cross spatial relation model, i.e.
the selection takes place if there exists an intersection between the interior of the selection figure
and the interior of the shape to be selected and an intersection between the interior of the selection
figure and the exterior of the shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior T * T

Boundary * * *
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Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Cross item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.10 Cross (lines only)

Description
Clicking on the Select/Select type/Cross (lines only) menu item activates the Cross (lines only)
spatial relation model. This selection model can be used only if the currently active selection
method is Select by Line. With the active Cross (lines only) selection model the selection takes
place if there exists a 0-dimensional (point) intersection between the interior of the selection line
and the interior of the line to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior 0 * *

Boundary * * *

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Cross (lines only) item on the Select type list.

Associated functions
For general information about spatial relation models refer to the Select type help section.

3.4.9.11 Within

Description
Clicking on the Select/Select type/Within menu item activates the Within spatial relation model, i.e.
the selection takes place if the selection figure is entirely contained in the shape to be selected.
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Relation table

A \ B Interior Boundary Exterior

Interior T * F

Boundary * * F

Exterior * * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Within item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.12 Contains

Description
Clicking on the Select/Select type/Contains menu item activates the Contains spatial relation
model, i.e. the selection takes place if the selection figure contains the entire shape to be selected.

Relation table

A \ B Interior Boundary Exterior

Interior T * *

Boundary * * *

Exterior F F *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Contains item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.
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3.4.9.13 Overlap

Description
Clicking on the Select/Select type/Overlap menu item activates the Overlap spatial relation model,
i.e. the selection takes place if there exists an intersection between the selection figure and the
shape to be selected but the selection figure and the shape to be selected cannot be equal or
contain each other.

Relation table

A \ B Interior Boundary Exterior

Interior T * T

Boundary * * *

Exterior T * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant

Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Overlap item on the Select type list.

Associated functions
For general information about spatial relation models and the list of functions affected by activating
this option refer to the Select type help section.

3.4.9.14 Overlap (lines only)

Description
Clicking on the Select/Select type/Overlap (lines only) menu item activates the Overlap (lines only)
spatial relation model. This selection model can be used only if the currently active selection
method is Select by Line. With the active Overlap (lines only) selection model the selection takes
place if there exists an 1-dimensional (line) intersection between the selection line and the line to
be selected but the selection line and the line to be selected cannot be equal or contain each
other.

Relation table

A \ B Interior Boundary Exterior

Interior 1 * T

Boundary * * *

Exterior T * *

Table legend
A - selection figure
B - shape to be selected
T - true, intersection exists
0 - true, intersection exists and is 0-dimensional (point)
1 - true, intersection exists and is 1-dimensional (line)
2 - true, intersection exists and is 2-dimensional (area)
F - false, intersection does not exist
* - irrelevant
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Equivalent actions
The same function can be initiated by clicking on the Select type item in the Map area context
menu and then on the Overlap (lines only) item on the Select type list.

Associated functions
For general information about spatial relation models refer to the Select type help section.

3.4.10 Select by Query

Description
Clicking on the Select/Select by Query menu item provides for selection of shapes based on the
SQL type query performed on their attributes. A shape is said to satisfy the query if for the shape
the logical value of the query is True.

To perform a selection of shapes based on their attributes
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Click on the Select/Select by Query menu item - this invokes the Select by Query dialog box.
3. Within the Select by Query dialog box construct the SQL type query - see Constructing SQL

type query instructions below.
4. Choose the selection result form the drop down list beside the Execute button - see Selection

results below.
5. Click on the Execute button - all shapes satisfying the current query will be selected.
6. [OPTIONAL] To perform a subquery or a different query repeat the steps from 2 to 4.
7. Click on the Cancel button.

Selection results
· Replace Selection - a new selection is performed regardless of what is currently selected,
· Add to Selection - the recent selection is preserved and the shapes that satisfy the current query

are selected,
· Subtract from Selection - from the set of recently selected shapes the shapes that do not satisfy

the current query remain selected.
· Narrow Selection - from the set of recently selected shapes the shapes that satisfy the current

query remain selected.

Select by Query dialog box.

Constructing SQL type query
The SQL type query consists of comparison statements connected with logical operators in the
following way:
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[comparison statement] [logical operator] [comparison statement] ... [logical operator] [comparison
statement].

Additionally, round brackets can be used to group/prioritize a sequence within the query. The left
bracket '(' must always appear before a comparison statement and the right bracket ')' after a
comparison statement. The logical operators AND and OR must appear before a comparison
statement/left bracket or after a comparison statement/right bracket and not at the beginning or
ending of the query. The negation operator NOT must appear after a logical operator/left bracket
or at the beginning of the query. A comparison statement consists of a primary attribute, relation
operator and value/secondary attribute in the following way:

[primary attribute] [relation] [value]     or     [primary attribute] [relation] [secondary attribute].

An attribute which name contains a space must be written inside the square brackets.

To add a comparison statement to the query
1. Within the Comparison statement box choose the primary attribute from the left Attribute drop

down list.
2. To compare the primary attribute with a value click on the Value radio button in the same box.

To compare the primary attribute with another attribute click on the Attribute radio button in the
same box.

3. (A) If you have chosen Value in the previous step then a tool appropriate to the primary attribute
type will appear below the Value radio button. If the primary attribute is of: String, Number or
Float type then a text box will appear, Boolean type then a drop down list will appear, Date type
then a date picker will appear. (B) If you have chosen Attribute in the previous step then a drop
down list will appear below the Attribute radio button. The drop down list will contain all the
attributes of the same type as the primary attribute except the primary attribute itself.

4. (A) Specify the value in the tool. (B) Pick the secondary attribute from the drop down list.
5. Choose a relation operator form the Relation drop down list.
6. Click on the Add button in the same box.

To add a logical operator to the query
1. Within the Logical operator box choose logical/negation operator from the drop down list.
2. Click on the Add button in the same box.

To put brackets around a desired part of the query
1. Within the query text box move the mouse pointer to the beginning/ending of the desired part.
2. Press and hold the left mouse button.
3. Move the mouse pointer to the ending/beginning of the desired part.
4. Release the left mouse button.
5. Click on the (   ) button.

To blank the query, click on the Clear button.

Associated functions
To review the attributes of a vector layer, use the Show attributes table feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Polygon, Select by Circle, Select by
Rectangle, Select by Clipboard, Select All.

Note
· The default logical value of the SQL type query, i.e. the logical value of the empty query, is True.
· A summary of the most recent selection operation is displayed below the query text box.
· When the primary attribute is of String type and specifying a value for the LIKE comparison the

'_' character can be used as a single unspecified character and the '%'  character as a sequence
of unspecified characters.
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3.4.11 Select All

Description
Clicking on the Select/Select All menu item selects all shapes in the active vector layer, i.e. the
whole layer.

To select all shapes in a vector layer
1. Activate (highlight) the vector layer on which the selection is to be performed. Do this by clicking

on its name in the Legend panel.
2. Click on the Select/Select All menu item.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.

Similar functions
See Localize, Select by Point, Select by Line, Select by Polygon, Select by Circle, Select by
Rectangle, Select by Clipboard, Select by Query.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.12 Invert Selection

Description
Clicking on the Select/Invert Selection menu item inverts the current selection, i.e. selects all not
selected shapes and deselects all selected shapes in the currently active vector layer.

To invert the current selection, click on the Select/Invert Selection menu item.

Equivalent actions
The same function can be initiated by clicking on the Invert Selection item in the Map area context
menu.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

3.4.13 Deselect all

Description
Clicking on the Select/Deselect all menu item cancels all previously made selections.

To cancel all previously made selections, click on the Select/Deselect all menu item.

Equivalent actions
The same function can be initiated by clicking on the Deselect all item in the Map area context
menu.
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Key shortcut
This function can be initiated by pressing the Ctrl+D key combination.

Note
· All currently selected shapes are highlighted on the Map area.
· Changing the active layer cancels all previously made selections.

3.4.14 Show Selected

Description
Clicking on the Select/Show Selected menu item makes the Map area display only the selected
shapes. The visibility of layers other than the active vector layer is not affected in any way.

To make the Map area display only the desired shapes
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Select/Show Selected menu item.

Equivalent actions
The same function can be initiated by clicking on the Show Selected item in the Map area context
menu.

Associated functions
See Hide Selected, Show all, Hide all.

Note
· The Show Selected feature takes into account the current selection and not the successive

ones.

3.4.15 Hide Selected

Description
Clicking on the Select/Hide Selected menu entry makes the Map area hide the selected shapes.
The visibility of layers other than the active vector layer is not affected in any way.
To make the Map area hide the desired shapes
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Select/Hide Selected menu item.

Equivalent actions
The same function can be initiated by clicking on the Hide Selected item in the Map area context
menu.

Associated functions
See Show Selected, Show all, Hide all.

Note
· The Hide Selected feature takes in to account the current selection and not the successive ones.
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3.4.16 Show all

Description
Clicking on the Select/Show all menu item makes the Map area display all shapes. The visibility of
layers other than the active vector layer is not affected in any way.

To make the Map area display all shapes from the currently active vector layer, click on the
Select/Show all menu item.

Equivalent actions
The same function can be initiated by clicking on the Show all item in the Map area context menu.

Associated functions
See Show Selected, Hide Selected, Hide all.

3.4.17 Hide all

Description
Clicking on the Select/Hide all menu item makes the Map area hide all shapes. The visibility of
layers other than the active vector layer is not affected in any way.

To make the Map area hide all shapes from the currently active vector layer, click on the
Select/Hide all menu item.

Equivalent actions
The same function can be initiated by clicking on the Hide all item in the Map area context menu.

Associated functions
See Show Selected, Hide Selected, Show all.

3.4.18 Locate record

Description
Clicking on the Select/Locate record menu item locates the record of a recently selected shape on
the attributes list of the Data panel (if opened). This feature can be used only if the shapes are
being selected with the Localize or Select by Point selecting features.

To locate the record of a desired shape on the attributes list of the Data panel
1. Activate (highlight) the vector layer containing the shape. Do this by clicking on its name in the 

Legend panel.
2. Make a selection of the shape using the Localize or Select by Point selecting feature.
3. Expand the context menu by clicking with the right mouse button on the selected layer's name in

the Legend panel and click on the Open layer data item - the Data panel will appear at the
bottom of the Editor window.

4. Click on the Select/Locate record menu item.

Equivalent actions
The same function can be initiated by clicking on the Locate record item in the Map area context
menu.

3.5 Layer

Description
The Layer menu group contains options used to operate on whole layers and layer files.
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3.5.1 New

Description
Clicking on the Layer/New menu item provides for creation of a new vector layer along with its file.
A newly created layer is automatically added to the current project and displayed on the list of
currently open layers on the Legend panel. The most common reason to create a new vector layer
is to convert an existing one in to a different layer format.

To create a new vector layer
1. Click on the Layer/New menu item - this invokes the Create New Layer dialog box.
2. Within the Create New Layer dialog box select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the newly created layer file. A new folder can be

created by clicking on the  icon at the top-right corner of the Create New Layer dialog box,
entering its name and pressing the Enter key.

4. Enter a name for the layer file in the File name list.
5. Choose the file format from the Save as type list.
6. Click on the Save button - this invokes the Layer settings dialog box. [OPTIONAL] For SQL

database layer formats, such as the TatukGIS SQL Layer (TTKLS), the MS Access SQL Layer
dialog box appears before the Layer settings dialog box. Within the MS Access SQL Layer
dialog box choose the layer type from the Select SQL type list by clicking on the appropriate
option. When finished click on the OK button - this invokes the Layer settings dialog box.

7. Within the Layer settings dialog box set the extent of the newly created layer In the Layer extent
box.

8. Set the layer coordinate system - click on the [...] button in the Layer CS box and follow any of
the procedures described in the Coordinate systems help topic starting from the step 2.

9. Choose the layer dimensionality from the Layer dimension list: 2D - vertices are described by
two parameters, that is, their planar coordinates, Z - vertices are described by the planar
coordinates and altitude, M - vertices are described by the planar coordinates and a parameter
of any meaning (e.g. height), ZM - vertices are described by the planar coordinates, altitude and
a parameter of any meaning.

10. [OPTIONAL] If the chosen format of the newly created layer is the ArcView Shape Files (SHP),
select one option from the Store shapes type list. The SHP layer format can store only one type
of shapes.

11. Click on the OK button.

To convert a vector layer file in to a different format
1. Complete the procedure of creating a new vector layer described above.
2. Ensure that the newly created layer is active - do it by clicking on its name in the Legend panel.
3. Click on the Layer/Import menu item - this invokes the Open dialog box.
4. Within the Open dialog box select the appropriate drive from the Look in list.
5. Locate the layer file by entering the directory that contains this file.
6. Double-click on the layer file name.
7. If the importing procedure encounters no problem a message box will appear informing you

about the success. Confirm it by clicking on the OK button.
8. Click on the File/Save menu item - now the newly created layer contains all the data from the

imported layer file.
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Layer settings dialog box.

MS Access SQL Layer dialog box.

Note
· One of the available vector layer file formats for the creation of a new layer is TatukGIS SQL

Layer (*.ttkls), which means that the new layer will be a SQL database file. By default the layer is
saved to the Microsoft Access SQL database file with the option to choose between the following
three formats: OpenGIS SQL Simple Features for SQL Implementation, The TatukGIS (native)
binary SQL vector layers method, Geomedia Access Warehouse or Geomedia SQL Server.
Such file can be converted for the usage with different SQL database such as MSSQL, Oracle,
Interbase, DB2, MySQL, PostgreSQL, etc. For more information visit FAQ section on the
TatukGIS web page (http://www.tatukgis.com/) and search for the following FAQ number:
Q10765.

· If creating a new vector layer as the SQL database layer file use a file name without spaces or
any special characters. This will ensure that the file is compatible with various SQL database
products.

3.5.2 Add

Description
Clicking on the Layer/Add menu item provides for opening an existing layer file. The newly opened
layer is automatically added to the current project and displayed on the list of currently open layers
on the Legend panel. The geometric data contained in the layer is rendered on the Map area. This
operation does not affect other open layers in any way.

To open a layer file and add it to the current project
1. Click on the Layer/Add menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
3. Locate the layer file by entering the directory that contains this file.
4. Double-click on the layer file name.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Add item in the Legend panel context menu.

http://www.tatukgis.com/
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Similar functions
To add a layer file stored on a remote server, use the Add from server feature.
To add a layer stored in a database, use the Add SQL layer feature.

Key shortcut
This function can be initiated by pressing the Ctrl+Ins key combination.

Note
· By default the Open dialog box displays the files of all supported formats - Common files (...)

selection in the Files of type list in the Open dialog box. This can be altered by selecting a
different filter in the same list.

· The Add feature can be also used to import point data with attributes that is stored in the
Comma Separated Values (CSV) point layer file format. The CSV file can be opened as a CSV
layer type. Because some programs (such as Microsoft Excel) export CSV files with semicolon
as value separator (instead of comma) and with comma as a digit separator (instead of dot) for
numeric values, there can be some format deviations concerning CSV files. The Editor is
designed to auto detect the arrangement of a CSV file and import it in a correct way. However,
when saving to a CSV file the Editor always uses comma as value separator and dot as a digit
separator. It also finds out if the values are integers, floating point numbers, or character strings.
Others, such as dates, are treated as character strings.

3.5.3 Add SQL layer

Description
Clicking on the Layer/Add SQL layer menu item invokes the Connect to SQL layers dialog box.
The Connect to SQL layers dialog box provides for opening a layer stored entirely in a database.
The newly opened layer is automatically added to the current project and displayed on the list of
currently open layers on the Legend panel. The geometric data contained in the layer is rendered
on the Map area. This operation does not affect other open layers in any way.
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Connect to SQL layers dialog box.

To add a layer through a database connection
1. Click on the Layer/Add SQL layer menu item - this invokes the Connect to SQL layers dialog

box.
2. Fill the required connection fields: ADO Connection string and Dialect. For the ADO Connection

string an automated method can be used instead of simply typing the connection string. To use
it click on the Build... button and the frmJoinDatabase.ADOConnection ConnectionString dialog
box will appear.

3. Within the frmJoinDatabase.ADOConnection ConnectionString dialog box select one option on
the Source of Connection list: if you would like to use connection parameters stored in a file,
choose the Use Data Link File option and click on the Browse... button. If you would like to build
a connection string from scratch, choose the Use Connection String option and click on the
Build... button.

4. (A) If you have chosen the Use Data Link File option in the previous step, the Select Data Link
File dialog box will appear. Within in select the appropriate drive from the Look in list, locate the
data link file by entering the directory that contains this file, and double-click on the file name.
(B) If you have chosen the Use Connection String option in the previous step, the Data Link
Properties dialog box will appear. Within the four tabs of the Data Link Properties dialog box the
user finds a number of options used to define the ODBC link parameters. Set up a connection
with the ODBC interface appropriately to your computer environment configuration. When
finished, click on the OK button.

5. When the step 4 is finished (regardless whether (A) or (B) was performed), the
frmJoinDatabase.ADOConnection ConnectionString dialog box will appear again. Click on the
OK button within this dialog box - this brings back the Connect to SQL layers dialog box.

6. [OPTIONAL] If required fill the additional connection fields: Storage, Schema, Catalog and
Additional parameters.

7. Within the Connect to SQL layers dialog box click on the Connect button - if the connection
parameters loaded from the file are correct the connection is established and the list of available
layers is displayed within the Available layers box.
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8. Select the desired layer in the the Available layers box.
9. Click on the Add layer button.
10. [OPTIONAL] To save the connection parameters of the selected layer for future use, click on

the Save file button. Within the Save dialog box locate the folder where you would like to store
the connection file, enter a name for the file in the File name list and click on the Save button.

11. Click on the Close button.

Similar functions
To add a layer file stored on a local drive, use the Add feature.
To add a layer file stored on a remote server, use the Add from server feature.
To import attribute tables from a database or data file, use the Import data feature.
To preview and use the attributes stored in a database, use the Join Database feature.

3.5.4 Add from server

Description
Clicking on the Layer/Add from server menu item provides for opening an existing layer file from a
remote server. The newly opened layer is automatically added to the current project and displayed
on the list of currently open layers on the Legend panel. The geometric data contained in the layer
is rendered on the Map area. This operation does not affect other open layers in any way. The
opening of a file or project from a server requires that the user provide the exact path to the file on
the remote server and the server's network address.

To open a layer file stored on a remote server and add it to the current project
1. Click on the Layer/Add from server menu item - this invokes the Open from server dialog box.
2. Within the Open from server dialog box enter the exact path to the file or select it using the

Address list.
3. Click on the OK button.

Open from server dialog box.

Similar functions
To add a layer stored in a database, use the Add SQL layer feature.
To add a layer file stored on a local drive, use the Add feature.

3.5.5 Remove

Description
Clicking on the Layer/Remove menu item removes the currently active layer from the current
project and from the Editor. The layer is automatically removed from the list of currently open
layers on the Legend panel and its geometry is removed from the Map area.  This operation does
not affect other open layers in any way.

To remove a layer from the current project and from the Editor
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Remove menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar or on the
Remove entry in the Legend panel context menu.
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Key shortcut
This function can be initiated by pressing the Ctrl+Del key combination.

3.5.6 Import

Description
Clicking on the Layer/Import menu item provides for importing any vector layer file to a vector layer
open in the Editor. The data from the file being imported can replace or be appended to the active
layer. If the imported data comes from a different file format than the active layer then it is
automatically converted in to an appropriate format.

To import a vector layer and replace/append to the one already open in the Editor
1. Activate (highlight) the layer to which the import is to be done. Do this by clicking on its name in

the Legend panel.
2. Click on the Layer/Import menu entry - this invokes the Merge layers dialog box.
3. Within the Import dialog box click on the Layer... button - this invokes the Open dialog box.
4. Within the Open dialog box select the appropriate drive from the Look in list.
5. Locate the layer file by entering the directory that contains this file.
6. Double-click on the layer file name - this brings back the Merge layers dialog box.
7. If you would like to replace the open layer with the imported one click on the Replace option. If

you would like to merge the open layer with the imported one click on the Append option.
8. Click on the Next>> button.
9. [OPTIONAL] If you would like to import just a part of the layer instead of its entirety click on the 

Builder... button - this invokes the Query builder dialog box. Within the Query builder dialog box
construct a SQL-type query that has logical value True for all shapes that you would like to
import. When finished, click on the OK button - this brings back the Import dialog box.

10. Choose the extent to be imported from the Extent list.
11. Click on the Next>> button.
12. Adjust the settings for attribute importing.
13. Click on the Next>> button - a progress bar will appear informing you about the progress of the

import procedure.
14. When the progress bar reaches 100% the import procedure is completed. Click on the OK

button.

Merge layers dialog box.
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Query builder dialog box.

Constructing SQL type query
The SQL type query consists of comparison statements connected with logical operators in the
following way:

[comparison statement] [logical operator] [comparison statement] ... [logical operator] [comparison
statement].

Additionally, round brackets can be used to group/prioritize a sequence within the query. The left
bracket '(' must always appear before a comparison statement and the right bracket ')' after a
comparison statement. The logical operators AND and OR must appear before a comparison
statement/left bracket or after a comparison statement/right bracket and not at the beginning or
ending of the query. The negation operator NOT must appear after a logical operator/left bracket
or at the beginning of the query. A comparison statement consists of a primary attribute, relation
operator and value/secondary attribute in the following way:

[primary attribute] [relation] [value]     or     [primary attribute] [relation] [secondary attribute].

An attribute which name contains a space must be written inside the square brackets.

To add a comparison statement to the query
1. Within the Comparison statement box choose the primary attribute from the left Attribute drop

down list.
2. To compare the primary attribute with a value click on the Value radio button in the same box.

To compare the primary attribute with another attribute click on the Attribute radio button in the
same box.

3. (A) If you have chosen Value in the previous step then a tool appropriate to the primary attribute
type will appear below the Value radio button. If the primary attribute is of: String, Number or
Float type then a text box will appear, Boolean type then a drop down list will appear, Date type
then a date picker will appear. (B) If you have chosen Attribute in the previous step then a drop
down list will appear below the Attribute radio button. The drop down list will contain all the
attributes of the same type as the primary attribute except the primary attribute itself.

4. (A) Specify the value in the tool. (B) Pick the secondary attribute from the drop down list.
5. Choose a relation operator form the Relation drop down list.
6. Click on the Add button in the same box.

To add a logical operator to the query
1. Within the Logical operator box choose logical/negation operator from the drop down list.
2. Click on the Add button in the same box.

To put brackets around a desired part of the query
1. Within the query text box move the mouse pointer to the beginning/ending of the desired part.
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2. Press and hold the left mouse button.
3. Move the mouse pointer to the ending/beginning of the desired part.
4. Release the left mouse button.
5. Click on the (   ) button.

To blank the query, click on the Clear button.

Note
· If importing to a ArcView Shape File (SHP) layer file format, the shape type (point, multipoint,

polyline, or polygon) of the file being imported must be of the same type as the layer to which it
is being imported. Otherwise the procedure will result in an error message stating that the file
types are not compatible.

· The default logical value of the SQL type query, i.e. the logical value of the empty query, is True.
· Concerning the Query Builder dialog box, when the primary attribute is of String type and

specifying a value for the LIKE comparison the '_' character can be used as a single unspecified
character and the '%'  character as a sequence of unspecified characters.

3.5.7 Export

Description
Clicking on the Layer/Export menu item provides for exporting a vector layer or its part in to a layer
file of a chosen format.

To convert a vector layer file in to a different format
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Export menu item - this invokes the Export Layer dialog box.
3. Within the Export Layer dialog box click on the OK button - this invokes the Save As dialog box.
4. Within the Save As dialog box select the appropriate drive from the Save in list.
5. Locate the folder where you would like to store the layer file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

6. Enter a name for the layer file in the File name list.
7. Click on the Save button.

To export a part of a vector layer in to a separate layer file (manual selection)
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Layer/Export menu item - this invokes the Export Layer dialog box.
4. Within the Export Layer dialog box click on the Selected objects check box.
5. Adjust the extent used for the export procedure using the options from the Select extent list.
6. Click on the OK button - this invokes the Save As dialog box.
7. Within the Save As dialog box select the appropriate drive from the Save in list.
8. Locate the folder where you would like to store the layer file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

9. Enter a name for the layer file in the File name list.
10.Click on the Save button.

To export a desired part of a vector layer in to a separate layer file (selection by SQL type
query)
1. Activate (highlight) the layer containing the desired shapes. Do this by clicking on its name in

the Legend panel.
2. Click on the Layer/Export menu item - this invokes the Export Layer dialog box.
3. Click on the Builder button - this invokes the Query Builder dialog box.
4. Within the Select by Query dialog box construct the SQL type query - see Constructing SQL

type query instructions below. When finished click on the OK button - all  shapes from the
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active layer for which the statement is satisfied will be selected and the Export Layer dialog box
will be brought back.

5. Within the Export Layer dialog box adjust the extent used for the export procedure using the
options from the Select extent list.

6. [OPTIONAL] If you would like to export only one type of shapes (points, multipoints, lines or
polygons) set the appropriate filter in the Select shape type list.

7. Click on the OK button - this invokes the Save As dialog box.
11.Within the Save As dialog box select the appropriate drive from the Save in list.
12. Locate the folder where you would like to store the layer file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

8.  Enter a name for the layer file in the File name list.
9.  Click on the Save button.

Select extent list options
· Map extent - export the extent covering entirety of the currently active layer,
· Visible extent - export the extent currently visible in the Map area,
· User defined - export the extent that is manually defined by the user by entering horizontal

coordinates of the right and left extent limits and vertical coordinates of the top and bottom
extent limits.

· Clipped by extent (for Visible extent and User defined) - when checked, all shapes partially
outside the defined extent will be clipped; otherwise shapes partially outside the defined extend
will be exported whole.

Export Layer dialog box.
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Query builder dialog box.

Constructing SQL type query
The SQL type query consists of comparison statements connected with logical operators in the
following way:

[comparison statement] [logical operator] [comparison statement] ... [logical operator] [comparison
statement].

Additionally, round brackets can be used to group/prioritize a sequence within the query. The left
bracket '(' must always appear before a comparison statement and the right bracket ')' after a
comparison statement. The logical operators AND and OR must appear before a comparison
statement/left bracket or after a comparison statement/right bracket and not at the beginning or
ending of the query. The negation operator NOT must appear after a logical operator/left bracket
or at the beginning of the query. A comparison statement consists of a primary attribute, relation
operator and value/secondary attribute in the following way:

[primary attribute] [relation] [value]     or     [primary attribute] [relation] [secondary attribute].

An attribute which name contains a space must be written inside the square brackets.

To add a comparison statement to the query
1. Within the Comparison statement box choose the primary attribute from the left Attribute drop

down list.
2. To compare the primary attribute with a value click on the Value radio button in the same box.

To compare the primary attribute with another attribute click on the Attribute radio button in the
same box.

3. (A) If you have chosen Value in the previous step then a tool appropriate to the primary attribute
type will appear below the Value radio button. If the primary attribute is of: String, Number or
Float type then a text box will appear, Boolean type then a drop down list will appear, Date type
then a date picker will appear. (B) If you have chosen Attribute in the previous step then a drop
down list will appear below the Attribute radio button. The drop down list will contain all the
attributes of the same type as the primary attribute except the primary attribute itself.

4. (A) Specify the value in the tool. (B) Pick the secondary attribute from the drop down list.
5. Choose a relation operator form the Relation drop down list.
6. Click on the Add button in the same box.

To add a logical operator to the query
1. Within the Logical operator box choose logical/negation operator from the drop down list.
2. Click on the Add button in the same box.

To put brackets around a desired part of the query
1. Within the query text box move the mouse pointer to the beginning/ending of the desired part.
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2. Press and hold the left mouse button.
3. Move the mouse pointer to the ending/beginning of the desired part.
4. Release the left mouse button.
5. Click on the (   ) button.

To blank the query, click on the Clear button.

Note
· If exporting from a layer containing multiple shape types to a SHP file format, only one shape

type can be exported due to the specifications of this format. An attempt to export multiple shape
types to a SHP file format will result in an error message.

· If creating a new vector layer as the SQL database layer file use a file name without spaces or
any special characters. This will ensure that the file is compatible with various SQL database
products.

· The default logical value of the SQL type query, i.e. the logical value of the empty query, is True.
· Concerning the Query Builder dialog box, when the primary attribute is of String type and

specifying a value for the LIKE comparison the '_' character can be used as a single unspecified
character and the '%'  character as a sequence of unspecified characters.

3.5.8 Restructure

Description
Clicking on the Layer/Restructure menu item provides for basic management of the attributes table
of the currently active vector layer.

To add a new attribute to a vector layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Restructure menu item - this invokes the Restructure layer: [chosen layer

name] dialog box.
3. Within the Restructure layer: [chosen layer name] dialog box click on the New button.
4. In the Name text field set the name of the newly created attribute.
5. Choose the type of the new attribute from the Type list.
6. [OPTIONAL] If you have chosen the string type set the maximal number of characters in the 

Width text box. If you have chosen the number type set the total number of digits in the Width
text box and the number of decimal digits in the Decimal text box.

7. Click on the OK button.

To to delete an attribute from a vector layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Restructure menu item - this invokes the Restructure layer: [chosen layer

name] dialog box.
3. Within the Restructure layer: [chosen layer name] dialog box select the desired attribute by

clicking on its entry in the attributes list.
4. Click on the Delete button.
5. Click on the OK button.
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Restructure layer dialog box opened for vector layer named world.

Associated features
To set the value of some attribute for all shapes belonging to a vector layer, use the Set column
value feature.

Note
· The type of an existing attribute cannot be changed.

3.5.9 Save layer properties

Description
Clicking on the Layer/Save layer properties menu item provides for saving properties of the
currently active vector layer in to a separate configuration file (in INI format).

To save the properties of a vector vector layer in to a separate INI file
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Save layer properties menu item - this invokes the Save As dialog box.
3. Within the Save As dialog box select the appropriate drive from the Save in list.
4. Locate the folder where you would like to store the INI file. You may also create a new folder by

clicking on  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

5. [OPTIONAL] Enter a name for the INI file in the File name list.
6. Click on the Save button.

Equivalent actions
The same function can be initiated by clicking on the Save layer properties item in the Legend
panel context menu.

Associated functions
To customize the properties of a vector layer, use the Properties feature.
To load the properties of a vector layer from a previously created INI file, use the Load layer
properties feature.

Note
· If the INI file is stored in the same folder as the corresponding vector layer file and has the

default name it will be automatically loaded whenever the corresponding layer file is being
opened.
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3.5.10 Load layer properties

Description
Clicking on the Layer/Load layer properties menu item provides for loading properties of the
currently active vector layer from a separate configuration file (in INI format).

To load the properties of a vector layer from a separate INI file
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Load layer properties menu item - this invokes the Open dialog box.
3. Within the Open dialog box select the appropriate drive from the Look in list.
4. Locate the INI file by entering the directory that contains this file.
5. Double-click on the INI file name.

Equivalent actions
The same function can be initiated by clicking on the Load layer properties item in the Legend
panel context menu.

Associated functions
To customize the properties of a vector layer, use the Properties feature.
To save the properties of a vector layer in to an INI file, use the Save layer properties feature.

Note
· If the INI file is stored in the same folder as the corresponding vector layer file and has the

default name it will be automatically loaded whenever the corresponding layer file is being
opened.

3.5.11 Properties

Description
Clicking on the Layer/Properties menu item invokes the layer properties dialog box. The layer
properties dialog box comes in two different forms (refer to subtopics for detailed information): 
· Vector dialog box - properties dialog box for vector type layers,
· Raster dialog box - properties dialog box for raster raster type layers (images, grids).
The layer properties dialog box provides various layer displaying customization features as
coloring, labeling, coordinate system adjustment, charts creation, etc. Consistent with GIS
principles, and unlike with some more CAD oriented solutions, the Editor saves the layer visual
properties to the project file or the layer properties file. Making changes to the layer properties do
not alter the layer file in any way. Not saving the layer properties to the layer file itself allows for
greater inter-operability, because the same layer file can be used in different ways in multiple
projects or applications.

IMPORTANT
· All settings apply to the section currently selected in the Section list. A section is a set of visual

properties defined for a range of zoom levels. The Visible section is the default section - visual
properties defined for it are valid for any zoom level.

· To automatically customize the visual properties of a vector or grid layer, click on the Wizard
button and follow the instructions. Two examples of using the Wizard feature can be found
further in this topic in Common scenarios section: To automatically color all shapes from a
vector layer proportionally to the value of some numeric attribute and To automatically
create and color optimal zones for a grid layer.

· A number of units can be used to define each size/width setting: px - pixel, m - meter, mm -
milimeter, in - inch, pt - point = 1/72 inch.

· Inserting an asterisk after the unit symbol makes the size of the objects for which the setting
applies relative to the current Map area scale.
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Vector dialog box displaying properties of a polygon type layer named world.
Section list indicated.

Common scenarios

To add a new section to a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Vector: [layer name] dialog box for a vector layer and Raster: [layer name]
dialog box for a raster layer.

3. Within the Vector/Raster dialog box switch to any tab on which the Section list is visible.

4. Click on the  button at the left hand side of the Section list.

To delete a section from a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Vector: [layer name] dialog box for a vector layer and Raster: [layer name]
dialog box for a raster layer.

3. Within the Vector/Raster dialog box switch to any tab on which the Section list is visible.
4. Within the Section list click on the routine to be deleted.

5. Click on the  button at the left hand side of the Section list.

To delete all custom sections from a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Vector: [layer name] dialog box for a vector layer and Raster: [layer name]
dialog box for a raster layer.

3. Within the Vector/Raster dialog box switch to any tab on which the Section list is visible.

6. Click on the  button at the left hand side of the Section list.
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To change/set/turn off the coordinate system for a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Vector: [layer name] dialog box for a vector layer and Raster: [layer name]
dialog box for a raster layer.

3. Within the Vector/Raster dialog box switch to the Layer tab by clicking on its label at the top of
the dialog box.

4. Within the Layer tab make sure that the Parameters subtab is active.
5. Click on the Select button - this invokes the Coordinate System dialog box.
6. Follow any procedure described in the Coordinate Systems help topic starting each from the

step 2.
7. Within the Vector/Raster dialog box click on the OK button.

To automatically color all shapes from a vector layer proportionally to the value of some
numeric attribute
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Vector: [layer name] dialog box.
3. Within the Vector dialog box click on the Wizard button - this invokes the Rendering Wizard

dialog box.
4. Within the Rendering Wizard dialog box select the desired attribute from the Formula... drop

down list and click on the Next button.
5. Make sure that the Continuous values option is selected and that the Minimal value and the

Maximal value text boxes display correct values. Click on the Next button.
6. Make sure that the Color option is selected in the Render by list. Click on the Apply button - this

brings back the Vector: [layer name] dialog box.
7. Within the Vector dialog box click on the OK button.

Rendering Wizard dialog box.

To automatically create and color optimal zones for a grid layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Expand the Legend panel context menu over the layer name and click on the Properties item -

this invokes the Raster: [layer name] dialog box.
3. Within the Raster dialog box click on the Wizard button - this invokes the Grid Wizard dialog

box.
4. If needed, adjust the colors using three color buttons (blue, green and red buttons on the

screenshot below).
5. Click on the Apply button.
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Grid Wizard dialog box.

Associated functions
To save the layer properties to a file, use the Save layer properties feature.
To load the layer properties from a file, use the Load layer properties feature.

Equivalent actions
The same function can be initiated by double clicking on the layer name in the Legend panel or on
the Properties item in the Legend panel context menu.

3.5.11.1 Vector dialog box

Description
The Vector dialog box is the layer property dialog box for the vector type layers. It consists of 6 up
to 8 settings tabs (depending of the vector layer format):
· Layer tab,
· Section tab,
· Renderer tab,
· Line tab - appears only if the layer supports line type shapes,
· Area tab - appears only if the layer supports polygon type shapes,
· Marker tab - appears only if the layer supports point or multipoint type shapes,
· Label tab,
· Chart tab.
For general information about layer properties and common usage scenarios refer to the 
Properties help topic.
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3.5.11.1.1  Layer

Vector dialog box, Layer tab, Parameters subtab.

Parameters subtab
· Path - [READ ONLY] path to the file containing the layer.
· Name - [READ ONLY] name of the file containing the layer.
· Caption - identificator of the layer under which it appears in the Legend panel.
· Coordinate System - coordinate system in which the layer is displayed.
· Cached Paint - if unchecked, the rendering is performed directly on the Map area, which can

dramatically improve performance with very large and complicated vector data sets but causes 
Map area flickering.

· Labels on top - if checked, labels are displayed on top of all layers in the project. 
· Incremental paint - if checked, the rendering in Drag mode is performed only after the mouse

button is released, which can dramatically improve performance with very large and complicated
vector data sets.

· Transparency - factor defining the layer transparency; it must be greater or equal to 0 and lower
or equal to 100, where 0 means invisible and 100 means opaque.

· Addition - factor determining the degree to which the background color of the layer is added to
the color of the layer shapes; it must be greater or equal to 0 and lower or equal to 100, where 0
means shape color and 100 means layer background color; this feature applies only to anaglyph
images.

Info subtab
· File informations - [READ ONLY] information about the file format.
· User comments - additional information provided by the user/file creator.
· From Codepage - codepage to be used for reading layer parameters.
· To Codepage - codepage to be used for processing/displaying layer parameters.



72 TatukGIS Editor/Viewer

(c)2000-2010 TatukGIS. All rights Reserved

3.5.11.1.2  Section

Vector dialog box, Section tab.

Section tab
· Visible - if unchecked, the layer remains hidden, it is not rendered within the Map area.
· Minimum scale - minimum scale at which the current section will be rendered; click on the

Current button to fill it with the scale at the current zoom level.
· Maximum scale - maximum scale at which the current section will be rendered; click on the

Current button to fill it with the scale at the current zoom level.
· Render if match query - query statement based on layer attributes - the current section settings

will apply only to the shapes for which the logical value of this statement is true; the default
logical value of the query, i.e. the logical value of the empty query, is true.

· Legend - name of the current section that is displayed in the Legend panel.
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3.5.11.1.3  Renderer

Vector dialog box, Renderer tab, First subtab.

First/Second subtab
· Number of zones - number of zones (ranges) into which the attribute values will be divided for

the rendering purposes; if the number of zones is negative then logarithmic scale will be used.
· Minimum value - the lowest value of the lowest zone; a shape with the attribute value lower than

Minimum value will be rendered in the Default color.
· Maximum value - the highest value of the highest zone; a shape with the attribute value higher

than Maximum value will be rendered in the Default color.
· Start color - color in which the shapes belonging to the lowest zone will be rendered.
· End color - color in which the shapes belonging to the highest zone will be rendered.
· Default color - color in which the shapes with the attribute value outside the [Minimum value,

Maximum value] zone will be rendered.
· Start size - size of point/width of line/width of polygon outline that will be rendered for the shapes

belonging to the lowest zone.
· End size - size of point/width of line/width of polygon outline that will be rendered for the shapes

belonging to the highest zone.
· Default size - size of point/width of line/width of polygon outline that will be rendered for the

shapes outside the [Minimum value,Maximum value] zone.
· Render expression - query statement based on layer attributes - only the shapes for which the

logical value of this statement is true will be rendered using the custom rendering routines; if it is
empty or contains only attribute name all shapes will be rendered.

· Round - if positive, number of decimal digits of the fractional part of the numbers displayed in
the Legend panel; if negative, number of decimal digits cut from the integral part of the numbers
displayed in the Legend panel.
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3.5.11.1.4  Line

Vector dialog box, Line tab, Line subtab.

Line subtab
· Style - style of the line.
· Width - width of the line; check Use renderer option below to use global renderer settings found

on the Renderer tab.
· Color - color of the line; check Use renderer option below to use global renderer settings found

on the Renderer tab.
· Bitmap - image file used for drawing line instead of color.
· Pattern - pattern of the line.
· Symbol - character/image used for drawing line instead of color.
· Symbol Gap - distance between subsequent symbols.
· Symbol Rotate - relative rotation of each symbol (in degrees).
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

Outline subtab
· Style - style of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Width - width of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Color - color of the outline.
· Bitmap - image file used for drawing outline instead of color.
· Pattern - pattern of the outline.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

Smart size subtab
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· Size - factor defining how wide (at least) must be a line at the current scale to be rendered.
· Field - if the width of lines should be rendered on the basis of some attribute, use this list to

choose appropriate one.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

3.5.11.1.5  Area

Vector dialog box, Area tab, Area subtab.

Area subtab
· Pattern - pattern of the polygon area.
· Bitmap - image file used for filling area instead of color.
· Color - color of the polygon area; check Use renderer option below to use global renderer

settings found on the Renderer tab.
· Symbol - character/image used for filling area instead of color.
· Symbol Gap - distance between subsequent symbols.
· Symbol Rotate - relative rotation of each symbol (in degrees).
· Symbol Size - size of each symbol.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

Outline subtab
· Style - style of the outline.
· Width - width of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Color - color of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Bitmap - image file used for drawing outline instead of color.
· Pattern - pattern of the outline.
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· Symbol - character/image used for drawing outline instead of color.
· Symbol Gap - distance between subsequent symbols.
· Symbol Rotate - relative rotation of each symbol (in degrees).
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

Smart size subtab
· Size - factor defining how big (at least) must be a polygon at the current scale to be rendered.
· Field - if the size of polygons should be rendered on the basis of some attribute, use this list to

choose appropriate one.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

3.5.11.1.6  Marker

Vector dialog box, Marker tab, Marker subtab.

Marker subtab
· Style - style of the point marker.
· Size - size of the point marker; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Color - color of the point marker; check Use renderer option below to use global renderer

settings found on the Renderer tab.
· Bitmap - image file used for drawing point marker instead of color.
· Pattern - pattern of the point marker.
· Symbol - character/image used for drawing point marker instead of color.
· Symbol Rotate - relative rotation of each symbol (in degrees).
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.
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Outline subtab
· Style - style of the outline.
· Width - width of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Color - color of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Bitmap - an image file used for drawing outline instead of color.
· Pattern - pattern of the outline.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

Smart size subtab
· Size - factor defining how big (at least) must be a point marker at the current scale to be

rendered.
· Field - if the size of point markers should be rendered on the basis of some attribute, use this list

to choose appropriate one.
· Include in legend - if checked, the currently selected section is displayed in the Legend panel as

a subgroup of its layer.

3.5.11.1.7  Label

Vector dialog box, Label tab, Label subtab.

Label subtab
· Width - maximum label width.
· Height - maximum label height.
· Color - label background color; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Bitmap - image file used for label background instead of color.
· Pattern - pattern of the label background.
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· Font - label font.
· Field - attribute, which values are displayed as the labels.
· Value - if not blank, a formatted combination of strings and attributes that is displayed as a label

instead of attribute defined in Field; IMPORTANT - see Value label formatting help topic for
detailed information on label formatting.

· Include in legend - if checked, the label symbol of the currently selected section is displayed in
the Legend panel.

· Visible - if checked, the labels defined for the current section are visible within the Map area.

Outline subtab
· Style - style of the outline.
· Width - width of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Color - color of the outline; check Use renderer option below to use global renderer settings

found on the Renderer tab.
· Bitmap - image file used for drawing outline instead of color.
· Pattern - pattern of the outline.
· Include in legend - if checked, the label symbol of the currently selected section is displayed in

the Legend panel.
· Visible - if checked, the labels defined for the current section are visible within the Map area.

Smart size subtab
· Size - factor defining how big (at least) must be the shape at the current scale to render its label.
· Field - if the size of labels should be rendered on the basis of some attribute, use this list to

choose appropriate one.
· Include in legend - if checked, the label symbol of the currently selected section is displayed in

the Legend panel.
· Visible - if checked, the labels defined for the current section are visible within the Map area.

Position subtab
· Position - checkboxes indicate where does the Editor should try to put the label: 5 - [reference

position] shape centroid or, if the centroid is outside the shape, the most optimal point, 1 -
top-left position with respect to reference, 2 - over reference, 3 - top-right position with respect to
reference, 4 - on the left hand side of reference, 6 - on the right hand side of reference, 7 -
bottom-left position with respect to reference, 8 - under reference, 9 - bottom-right position with
respect to reference; the order of checking decides about the position priority; when the Editor is
unable to put the label in some position it tries the position with lower priority.

· Flow - if checked, the Editor always tries to position the label in the most optimal place.
· Alignment - defines alignment of the label within the label extent: Single line - only the first line of

the label is displayed, Left justify - text is aligned to the left border of the label extent, Center -
text is centered within the label extent, Right justify - text is aligned to the right border of the label
extent, Follow - only the first line of the label is displayed in the most optimal place or, for line
type shapes, along the line.

· Avoid overlap - if checked, the labels will never overlap each other.
· Avoid duplicates - if checked, if more than one shape has some value of attribute used in label

definition then only the label of the shape with the lowest GIS_UID value is displayed.
· Label Rotate - rotation of the label (in degrees).
· Include in legend - if checked, the label symbol of the currently selected section is displayed in

the Legend panel.
· Visible - if checked, the labels defined for the current section are visible within the Map area.

3.5.11.1.7.1  Value label formatting

Value label formatting
The Editor provides a simple markup language for custom label formatting.

Visual formatting
The Editor supports some of the standard HTML markers for visual formatting:
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· <B></B> - text inside is displayed in bold font.
· <BOL></BOL> - equivalent of <B></B> supported for compatibility with other GIS products.
· <I></I> - text inside is displayed in italic font.
· <U></U> - text inside is underlined.
· <HR> - horizontal line.
· <BR> - line break.
· <P></P> - text inside is treated as a complete paragraph.
· <STRONG></STRONG> - text inside is displayed in extra bold font.
· <FONT SIZE="S" NAME="F" COLOR="C"></FONT> - text inside is displayed in the F font

(e.g. ARIAL, TIMES, TAHOMA, etc) of the size S and the C color (where C can be one of the
following: BLACK, BLUE, FUCHSIA, GRAY, GREEEN, LIME, MAROON, NAVY, OLIVE,
PURPLE, RED, SILVER, TEAL, WHITE, YELLOW); the C color can be also given in the RGB
representation #RRGGBB, where RR, GG and BB are two digit hexadecimal number
representations of the red, green and blue color intensities.

· &amp; - the & sign.
· &nbsp; - forced insertion of space.
· &gt; - the > sign.
· &lt; - the < sign.

Example: The code 

<U><FONT NAME="ARIAL" COLOR=#FF0000><I>value1</I></FONT>&nbsp;<FONT
NAME="ARIAL" COLOR=#0000FF><B>&lt;</B></FONT>&nbsp;<FONT NAME="ARIAL"
COLOR=#00FF00><BOL>value2</BOL></FONT></U>

will result in the following label: value1 < value2 .

Inserting attributes
The code {FIELD_NAME:FORMAT} inserts the value of an attribute named FIELD_NAME with
formatting defined by the format string FORMAT. The format string is attribute type specific.

Formatting of NUMBER and FLOAT type attributes
A) Automatic formatting

Format character Format name Description

C or c Currency Integer next to the character defines the number of
most significant digits to be displayed.

D or d Decimal Integer next to the character defines the minimum
number of digits to be displayed; number will be
padded with zeroes if necessary; non integral value
will be rounded first.

E or e Scientific (exponential) Integer next to the character defines the number of
digits displayed after the decimal point (default is 2);
number formatted as Scientific is always displayed in
exponential form; 

F or f Fixed-point Integer next to the character defines the number of
digits displayed after the decimal point (default is 2).

G or g General The Editor tries to display the number in best suited
form; Integer next to the character defines the
number of significant digits.

N or n Number Integer next to the character defines the number of
digits displayed after the decimal point (default is 2);
inserts thousand separators accordingly to the
system settings.

P or p Percent The number is multiplied by 100; i defines the
number of digits displayed after the decimal point
(default is 2).
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R or r Round-trip Equivalent of General (for .NET compatibility only);
Integer next to the character is ignored.

X or x Hexadecimal Integer next to the character defines the minimum
number of hexadecimal digits to be displayed;
number will be padded with zeroes if necessary; non
integral value will be rounded first; 

B) Custom formatting

Format character Name Description

# Digit placeholder Defines optional position of a digit; if corresponding digit
does not exist the digit placeholder is neglected.

0 Zero placeholder Defines obligatory position of a digit; if corresponding digit
does not exist the zero placeholder is replaced by '0'.

. Decimal point Defines the position of the decimal point.

[other] Other characters are displayed without any change.

Examples:

Code Attribute value Result string Note

{FIELD_NAME:#.###} 123.59 '123.59'

{FIELD_NAME:#.000} 123.59 '123.590'

{FIELD_NAME:#.####0} 123.59 '123.59000'

{FIELD_NAME:#####.###} -123.59 '-123.59'

{FIELD_NAME:00000.###} 123.59 '00123.59'

{FIELD_NAME:0-0-0-0-0} 123.59 '0-0-1-2-4' rounding

{FIELD_NAME:over #;below #;zero
#}

123.59 'over 124' rounding

{FIELD_NAME:over #;below #;zero
#}

-123.59 'below 124' rounding, no minus sign

{FIELD_NAME:over #;below #;zero
#}

0 'zero ' no zero sign

{FIELD_NAME:over #;below #;zero
0}

0 'zero 0'

{FIELD_NAME:;below #;zero#} 123.59 '' empty string

{FIELD_NAME:over #;;zero#} -123.59 '' empty string

{FIELD_NAME:over #;below #;} 0 '' empty string

Formatting of BOOLEAN type attributes
A) Automatic formatting

Code Attribute value Result string

{FIELD_NAME} True 'True'

{FIELD_NAME} False 'False'

B) Custom formatting

Examples:

Code Attribute value Result Note

{FIELD_NAME:yes;no} True 'yes'

{FIELD_NAME:yes;no} False 'no'

{FIELD_NAME:yes} True 'yes'

{FIELD_NAME:yes} False '' empty string
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{FIELD_NAME:;no} True '' empty string

{FIELD_NAME:yes;} False '' empty string

{FIELD_NAME:yes;no1;no2} False 'no1;no2'

Formatting of DATE type attributes

Note: character in brackets represents a string consisting of any number of this character.

Format string Format name Description

d Day Day as a number 1..31 (without trailing zero).

dd Day Day as a number 01..31 (with trailing zero).

ddd Day Day as an abbreviated name of the day of the week;
depends on system regional settings.

dddd(d) Day Day as a full name of the day of the week; depends on
system regional settings.

f Second fraction Most significant digit of the second fraction.

ff Second fraction Two most significant digits of the second fraction.

fff Second fraction Three most significant digits of the second fraction.

ffff Second fraction Four most significant digits of the second fraction.

fffff Second fraction Five most significant digits of the second fraction.

ffffff Second fraction Six most significant digits of the second fraction.

fffffff(f) Second fraction Seven most significant digits of the second fraction.

F Second fraction Most significant digit of the second fraction; if zero then
nothing will be displayed.

FF Second fraction Two most significant digits of the second fraction; trailing
zeros will be truncated.

FFF Second fraction Three most significant digits of the second fraction; trailing
zeros will be truncated.

FFFF Second fraction Four most significant digits of the second fraction; trailing
zeros will be truncated.

FFFFF Second fraction Five most significant digits of the second fraction; trailing
zeros will be truncated.

FFFFFF Second fraction Six most significant digits of the second fraction; trailing
zeros will be truncated.

FFFFFF(F) Second fraction Seven most significant digits of the second fraction; trailing
zeros will be truncated.

g(g) Period or Era [not supported yet]

h Hour Hour as a number 1..12 (without trailing zero).

hh(h) Hour Hour as a number 01..12 (with trailing zero).

H Hour Hour as a number 1..24 (without trailing zero).

HH(H) Hour Hour as a number 01..24 (with trailing zero).

m Minute Minute as a number 0..59 (without trailing zero).

mm(m) Minute Minute as a number 00..59 (with trailing zero).

M Month Month as a number 1..12 (without trailing zero).

MM Month Month as a number 01..12 (with trailing zero).

MMM Month Month as an abbreviated name of the month; depends on
system regional settings.

MMMM(M) Month Month as a full name of the month; depends on system
regional settings.

s Seconds Seconds as a number 0..59 (without trailing zero).

ss(s) Seconds Seconds as a number 00..59 (with trailing zero).

t AM/PM First character of the 'AM' or 'PM' string; depends on system
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regional settings.

tt(t) AM/PM 'AM' or 'PM' string; depends on system regional settings.

y Year Year as a two digit number; if year has less than two digits
then one digit number will be displayed.

yy Year Year as a two digit number; if year has less than two digits
then result will be padded with zero.

yyy Year Year as a three digit number; if year has less than three
digits then result will be padded with zeros.

yyyy Year Year as a four digit number; if year has less than four digits
then result will be padded with zeros.

yyyy(y) Year Year as a five digit number; if year has less than five digits
then result will be padded with zeros.

z(z) GMT Offset [not supported yet]

[other] Other characters are displayed without any change.

Examples:

Code Attribute value Result string Note

{FIELD_NAME:d} 3rd of June 2008:
17:09:03.650, US
English

'3'

{FIELD_NAME:dd} 3rd of June 2008:
17:09:03.650, US
English

'03'

{FIELD_NAME:ddd} 3rd of June 2008:
17:09:03.650, US
English

'Tue'

{FIELD_NAME:dddd} 3rd of June 2008:
17:09:03.650, US
English

'Tuesday'

{FIELD_NAME:M} 3rd of June 2008:
17:09:03.650, US
English

'6'

{FIELD_NAME:MM} 3rd of June 2008:
17:09:03.650, US
English

'06'

{FIELD_NAME:MMM} 3rd of June 2008:
17:09:03.650, US
English

'Jun'

{FIELD_NAME:MMMM} 3rd of June 2008:
17:09:03.650, US
English

'June'

{FIELD_NAME:y} 3rd of June 2008:
17:09:03.650, US
English

'08'

{FIELD_NAME:yy} 3rd of June 2008:
17:09:03.650, US
English

'08'

{FIELD_NAME:yyy} 3rd of June 2008:
17:09:03.650, US
English

'008'

{FIELD_NAME:yyyy} 3rd of June 2008:
17:09:03.650, US
English

'2008'

{FIELD_NAME:yyyyy} 3rd of June 2008:
17:09:03.650, US
English

'02008'
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{FIELD_NAME:h} 3rd of June 2008:
17:09:03.650, US
English

'5'

{FIELD_NAME:hh} 3rd of June 2008:
17:09:03.650, US
English

'05'

{FIELD_NAME:H} 3rd of June 2008:
17:09:03.650, US
English

'17'

{FIELD_NAME:HH} 3rd of June 2008:
17:09:03.650, US
English

'17'

{FIELD_NAME:t} 3rd of June 2008:
17:09:03.650, US
English

'P'

{FIELD_NAME:tt} 3rd of June 2008:
17:09:03.650, US
English

'PM'

{FIELD_NAME:m} 3rd of June 2008:
17:09:03.650, US
English

'9'

{FIELD_NAME:mm} 3rd of June 2008:
17:09:03.650, US
English

'09'

{FIELD_NAME:mmm} 3rd of June 2008:
17:09:03.650, US
English

'09' ignored 3rd 'm'
in format string

{FIELD_NAME:s} 3rd of June 2008:
17:09:03.650, US
English

'3'

{FIELD_NAME:ss} 3rd of June 2008:
17:09:03.650, US
English

'03'

{FIELD_NAME:f} 3rd of June 2008:
17:09:03.650, US
English

'6'

{FIELD_NAME:ffff} 3rd of June 2008:
17:09:03.650, US
English

'6500'

{FIELD_NAME:FFFF} 3rd of June 2008:
17:09:03.650, US
English

'65'

{FIELD_NAME:yyyy/MM/dd
HH/mm/ss.ffff}

3rd of June 2008:
17:09:03.650, US
English

'2008/06/03
17:09:03.6500'

Formatting of STRING type attributes

Note: i is a placeholder for an integer number.

Format character Name Description

$ normal text Text displayed without any changes.

S uppercase Text displayed in uppercase.

s lowercase Text displayed in lowercase.

i [at the beginning] first
character

i>0 defines from which character (counting from the beginning of
the string) should be the string displayed; if i<0 then the
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characters are counted from the end of the string.

i [at the end] last
character

i>0 defines up to which character (counting from the beginning
of the string) should be the string displayed; if i<0 then the
characters are counted from the end of the string.

Examples:

Code Attribute value Result string Note

{FIELD_NAME:$} 'Abcdefghij' 'Abcdefghij'

{FIELD_NAME:S} 'Abcdefghij' 'ABCDEFGHIJ'

{FIELD_NAME:s} 'Abcdefghij' 'abcdefghij'

{FIELD_NAME:1$-1} 'Abcdefghij' 'Abcdefghij'

{FIELD_NAME:1S3} 'Abcdefghij' 'ABC'

{FIELD_NAME:1s3} 'Abcdefghij' 'abc'

{FIELD_NAME:1$-3} 'Abcdefghij' 'Abcdefgh'

{FIELD_NAME:-3$-1} 'Abcdefghij' 'hij'

{FIELD_NAME:4$-4} 'Abcdefghij' 'defg'

{FIELD_NAME:8$-8} 'Abcdefghij' '' empty string

3.5.11.1.8  Chart

Vector dialog box, Chart tab, Chart subtab.

Chart subtab
· Style - style of the chart.
· Size - size of the chart; check Use renderer option below to use global renderer settings found

on the Renderer tab.
· Minimum value - bottom value for the chart; applies to BAR style chart only.
· Maximum value - top value for the chart; applies to BAR style chart only.
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· Include in legend - if checked, the chart symbol of the currently selected section is displayed in
the Legend panel.

Values 1-4/Values 5-8 subtab
· Values - the attributes used to build the chart for each shape.
· Legends - text that is displayed besides the chart symbol in the Legend panel.
· Include in legend - if checked, the chart symbol of the currently selected section is displayed in

the Legend panel.

3.5.11.2 Raster dialog box

Description
The Raster dialog box is the layer property dialog box for the raster type layers (images, grids). It
consists of 3 settings tabs :
· Layer tab,
· Section tab,
· Pixel tab - appears if the layer was not recognized as a grid layer,
· Grid tab - appears only when the layer was recognized as a grid layer.
For general information about layer properties and common usage scenarios refer to the 
Properties help topic.

3.5.11.2.1  Layer

Raster dialog box, Layer tab, Parameters subtab.

Parameters subtab
· Path - [READ ONLY] path to the file containing the layer.
· Name - [READ ONLY] name of the file containing the layer.
· Caption - identificator of the layer under which it appears in the Legend panel.
· Coordinate System - coordinate system in which the layer is displayed.
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· Cached Paint - if unchecked, the rendering is performed directly on the Map area, which can
dramatically improve performance with very large and complicated vector data sets.

· Labels on top - if checked, labels are displayed on top of all layers in the project. 
· Incremental paint - if checked, the rendering in Drag mode is performed only when the mouse

button is released, which can dramatically improve performance with very large and complicated
vector data sets.

· Transparency - factor defining the layer transparency; it must be greater or equal to 0 and lower
or equal to 100, where 0 means invisible and 100 means opaque.

· Addition - factor determining the degree to which the background color of the layer is added to
the color of the layer shapes; it must be greater or equal to 0 and lower or equal to 100, where 0
means shape color and 100 means layer background color; this feature applies only to anaglyph
images.

Info subtab
· File informations - [READ ONLY] information about the file format, resolution and bit depth.
· User comments - additional information provided by the user/file creator.
· From Codepage - codepage to be used for reading layer parameters.
· To Codepage - codepage to be used for processing/displaying layer parameters.

3.5.11.2.2  Section

Raster dialog box, Section tab.

Section tab
· Visible - if unchecked, the layer remains hidden, it is not rendered within the Map area.
· Minimum scale - minimum scale at which the current section will be rendered; click on the

Current button to fill it with the scale at the current zoom level.
· Maximum scale - maximum scale at which the current section will be rendered; click on the

Current button to fill it with the scale at the current zoom level.
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3.5.11.2.3  Pixel

Raster dialog box, Pixel tab.

Pixel tab
· Red - defines how much the red color is reduced/amplified with respect to the original value for

each pixel; can vary from -100 to 100, where -100 means that the red color is completely
reduced and 100 that the red color is fully amplified.

· Green - defines how much the green color is reduced/amplified with respect to the original value
for each pixel; can vary from -100 to 100, where -100 means that the green color is completely
reduced and 100 that the green color is fully amplified.

· Blue - defines how much the blue color is reduced/amplified with respect to the original value for
each pixel; can vary from -100 to 100, where -100 means that the blue color is completely
reduced and 100 that the blue color is fully amplified.

· Brightness - defines how much all colors are reduced/amplified with respect to the original value
for each pixel; can vary from -100 to 100, where -100 turns the layer black and 100 turns the
layer white.

· Contrast - defines how much each color is reduced or amplified with respect to the original value
for each pixel; for values from -100 to 0 the color is reduced if its original intensity is above the
average and is amplified if its original intensity is below the average; for values from 0 to 100 the
color is reduced if its original intensity is below the average and is amplified if its original intensity
is above the average.

· Inversion - if checked, the layer is displayed in negative colors.
· Grayscale - if checked, the layer is displayed in grayscale colors.
· Histogram - if checked, the colors are amplified with the usage of histogram computed for the

current layer.
· Reset button - restores the default settings on the Pixel tab.
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3.5.11.2.4  Grid

Raster dialog box, Grid tab.

Grid tab - appears only if the layer is recognized as a grid layer

·  button - adds a new zone to the Zone list.

·  button - deletes the zone currently selected in the Zone list.

·  button - deletes all zones from the Zone list.
· Color button - invokes the Color dialog box in which the user can pick a color for the zone

currently selected in the Zone list.
· Min - lower limit for the zone currently selected in the Zone list.
· Max - upper limit for the zone currently selected in the Zone list.
· Legend - name of the zone currently selected in the Zone list as it is displayed in the Legend

panel.
· Shadow - if checked, the grid layer is treated as an height map and an imitation of shadow is

cast as if the light source was placed on the left hand side of the layer.

3.5.12 Move up

Description
Clicking on the Layer/Move up menu item shifts up the currently active layer on the priority list. The
priority list (the list of all currently open layers) is displayed on the Legend panel. Positions on the
priority list affects the order of rendering on the Map area. The layer topmost on the priority list has
the highest priority and is rendered as the last one, i.e. on the top of other layers. The priority
decreases downwards.

To increase the priority of a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Move up menu item.
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Equivalent actions
The same function can be initiated by clicking on the Move up item in the Legend panel's context
menu. The order on the priority list can be changed by dragging items on the Legend panel with
the mouse pointer.

Associated functions
To decrease the priority of a layer, use the Move down feature.

3.5.13 Move down

Description
Clicking on the Layer/Move down menu item shifts down the currently active layer on the priority
list. The priority list (the list of all currently open layers) is displayed on the Legend panel. Positions
on the priority list affects the order of rendering on the Map area. The layer topmost on the priority
list has the highest priority and is rendered as the last one, i.e. on the top of other layers. The
priority decreases downwards.

To decrease the priority of a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Move down menu item.

Equivalent actions
The same function can be initiated by clicking on the Move down item in the Legend panel's
context menu. The order on the priority list can be changed by dragging items on the Legend panel
with the mouse pointer.

Associated functions
To increase the priority of a layer, use the Move up feature.

3.5.14 Show attributes table

Description
Clicking on the Layer/Show attributes table menu item shows the attributes table of the active
vector layer in the Data panel. If the Data panel is close at the moment of calling this function it will
be opened first.

To show the attributes table of a vector layer in the Data panel
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
1. Click on the Layer/Show attributes table menu item.

Equivalent actions
The same function can be activated by clicking on the Show attributes table item in the Legend
panel context menu.

3.5.15 Visible

Description
Clicking on the Layer/Visible menu item toggles visibility of the currently active layer on the Map
area. Even if a layer is invisible it still remains open.

To toggle visibility of a desired layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Visible menu item.

Equivalent actions
The visibility of a layer can be also toggled by clicking on a square on the left side of its name on
the Legend panel.
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3.5.16 Recalculate extent

Description
Clicking on the Layer/Recalc extent menu item causes recalculation of the total extent of a vector
layer. This feature is especially useful while editing geometry of a vector layer. The geometry
editing may affect a layer in such a way that the initial total extent does not contain all the geometry
of the layer or it is too big and causes some operations to be performed ineffectively.

To recalculate the total extent of a layer
1. Activate (highlight) the desired layer. Do this by clicking on its name in the Legend panel.
2. Click on the Layer/Recalc extent menu item.

Note
· If the active layer is not a vector type layer this feature remains inactive.

3.6 Shape

Description
The Shape menu group contains features used for editing individual shapes (objects) within a
vector layer. The term "shape" is commonly used in GIS world to describe a single geometric
object of a vector type. A shape can be one of the following four types: point, multi-point, line,
polygon.

Object elements
The following table explains how the elements of the geometric objects are classified.

Object \ Class Interior Boundary Exterior

Point Point
itself

Nothing Everything except
interior

Multipoint Points
themselves

Nothing Everything except
interior

Line Line itself except
the starting and
ending points

Starting and
ending points of

the line

Everything except
interior and
boundary

Polygon Area of the
polygon

Outline of the
polygon

Everything except
interior and
boundary

3.6.1 Edit shape

Description
Clicking on the Shape/Edit shape menu item activates the editing tool of a general purpose. The
user can edit an existing shape of any type (point, multipoint, line and polygon) by interacting with it
within the Map area. All editing actions are performed on the vertices. 
The way the vertices are being connected can be changed by choosing one of the edit modes -
see Edit mode, Nearest point and After active point topics for details.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point
and Snap to line topics for details.
The table below describes the placement of vertices for each shape type.

Shape type Vertices

Point Point itself

Multipoint Points themselves

Line Starting, final and
intermediate points

Polygon Intermediate points of the
outline
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Editing a point type shape

To move a point in to a different place
1. Activate (highlight) the layer that contains the desired point. Do this by clicking on its name in

the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the desired point and its destination place are visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the desired point and click to make a selection.
5. Without moving the mouse pointer press the left mouse button.
6. Move the mouse pointer to the destination place. When finished release the left mouse button.
7. Click on the Shape/Edit shape menu item to confirm the change.

Editing a multipoint type shape

To deform a multipoint by moving its vertices to different places
1. Activate (highlight) the layer that contains the desired multipoint. Do this by clicking on its name

in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the multipoint and its intended post-edition form are visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over any of the vertices belonging to the multipoint and click to make a

selection - all vertices belonging to that multipoint will appear in green color.
5. Move the mouse pointer over a vertex that you would like to displace and press the left mouse

button.
6. Move the mouse pointer to the destination place. When finished release the left mouse button.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
8. Click on the Shape/Edit shape menu item to confirm the change.

To remove vertices from a multipoint
1. Activate (highlight) the layer that contains the desired multipoint. Do this by clicking on its name

in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the multipoint is visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over any of the vertices belonging to the multipoint and click to make a

selection - all vertices belonging to that multipoint will appear in green color.
5. Move the mouse pointer over a vertex that you would like to remove and click.
6. After approximately one second click again without moving the mouse pointer.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
8. Click on the Shape/Edit shape menu item to confirm the change.

Editing a line type shape

To deform a line by moving its vertices to different places
1. Activate (highlight) the layer that contains the desired line. Do this by clicking on its name in the 

Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the line and its intended post-edition form are visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the line and click to make a selection - all vertices belonging to

that line will appear in green color.
5. Move the mouse pointer over a vertex that you would like to displace and press the left mouse

button.
6. Move the mouse pointer to the destination place. When finished release the left mouse button.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
8. Click on the Shape/Edit shape menu item to confirm the change.

To deform/expand a line by adding new vertices
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1. Activate (highlight) the layer that contains the desired line. Do this by clicking on its name in the 
Legend panel.

2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the
Map area such that the line and its intended post-edition form are visible.

3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the line and click to make a selection.
5. Move the mouse pointer over the place where you would like to create a new vertex and click.
6. [OPTIONAL] Repeat the step 5 as many times as needed.
7. Click on the Shape/Edit shape menu item to confirm the change.

To remove vertices from a line
1. Activate (highlight) the layer that contains the desired line. Do this by clicking on its name in the 

Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the line is visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the line and click to make a selection - all vertices belonging to

that line will appear in green color.
5. Move the mouse pointer over a vertex that you would like remove and click.
6. After approximately one second click again without moving the mouse pointer.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
8. Click on the Shape/Edit shape menu item to confirm the change.

Editing a polygon type shape

To deform a polygon by moving its vertices to different places
1. Activate (highlight) the layer that contains the desired polygon. Do this by clicking on its name in

the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the polygon and its intended post-edition form are visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the polygon and click to make a selection - all vertices belonging

to that polygon will appear in green color.
5. Move the mouse pointer over a vertex that you would like to displace and press the left mouse

button.
6. Move the mouse pointer to the destination place. When finished release the left mouse button.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
8. Click on the Shape/Edit shape menu item to confirm the change.

To deform/expand a polygon by adding new vertices
1. Activate (highlight) the layer that contains the desired polygon. Do this by clicking on its name in

the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the polygon and its intended post-edition form are visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the desired polygon and click on it to make a selection.
5. Move the mouse pointer over a place where you would like to create a new vertex and click.
6. [OPTIONAL] Repeat the step 5 as many times as needed.
7. Click on the Shape/Edit shape menu item to confirm the change.

To remove vertices from a polygon
1. Activate (highlight) the layer that contains the desired polygon. Do this by clicking on its name in

the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area such that the polygon is visible.
3. Click on the Shape/Edit shape menu item.
4. Move the mouse pointer over the polygon and click to make a selection - all vertices belonging

to that polygon will appear in green color.
5. Move the mouse pointer over a vertex that you would like remove and click.
6. After approximately one second click again without moving the mouse pointer.
7. [OPTIONAL] Repeat the steps 5 and 6 for as many times as needed.
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8. Click on the Shape/Edit shape menu item to confirm the change.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. Another way
is to click on the Edit shape item in the Map area context menu.

Associated functions
To remove a shape from a vector layer, use the Delete Shape feature.
To restore the state of a shape as it was previously saved, use the Revert Shape feature.

3.6.2 New shape

Description
Clicking on the Shape/Create new shape menu item displays the list of tools used create a new
shape within a vector layer. A newly created shape is built upon a basis formed of vertices in a way
specific to its type: point, multipoint, line or polygon. The table below describes the placement of
vertices for each shape type.

Shape type Vertices

Point Point itself

Multipoint Points themselves

Line Starting, final and
intermediate points

Polygon Intermediate points of the
outline

Equivalent actions

The same function can be initiated by clicking on the rightmost  icon on the Standard toolbar.

3.6.2.1 Point

Description
Clicking on the Shape/Create new shape/Point menu item activates the editing feature used to
create a shape of the point type within a vector layer. Each vertex created with the Point feature is
treated individually, as a separate shape.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point
and Snap to line topics for details.

To create a point or a set of points within a vector layer
1. Activate (highlight) the layer in which the point is to be created. Do this by clicking on its name in

the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the point.
3. Click on the Shape/Create new shape/Point menu item.
4. Within the Map area move the mouse pointer over any point and click. [OPTIONAL] Repeat this

step as many times as needed.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Point item on
the drop down list.

Similar functions
To create a set of points that is treated as a single shape (of the multipoint type), use the Multipoint
 feature.

Associated functions
To edit an existing shape, use the Edit object feature.
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To remove a shape from a vector layer use, the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than point

then this feature will be inactive.

3.6.2.2 Multipoint

Description
Clicking on the Shape/Create new shape/Multipoint menu item activates the editing feature used to
create a shape of the multipoint type within a vector layer. A vertex created with the Multipoint
feature can be treated as a separate shape or as a part of a multipoint type shape.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point
and Snap to line topics for details.

To create a multipoint within a vector layer
1. Activate (highlight) the layer in which the multipoint is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the multipoint.
3. Click on the Shape/Create new shape/Multipoint menu item.
4. Within the Map area move the mouse pointer over any point and click - a new vertex will be

created. [OPTIONAL] Repeat this step as many times as needed.
5. When the multipoint is completed click on the Shape/Create new shape/Multipoint menu item to

confirm.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Multipoint
item on the drop down list.

Similar functions
To create a set of vertices that are treated as a separate shapes (of the point type), use the Point
feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

multipoint then this feature will be inactive.

3.6.2.3 Line

Description
Clicking on the Shape/Create new shape/Line menu item activates the editing feature used to
create a broken line within a vector layer. This shape is of the line type. It is composed of two or
more sequentially numbered vertices with straight line segments connecting them. Intermediate
vertices are created manually.
The way the vertices are being connected can be changed by choosing one of the edit modes -
see Edit mode, Nearest point and After active point topics for details.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point
and Snap to line topics for details.

To create a broken line within a vector layer
1. Activate (highlight) the layer in which the broken line is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the line.
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3. Click on the Shape/Create new shape/Line menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

line will be fixed.
5. To create an intermediate vertex along with a line segment move the mouse pointer over a

different point and click. [OPTIONAL] Repeat this step as many times as needed.
6. When the broken line is drawn click on the Shape/Create new shape/Line menu entry to

confirm.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Line item on
the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line 90°, Line free,
Closed line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle
3point base [linear].

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.
· The last inserted vertex is marked with a red color.

3.6.2.4 Line 90°

Description
Clicking on the Shape/Create new shape/Line 90° menu item activates the editing feature used to
create a special kind of a broken line within a vector layer. This shape is of  the line type. It is
composed of two or more sequentially numbered vertices with perpendicularly oriented straight line
segments connecting them. Intermediate vertices are created manually.

To create a broken line with perpendicularly oriented segments within a vector layer
1. Activate (highlight) the layer in which the broken line is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the line.
3. Click on the Shape/Create new shape/Line 90° menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

line will be fixed.
5. Move the mouse pointer in any direction and click to create the first line segment.
6. To create an intermediate vertex along with a line segment move the mouse pointer

perpendicularly to the last segment and click. [OPTIONAL] Repeat this step as many times as
needed.

7. When the broken line is drawn click on the Shape/Create new shape/Line 90° menu item to
confirm.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Line 90° item
on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line free, Closed
line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle 3point
base [linear].
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Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.

3.6.2.5 Line free

Description
Clicking on the Shape/Create new shape/Line free menu item activates the editing feature used to
create a freely drawn line within a vector layer. This shape is of the line type. It is composed of two
or more sequentially numbered vertices with straight line segments connecting them. Intermediate
vertices are created automatically.

To create a freely drawn line within a vector layer
1. Activate (highlight) the layer in which the free line is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the line.
3. Click on the Shape/Create new shape/Line free menu item.
4. Within the Map area move the mouse pointer over any point and press the left mouse button - a

starting vertex of the line will be fixed.
5. Holding the left mouse button move the mouse cursor to draw the line. When finished release

the left mouse button.
6. [OPTIONAL] Repeat the steps 4 and 5 as many times as needed.
7. When the free line is drawn click on the Shape/Create new shape/Line free menu item to

confirm.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Line free
item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Closed
line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle 3point
base [linear].

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.

3.6.2.6 Close line

Description
Clicking on the Shape/Create new shape/Closed line menu item activates the editing feature used
to create a closed broken line within a vector layer. This shape is of the line type. It is composed of
two or more sequentially numbered vertices with straight line segments connecting them.
Intermediate vertices are created manually. The first vertex is automatically connected with the last
one.
The way the vertices are being connected can be changed by choosing one of the edit modes -
see Edit mode, Nearest point and After active point topics for details.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point



97Menu

(c)2000-2010 TatukGIS. All rights Reserved

and Snap to line topics for details.

To create a closed broken line within a vector layer
1. Select (highlight) the layer in which the closed broken line is to be created. Do it by clicking on

its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the line.
3. Click on the Shape/Create new shape/Closed line menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

line will be fixed.
5. To create an intermediate vertex along with a line segment move the mouse pointer over a

different point and click. [OPTIONAL] Repeat this step as many times as needed.
6. When the line is drawn click on the Shape/Create new shape/Closed line menu item to confirm -

the first and the last vertex will be connected automatically.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Closed line
item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle 3point
base [linear].
To create a polygon bounded by a closed line, use the Polygon feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.

3.6.2.7 Close line 90°

Description
Clicking on the Shape/Create new shape/Closed line 90° menu item activates the editing feature
used to create a closed broken line with perpendicularly oriented segments within a vector layer.
This shape is of the line type. It is composed of two or more sequentially numbered vertices with
perpendicularly oriented straight line segments connecting them. Intermediate vertices are created
manually. The first vertex is connected automatically with the last one.

To create a closed broken line with perpendicularly oriented segments within a vector layer
1. Activate (highlight) the layer in which the broken line is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the line.
3. Click on the Shape/Create new shape/Closed line 90° menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

line will be fixed.
5. Move the mouse pointer in any direction and click to create the first line segment.
6. To create an intermediate vertex along with a line segment move the mouse pointer

perpendicularly to the last segment and click. [OPTIONAL] Repeat this step as many times as
needed.

7. When the line is drawn click on the Shape/Create new shape/Closed line 90° menu item to
confirm - the first and the last vertex will be connected automatically.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not
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present there then click on the rightmost  icon on the same toolbar and then on the Closed line
90° item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle 3point base
[linear].
To create a polygon bounded by a closed line with perpendicularly oriented segments, use the
Polygon 90° feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.

3.6.2.8 Rectangle [line]

Description
Clicking on the upper Shape/Create new shape/Rectangle menu item activates the editing feature
used to create a rectangle within a vector layer. This shape is of the line type. It is composed of
four sequentially numbered vertices with four perpendicularly oriented straight line segments
connecting them. The four faces are parallel to the borders of the Map area.

To create a rectangle within a vector layer
1. Activate (highlight) the layer in which the rectangle is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the rectangle.
3. Click on the upper Shape/Create new shape/Rectangle menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting corner vertex

of the rectangle will be fixed.
5. Adjust the size of the rectangle by moving the mouse pointer in any direction.
6. Click again to finish drawing the rectangle.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the upper
Rectangle item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line, Closed line 90°, Rectangle rotated [linear], Circle [linear], Circle 3point base
[linear].
To create a rotated rectangle, use the Rectangle rotated [linear] feature.
To create a rectangular polygon, use the Rectangle [polygonal] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.
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3.6.2.9 Rectangle rotated [line]

Description
Clicking on the upper Shape/Create new shape/Rectangle rotated menu item activates the editing
feature used to create a rotated rectangle within a vector layer. This shape is of the line type. It is
composed of four sequentially numbered vertices with four perpendicularly oriented straight line
segments connecting them.

To create a rotated rectangle within a vector layer
1. Activate (highlight) the layer in which the rectangle is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the rectangle.
3. Click on the upper Shape/Create new shape/Rectangle rotated menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting corner vertex

of the rectangle will be fixed.
5. Adjust the rotation of the rectangle and the length of the first face by moving the mouse pointer

in any direction. Click when finished.
6. Adjust the size of the rectangle by moving the mouse pointer perpendicularly to the first face.
7. Click again to finish drawing the rectangle.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the upper
Rectangle rotated item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line, Closed line 90°, Rectangle [linear], Circle [linear], Circle 3point base [linear].
To create a rectangle with faces parallel to the borders of the Map area, use the Rectangle [linear]
feature.
To create a rotated rectangular polygon, use the Rectangle rotated [polygonal] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.

3.6.2.10 Circle [line]

Description
Clicking on the upper Shape/Create new shape/Circle menu item activates the editing feature used
to create an approximation of a circle within a vector layer. This shape is of  the line type. It is
composed of 64 sequentially numbered vertices with 63 straight line segments connecting them.

To create a circle within a vector layer (based on the center point and the radius)
1. Activate (highlight) the layer in which the circle is to be created. Do this by clicking on its name

in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the circle.
3. Click on the upper Shape/Create new shape/Circle menu item.
4. Within the Map area move the mouse pointer over any point and click - this fixes the center

point of the circle.
5. Adjust the length of the radius by moving the mouse pointer in any direction.
6. Click again to finish drawing the circle.

Equivalent actions
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The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the upper Circle
item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle 3point base
[linear].
A different method of creating an approximation of a circle is available with the Circle 3point base
[linear] feature.
To create a circular polygon, use the Circle [polygonal] or Circle 3point base [polygonal] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.
· While adjusting the length of the radius the perimeter and the radius are dynamically illustrated

on the Map area.

3.6.2.11 Circle 3point base [line]

Description
Clicking on the upper Shape/Create new shape/Circle 3point base menu item activates the editing
feature used to create an approximation of a circle within a vector layer. This shape is of the line
type. It is composed of 64 sequentially numbered vertices with 63 straight line segments
connecting them.

To create circle within a vector layer (based on any three vertices on the perimeter)
1. Activate (highlight) the layer in which the circle is to be created. Do this by clicking on its name

in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the circle.
3. Click on the upper Shape/Create new shape/Circle 3point base menu item.
4. Within the Map area click on the three points through which the perimeter of the circle should

pass - the approximation of a circle will be created.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the upper Circle
3point base item on the drop down list.

Similar functions
To create a different shape of a line type, use one of the following features: Line, Line 90°, Line
free, Closed line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear].
A different method of creating an approximation of a circle is available with the Circle [linear]
feature.
To create a circular polygon, use the Circle [polygonal] or Circle 3point base [polygonal] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than line

then this feature will be inactive.
· While moving the mouse pointer between addition of the second and the third point, the circle's



101Menu

(c)2000-2010 TatukGIS. All rights Reserved

chord, radius, and perimeter are dynamically illustrated on the Map area.

3.6.2.12 Polygon

Description
Clicking on the Shape/Create new shape/Polygon menu item activates the editing feature used to
create a polygon bounded by a closed broken line within a vector layer. This shape is of the
polygon type. Its outline is composed of three or more sequentially numbered vertices with straight
line segments connecting them. Intermediate vertices are created manually. The first vertex is
connected automatically with the last one.
The way the vertices are being connected can be changed by choosing one of the edit modes -
see Edit mode, Nearest point and After active point topics for details.
The Editor can snap newly created vertices to the existing ones - see Edit snap type, Snap to point
and Snap to line topics for details.

To create a polygon bounded by a closed broken line within a vector layer
1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the polygon.
3. Click on the Shape/Create new shape/Polygon menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

outline will be fixed.
5. To create an intermediate vertex along with an outline segment move the mouse pointer over

any point and click. [OPTIONAL] Repeat this step as many times as needed.
6. When the outline is drawn click on the Shape/Create new shape/Polygon menu item to confirm -

the first and the last vertex of the outline will be connected automatically and the polygon will
appear.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Polygon item
on the drop down list.

Similar functions
To create a different shape of a polygon type, use one of the following features: Polygon 90°,
Rectangle [polygonal], Rectangle rotated [polygonal], Circle [polygonal], Circle 3point base
[polygonal].
To create a closed broken line, use the Closed line feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.2.13 Polygon 90°

Description
Clicking on the Shape/Create new shape/Polygon 90° menu item activates the editing feature used
to create a polygon bounded by a closed broken line with perpendicularly oriented segments within
a vector layer. This shape is of the line type. Its outline is composed of three or more sequentially
numbered vertices with perpendicularly oriented straight line segments connecting them.
Intermediate vertices are created manually. The first vertex is connected automatically with the last
one.

To create an area bounded by a closed broken line with perpendicularly oriented segments
within a vector layer
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1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its
name in the Legend panel.

2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the
Map area to cover the area where you would like to create the polygon.

3. Click on the Shape/Create new shape/Polygon 90° menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting vertex of the

outline will be fixed.
5. Move the mouse pointer in any direction and click to create the first outline segment.
6. To create an intermediate vertex along with an outline segment move the mouse pointer

perpendicularly to the last segment and click. [OPTIONAL] Repeat this step as many times as
needed.

7. When the outline is drawn click on the Shape/Create new shape/Polygon 90° menu item to
confirm - the first and the last vertex will be connected automatically and the polygon will appear
.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the Polygon 90°
item on the drop down list.

Similar functions
To create a different shape of a polygon type, use one of the following features: Polygon,
Rectangle [polygonal], Rectangle rotated [polygonal], Circle [polygonal], Circle 3point base
[polygonal].
To create a closed broken line with perpendicularly oriented segments, use the Closed line 90°
feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.2.14 Rectangle [polygon]

Description
Clicking on the lower Shape/Create new shape/Rectangle menu item activates an editing feature
used to create a rectangular polygon within a vector layer. This shape is of the polygon type. Its
outline is composed of four sequentially numbered vertices with four perpendicularly oriented
straight line segments connecting them. The four faces are parallel to the borders of the Map area.

To create a rectangular polygon within a vector layer
1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the polygon.
3. Click on the lower Shape/Create new shape/Rectangle menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting corner vertex

of the outline will be fixed.
5. Adjust the size of the polygon by moving the mouse pointer in any direction.
6. Click again to finish drawing the outline - the polygon will appear.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the lower
Rectangle item on the drop down list.

Similar functions
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To create a different shape of a polygon type, use one of the following features: Polygon, Polygon
90°, Rectangle rotated [polygonal], Circle [polygonal], Circle 3point base [polygonal].
To create a rotated rectangular polygon, use the Rectangle rotated [polygonal] feature.
To create a rectangle, use the Rectangle [linear] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.2.15 Rectangle rotated [polygon]

Description
Clicking on the lower Shape/Create new shape/Rectangle rotated menu item activates the editing
feature used to create a rotated rectangular polygon within a vector layer. This shape is of the
polygon type. Its outline is composed of four sequentially numbered vertices with four
perpendicularly oriented straight line segments connecting them.

To create a rotated rectangular polygon within a vector layer
1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the polygon.
3. Click on the lower Shape/Create new shape/Rectangle rotated menu item.
4. Within the Map area move the mouse pointer over any point and click - a starting corner vertex

of the outline will be fixed.
5. Adjust the rotation of the polygon and the length of the first face by moving the mouse pointer in

any direction. Click when finished.
6. Adjust the size of the polygon by moving the mouse pointer perpendicularly to the first face.
7. Click again to finish drawing the outline - the area will appear.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the lower
Rectangle rotated item on the drop down list.

Similar functions
To create a different shape of a polygon type, use one of the following features: Polygon, Polygon
90°, Rectangle [polygonal], Circle [polygonal], Circle 3point base [polygonal].
To create a rectangular polygon with faces parallel to the borders of the Map area, use the
Rectangle [polygonal] feature.
To create a rotated rectangle, use the Rectangle rotated [linear] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.2.16 Circle [polygon]

Description
Clicking on the lower Shape/Create new shape/Circle menu item activates the editing feature used
to create a polygonal approximation of a circle within a vector layer. This shape is of the polygon
type. Its outline is composed of 64 sequentially numbered vertices with 63 straight line segments
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connecting them.

To create a circular polygon within a vector layer (based on the center point and the radius)
1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the polygon.
3. Click on the lower Shape/Create new shape/Circle menu item.
4. Within the Map area move the mouse pointer over any point and click - this fixes the center

point of the circle.
5. Adjust the length of the radius by moving the mouse pointer in any direction.
6. Click again to finish drawing the outline - the polygon will appear.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the lower Circle
item on the drop down list.

Similar functions
To create a different shape of a polygon type, use one of the following features: Polygon, Polygon
90°, Rectangle [polygonal], Rectangle rotated [polygonal], Circle 3point base [polygonal].
A different method of creating an approximation of a circular area is available with the Circle 3point
base [polygonal] feature.
To create a circle, use the Circle [linear] or Circle 3point base [linear] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.2.17 Circle 3point base [polygon]

Description
Clicking on the lower Shape/Create new shape/Circle 3point base menu item activates the editing
feature used to create a polygonal approximation of a circle within a vector layer. This shape is of
the polygon type. It is composed of 64 sequentially numbered vertices with 63 straight line
segments connecting them.

To create a circular polygon within a vector layer (based on any three vertices on the
perimeter)
1. Activate (highlight) the layer in which the polygon is to be created. Do this by clicking on its

name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to cover the area where you would like to create the polygon.
3. Click on the lower Shape/Create new shape/Circle 3point base menu item.
4. Within the Map area click on the three points through which the perimeter of the circle should

pass - the approximation of a circle will be created and the polygon will appear.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the rightmost  icon on the same toolbar and then on the lower Circle
3point base item on the drop down list.

Similar functions
To create a different shape of a polygon type, use one of the following features: Polygon, Polygon
90°, Rectangle [polygonal], Rectangle rotated [polygonal], Circle [polygonal].
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A different method of creating an approximation of a circular area is available with the Circle
[polygonal] feature.
To create a circle, use the Circle [linear] or Circle 3point base [linear] feature.

Associated functions
To edit an existing shape, use the Edit object feature.
To remove a shape from a vector layer, use the Delete Shape feature.

Note
· If the edited layer is stored in the ArcView Shape (SHP) file format of the type different than

polygon then this feature will be inactive.

3.6.3 Edit snap type

Description
Clicking on the Shape/Edit snap type menu item displays the list of available snap modes. While
the snapping is inactive each created/moved vertex is placed exactly where the user places the
mouse pointer. While the snapping is active the placement of a created/moved vertex may change
if it is close enough to some shape, i.e. the vertex may be shifted to some position within the
interior/boundary of the shape. The position to which the vertex will be shifted is defined by the
snap mode. The shapes to which the vertices are snapped belong to a user indicated layer. The
features affected by activating/deactivating the snapping and changing the snap mode: Edit shape,
Point, Multipoint, Line, Closed line, Polygon.

To activate snapping, choose the layer used for snapping from the  list located
on the Standard toolbar.

3.6.3.1 Snap to point

Description
Clicking on the Shape/Edit snap type/Snap to point menu item activates the Snap to point snap
mode. When the snapping and the Snap to point snap mode is active a vertex created/moved
close to a shape from the snapping layer is shifted to the closest vertex of the shape. For general
information about snapping and snap modes refer to the Edit snap type help topic.

To activate the Snap to point snap mode, click on the Shape/Edit snap type/Snap to point menu
item.

Associated functions
See Edit shape, Point, Multipoint, Line, Closed line, Polygon.

Similar functions
To make the Editor snap to lines, use the Snap to line feature.

3.6.3.2 Snap to line

Description
Clicking on the Shape/Edit snap type/Snap to line menu item activates the Snap to point snap
mode. When the snapping and the Snap to line snap mode is active a vertex created/moved close
to a shape from the snapping layer is shifted to the point defined by the orthogonal projection on
the closest shape line segment. For general information about snapping and snap modes refer to
the Edit snap type help topic.

To activate the Snap to line snap mode, click on the Shape/Edit snap type/Snap to line menu
item.

Associated functions
See Edit shape, Point, Multipoint, Line, Closed line, Polygon.
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Similar functions
To make the Editor snap to vertices, use the Snap to point feature.

3.6.4 Edit mode

Description
Clicking on the Shape/Edit mode menu item displays the list of available edit modes. The edit
mode defines the way in which the vertices are being connected while creating/editing a shape of
line or polygon type. The features affected by changing the edit mode: Edit shape, Line, Closed
line, Polygon.

3.6.4.1 Nearest point

Description
Clicking on the Shape/Edit mode/Nearest point menu item activates the Nearest point edit mode.
While the Nearest point edit mode is active:
· line type shapes - if the closest vertex to a newly created vertex is the vertex at the

beginning/end of the line and the new vertex is positioned at less than a 90° angle relatively to
the direction of the first/last line segment then it will be connected only to the first/last vertex
forming one new line segment. In any other case the newly created vertex will be connected to
the two closest adjacent vertices forming two new line segments,

· polygon type shapes - the newly created vertex will be connected to the two closest adjacent
vertices forming two new outline segments.

For general information about edit modes refer to the Edit mode help topic.

Associated functions
See Edit shape, Line, Closed line, Polygon.

Similar functions
While holding the Ctrl key the default edit mode is temporarily switched to the After active point edit
mode.

3.6.4.2 After active point

Description
Clicking on the Shape/Edit mode/After active point menu item activates the After active point edit
mode. While the After active point edit mode is active:
· line type shapes - if the active vertex is the one at the beginning/end of the line then the newly

created vertex will be connected only to the first/last vertex forming one new line segment; if the
active vertex is an intermediate vertex then the newly created vertex will be connected to the
active vertex and to the vertex next to the active vertex (according to vertices numbering). This
will result in forming two new line segments.

· polygon type shapes - the newly created vertex will be connected to the active vertex and to the
vertex next to the active vertex (according to vertices numbering). This will result in forming two
new outline segments. The vertex that is next to the vertex with the highest number is the first
vertex.

For general information about edit modes refer to the Edit mode help topic.

Associated functions
See Edit shape, Line, Closed line, Polygon.

Similar functions
While holding the Ctrl key the default edit mode is temporarily switched to the Nearest point edit
mode.

Note
· The active vertex is the one indicated by the red color.
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3.6.5 Add part

Description
Clicking on the Shape/Add part menu item provides for adding a new element to an existing shape
(point, multipoint, line or polygon). In general, a shape can consist of any number of parts.

To add a new part to an existing shape
1. Activate (highlight) the layer containing the shape to be modified. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit object menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Add part menu item.
5. Create a shape that will be added as a part to the selected shape. Do this by adding vertices in

the appropriate places. A vertex will be created on any click within the Map area.
6. Click on the Shape/Edit object menu item.

Associated functions
For more information about creating a new shape, see the Create new object section of this help
system and its subtopics.
To remove a part of an existing multipart shape, use the Delete part feature.

Similar functions
To join together any number of existing shapes, use the Union Shapes feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+A key combination.

Note
· In the case of polygonal shapes the Add part feature acts as a logical sum for their areal part,

i.e. if the shape that is being added overlaps somehow the existing shape, the resulting object
will not contain the common area.

3.6.6 Delete part

Description
Clicking on the Shape/Delete part menu item provides for removing a part of an existing multipart
shape (point, multipoint, line or polygon). In general, a shape can consist of any number of parts.

To delete a part of an existing multipart shape
1. Activate (highlight) the layer containing the shape to be modified. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit object menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the desired part of the shape and click to
make a selection.

4. Click on the Shape/Delete part menu item.

Associated functions
To add a new element to an existing shape, use the Add part feature.

Similar functions
To remove a whole shape from a vector layer, use the Delete Shape feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+D key combination.
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3.6.7 Delete shape

Description
Clicking on the Shape/Delete Shape menu item provides for removing a shape or a group of
shapes, both single and multipart, from a vector layer.

To delete a shape or a group of shapes from a vector layer
1. Activate (highlight) the layer containing the shapes to be deleted. Do this by clicking on its name

in the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Click on the Shape/Delete Shape menu item.

Equivalent actions
The same function can be initiated by clicking on the Delete Shape item in the Map area context
menu.

Similar functions
To remove a part of an existing multipart shape, use the Delete part feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+Del key combination.

3.6.8 Revert shape

Description
Clicking on the Shape/Revert Shape menu item restores the state of a selected shape as it is
saved in the layer file, i.e. all editing events performed since last saving on a selected shape are
cancelled.

To cancel all editing events performed on a shape
1. Acivate (highlight) the layer containing the shape of interest. Do this by clicking on its name in

the Legend panel.

2. Click on the Shape/Edit shape menu entry or equivalently on the  icon on the Standard
toolbar.

3. Within the Map area move the mouse pointer over shape click to make a selection.
4. Click on the Shape/Revert Shape menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. Another way
is to click on the Revert Shape item in the Map area context menu.

Associated functions
For more information about the methods of selecting objects see the Select section of this help
system and its subtopics.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+R key combination.

3.6.9 Change winding

Description
Clicking on the Shape/Change Winding menu item changes the direction in which the vertices of a
selected shape are enumerated. The default numeration is clockwise. The table below describes
the placement of vertices for each shape type.

Shape type Vertices
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Point Point itself

Multipoint Points themselves

Line Starting, final and
intermediate points

Polygon Intermediate points of the
outline

To change the direction in which the vertices of a shape are enumerated
1. Activate (highlight) the layer containing the shape to be modified. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu entry or equivalently on the  icon on the Standard
toolbar.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Change Winding menu item.

Equivalent actions
The same function can be initiated by clicking on the Change Winding item in the Map area
context menu.

3.6.10 Split shapes

Description
Clicking on the Shape/Split Shapes menu item provides for splitting a shape along a user drawn
line. Each shape that aroses as a consequence of splitting is a separate shape and not a part of a
multipart shape.

To split a shape or a group of shapes along a user drawn line
1. Activate (highlight) the layer containing the shapes to be splitted. Do this by clicking on its name

in the Legend panel.
2. Click on the Shape/Split Shapes menu item - a Split Shapes panel will appear over the Selected

panel.
3. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

4. Within the Split Shapes panel click on the Next>> button - a splitting tool similar to the Line
feature will be activated.

5. Within the Map area draw the line along which the selected shapes will be splitted.
6. Within the Split Shapes panel click on the Next>> button.
7. Choose one of the following options: Blank Attributes - the shapes created as a consequence of

splitting will have no values assigned to their attributes, Attributes from source - the shapes
created as a consequence of splitting will have the same values of the attributes as the shape
they were created from. Check the Replace source option if you would like to replace the
shapes being splitted by those created by splitting. If you would like to keep the shapes being
splitted and the shapes created by splitting leave this option unchecked.

8. When finished click again on the Next>> button.

To split a shape or a group of shapes along the lines stored in a linear vector layer
1. Create a new layer using the New feature and within it create the lines that will be used for

splitting. The lines can be added using the following features: Line, Line 90°, Line free, Closed
line, Closed line 90°, Rectangle [linear] , Rectangle rotated [linear], Circle [linear], Circle 3point
base [linear]. Alternatively, an existing vector layer file can be  opened but it must contain
shapes of the line type only. To do it use the Add feature.

9. Activate (highlight) the layer containing the shapes to be splitted. Do this by clicking on its name
in the Legend panel.

2. Click on the Shape/Split Shapes menu item - a Split Shapes panel will appear over the Selected
panel.

3. Use any of the following selection methods to select the shape: Localize, Select by Point, Select
by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard, Select
by Query, Select All.
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4. Within the Split Shapes panel click on the Next>> button and then on the Split by option.
5. Choose name of the previously created or opened layer from the list beside the Split by option.
6. Within the Split Shapes panel click on the Next>> button.
7. Choose one of the following options: Blank Attributes - the shapes created as a consequence of

splitting will have no values assigned to their attributes, Attributes from source - the shapes
created as a consequence of splitting will have the same values of the attributes as the shape
they were created from. Check the Replace source option if you would like to replace the
shapes being splitted by those created by splitting. If you would like to keep the shapes being
splitted and the shapes created by splitting leave this option unchecked.

8. When finished click again on the Next>> button.

Split shapes panel - three steps of the splitting procedure.

3.6.11 Union shapes

Description
Clicking on the Shape/Union Shapes menu item provides for merging a number of shapes of the
same type to form one multipart shape. Merging shapes of different types is not possible except
the point-multipoint case.

To merge a group of shapes to form one multipart shape
1. Activate (highlight) the layer containing the shapes to be merged. Do this by clicking on its name

in the Legend panel.
2. Click on the Shape/Union Shapes menu item - a Union Shapes panel will appear over the

Selected panel.
3. Use any of the following selection methods to select the shape: Localize, Select by Point, Select

by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard, Select
by Query, Select All.

4. Within the Union Shapes panel click on the Next>> button.
5. Choose one of the following options: Blank Attributes - the shape created as a consequence of

merging will have no values assigned to its attributes, Attributes from first shape - the shape
created as a consequence of merging will have the same values of the attributes as the first
selected shape. Check the Replace source option if you would like to replace the shapes being
merged by the one created by merging. If you would like to keep the shapes being merged and
the shape created by merging leave this option unchecked.

6. When finished click again on the Next>> button.

Union Shapes panel - two steps of the uniting procedure.
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3.6.12 Split parts

Description
If the currently selected shape is a multipart shape then clicking on the Shape/Split parts menu
item separates the parts and transforms them into individual shapes. Otherwise, no action is
taken.

To separate the parts of a multipart shape and transform them into individual objects
1. Activate (highlight) the layer containing the desired multipart shape. Do this by clicking on its

name in the Legend panel.
2. Use any of the following selection methods to select the shape: Localize, Select by Point, Select

by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard, Select
by Query, Select All.

3. Click on the Shape/Split parts menu entry.

Note
· The shapes created as a result of splitting inherit the attributes from the splitted shape.

3.6.13 Clipboard buffer

Description
Clicking on the Shape/Clipboard buffer menu item creates a polygonal buffer on the basis of the
selected shapes and stores it in the temporary clipboard layer. A polygonal buffer is defined as a
total area within a specified distance from any given group of shapes.

To create a polygonal buffer on the basis of a group of shapes
1. Activate (highlight) the layer containing the shapes of interest. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shapes: Localize, Select by Point,

Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard,
Select by Query, Select All.

3. Use the Copy or Copy Special feature to put the shapes into the temporary clipboard layer.
4. Click on the Shape/Clipboard buffer menu item.

Associated functions
To save a polygonal buffer stored in the temporary clipboard layer in to a vector layer file, use the 
Save Clipboard feature.

Note
· The temporary clipboard layer is a virtual object (stored in memory) automatically created by the 

Clipboard buffer feature and is not file type specific.
· A clipboard buffer is a shape of the polygon type.

3.6.14 Clipboard convex hull

Description
Clicking on the Shape/Clipboard convex hull menu item creates a convex hull on the basis of the
selected shapes and stores it in the temporary clipboard layer.

To create a convex hull on the basis of a group of shapes
1. Activate (highlight) the layer containing the shapes of interest. Do this by clicking on its name in

the Legend panel.
2. Use any of the following selection methods to select the shape: Localize, Select by Point, Select

by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard, Select
by Query, Select All.

3. Use the Copy or Copy Special feature to put the shapes into the temporary clipboard layer.
4. Click on the Shape/Clipboard convex hull menu item.

Associated functions
To save a convex hull stored in the temporary clipboard layer in to a vector layer file, use the Save
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Clipboard feature.

Note
· The temporary clipboard layer is a virtual object (stored in memory) automatically created by the 

Clipboard convex hull feature and is not file type specific.
· A convex hull is a shape of the polygon type.

3.6.15 Import points

Description
Clicking on the Shape/Import points menu item displays the list of methods for replacing a shape
by another one built on the basis of point type data stored in non-GIS representation.

Associated functions
To import a point type data from a file, use the File feature.
To import a point type data from a raw text, use the WKT feature.

Equivalent actions
The same function can be initiated by clicking on the Import points item in the Points tab of the
Selected panel context menu.

3.6.15.1 File

Description
Clicking on the Shape/Import points/File menu item provides for replacing a shape by another one
built on the basis of point type data stored in files of non-GIS format. The following file formats are
supported: Comma Separated Values (CSV), Microsoft Excel Spreadsheet (XLS).

To replace a shape by another one built on the basis of point type data stored in files of
non-GIS format
1. Activate (highlight) the layer containing the shape to be replaced. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Import points/File menu item -  this invokes the Open dialog box.
5. In the Open dialog box select the appropriate drive from the Look in list.
6. Locate the point data file by entering the directory that contains this file.
7. Double-click on the file name.

Equivalent actions
The same function can be initiated by clicking on the Import points/File item in the Points tab of
the Selected panel context menu.

3.6.15.2 WKT

Description
Clicking on the Shape/Import points/WKT menu entry provides for replacing a shape by another
one built on the basis of point type data given in the Well Known Text (WKT) representation.

To replace a shape by another one built on the basis of point type data given in the Well
Known Text (WKT) representation
1. Activate (highlight) the layer containing the shape to be replaced. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Import points/WKT menu item -  this invokes the WKT Import dialog box.
5. Enter the point type data in the WKT representation by hand or paste it from the clipboard.



113Menu

(c)2000-2010 TatukGIS. All rights Reserved

6. Click on the Import button.

WKT Import dialog box.

Equivalent actions
The same function can be initiated by clicking on the Import points/WKT item in the Points tab of
the Selected panel context menu.

3.6.15.3 Clipboard

Description
Clicking on the Shape/Import points/Clipboard menu item displays a list of methods for importing a
shape stored in the system clipboard as a list of vertices coordinates.

3.6.15.3.1  Degrees:Minutes:Seconds (DMS)

Description
Clicking on the Shape/Import points/Clipboard/Degrees:Minutes:Seconds (DMS) menu item
replaces the selected shape with a shape stored in the system clipboard as a list of vertices
coordinates in the Degrees:Minutes:Seconds (DMS) format, that is

DDD° MM' SS.SSSS" λ        DD° MM' SS.SSSS" φ ,

where D stands for degrees, M for minutes, S for seconds, λ is the longitude symbol (E if east, W if
west) and φ is the latitude symbol (N if north, S if south). This feature requires the coordinate
system of the open project to be defined. To define the coordinate system, use the Coordinate
Systems feature.

To replace a shape with a shape stored in the system clipboard as a list of coordinates in
the DMS format
1. Activate (highlight) the layer containing the shape to be replaced. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Import points/Clipboard/Degrees:Minutes:Seconds (DMS) menu item.
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3.6.15.3.2  Decimal Degrees (DD)

Description
Clicking on the Shape/Import points/Clipboard/Decimal Degrees (DD) menu item replaces the
selected shape with a shape stored in the system clipboard as a list of vertices coordinates. To
use this feature the shape stored in the system clipboard must be defined in the Decimal Degrees
(DD) format, that is

DDD.MMMM        DD.MMMM ,

where D stands for degrees and M for minutes. The first number is the longitude and the second is
the latitude. Note, that in the Decimal Degrees format minutes are represented as decimal fraction,
that is, 1' = 0.1666(6) . This feature requires the coordinate system of the open project to be
defined. To define the coordinate system, use the Coordinate Systems feature.

To replace a shape with a shape stored in the system clipboard as a list of coordinates in
the DMS format
1. Activate (highlight) the layer containing the shape to be replaced. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Import points/Clipboard/Degrees:Minutes:Seconds (DMS) menu item.

3.6.15.3.3  Map Units

Description
Clicking on the Shape/Import points/Clipboard/Map Units menu item replaces the selected shape
with a shape stored in the system clipboard as a list of vertices coordinates defined in any units. 
This feature does not require the coordinate system of the open project to be defined.

To replace a shape with a shape stored in the system clipboard as a list of coordinates
1. Activate (highlight) the layer containing the shape to be replaced. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Import points/Clipboard/Map Units menu item.

3.6.16 Export points

Description
Clicking on the Shape/Export points menu item displays a list of methods for exporting a shape as
a point type data in non-GIS representation.

Associated functions
To export a point type data to a file, use the File feature.
To export a point type data to a raw text, use the WKT feature.

Equivalent actions
The same function can be initiated by clicking on the Export points item in the Points tab of the
Selected panel context menu.

3.6.16.1 File

Description
Clicking on the Shape/Export points/File menu item provides for exporting a shape as a point type
data to file of non-GIS format. The following file formats are supported: Comma Separated Values
(CSV), HyperText Markup Language (HTML), ASCII Text (TXT), Microsoft Excel Spreadsheet
(XLS), Extensible Markup Language (XML).
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To export a shape as a point type data to file of non-GIS format
1. Activate (highlight) the layer containing the shape to be exported. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Export points/File menu item - this invokes the Save As dialog box.
5. In the Save As dialog box select the appropriate drive from the Save in list.
6. Locate the folder where you would like to store the point type data file. A new folder can be

created by clicking on the  icon at the top-right corner of the Save As dialog box, entering its
name and pressing the Enter key.

7. Enter a name for the file in the File name list.
8. Click on the Save button.

Equivalent actions
The same function can be initiated by clicking on the Export points/File item in the Points tab of
the Selected panel context menu.

3.6.16.2 WKT

Description
Clicking on the Shape/Export points/WKT menu item provides for exporting a shape as a point
type data to the Well Known Text (WKT) representation.

To export a shape as a point type data to the Well Known Text (WKT) representation
1. Activate (highlight) the layer containing the shape to be exported. Do this by clicking on its name

in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Export points/WKT menu item - this invokes the WKT Export dialog box.
5. Within the text area of the WKT Export dialog box the WKT representation of the selected

shape is being displayed.

WKT Export dialog box.

Equivalent actions
The same function can be initiated by clicking on the Export points/WKT item in the Points tab of
the Selected panel context menu.
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3.6.16.3 Clipboard

Description
Clicking on the Shape/Export points/Clipboard menu item displays a list of methods for transferring
a shape to the system clipboard as a list of vertices coordinates.

3.6.16.3.1  Degrees:Minutes:Seconds (DMS)

Description
Clicking on the Shape/Export points/Clipboard/Degrees:Minutes:Seconds (DMS) menu item copies
the selected shape to the system clipboard as a list of vertices coordinates in the following format

DDD° MM' SS.SSSS" λ        DD° MM' SS.SSSS" φ ,

where D stands for degrees, M for minutes, S for seconds, λ is the longitude symbol (E if east, W if
west) and φ is the latitude symbol (N if north, S if south). The coordinates depend on the
coordinate system set for the open project. To set, change or adjust the coordinate system of the
open project, use the Coordinate Systems feature.

To copy a shape to the system clipboard as a list of coordinates in the DMS format
1. Activate (highlight) the layer containing the shape to be copied. Do this by clicking on its name in

the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Export points/Clipboard/Degrees:Minutes:Seconds (DMS) menu item.

3.6.16.3.2  Decimal Degrees (DD)

Description
Clicking on the Shape/Export points/Clipboard/Decimal Degrees (DD) menu item copies the
selected shape to the system clipboard as a list of vertices coordinates in the following format

DDD.MMMM        DD.MMMM ,

where D stands for degrees and M for minutes. The first number is the longitude and the second is
the latitude. Note, that in the Decimal Degrees format minutes are represented as decimal fraction,
that is, 1' = 0.1666(6) . The coordinates depend on the coordinate system set for the open project.
To set, change or adjust the coordinate system of the open project, use the Coordinate Systems
feature.

To copy a shape to the system clipboard as a list of coordinates in the DD format
1. Activate (highlight) the layer containing the shape to be copied. Do this by clicking on its name in

the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Export points/Clipboard/Decimal Degrees (DD) menu item.

3.6.16.3.3  Map Units

Description
Clicking on the Shape/Export points/Clipboard/Map Units context menu item copies the selected
shape to the system clipboard as a list of vertices coordinates. The coordinates are represented in
the internal project units defined by the layers it consists of. The units are always represented as a
decimal number. The first number is the longitude and the second is the latitude. The coordinates
depend on the coordinate system set for the open project. To set, change or adjust the coordinate
system of the open project, use the Coordinate Systems feature.

To copy a shape to the system clipboard as a list of coordinates in the map units
1. Activate (highlight) the layer containing the shape to be copied. Do this by clicking on its name in
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the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Export points/Clipboard/Map Units menu item.

3.6.17 Smooth shape

Description
Clicking on the Shape/Smooth Shape menu item provides for smoothening a shape of line or
polygon type. Lines and polygon outlines naturally tend to be less than fully smooth because they
are composed of a series of straight line segments connecting a series of vertices. Smoothening is
done by creating additional vertices using an appropriate interpolation rule.

To smoothen a desired shape
1. Activate (highlight) the layer containing the shape to be smoothened. Do this by clicking on its

name in the Legend panel.

2. Click on the Shape/Edit shape menu item or equivalently on the  icon on the Standard toolbar
.

3. Within the Map area move the mouse pointer over the shape and click to make a selection.
4. Click on the Shape/Smooth Shape menu item - the Smooth shape dialog box will appear.
5. Within the Smooth shape dialog box adjust the smoothening quality. Do it by

increasing/decreasing the value in the Factor box for better/worse result. After each adjustment
you can preview the result by clicking on the Preview button. Preview is displayed as a red line
over the smoothened shape.

6. When finished click on the Apply button.

Smooth shape dialog box.

Associated functions
To simplify a shape, use the Simplify shape feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+O key combination.

3.6.18 Simplify shape

Description
Clicking on the Shape/Simplify Shape menu item provides for simplification of shape by reducing
the number of its vertices. The reduction is performed on the basis of a user-given simplification
factor.

To simplify a shape by reducing the number of its vertices
1. Activate (highlight) the layer containing the shape to be simplified. Do this by clicking on its

name in the Legend panel.
2. Use any of the following selection methods to select the shape: Localize, Select by Point, Select

by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by Clipboard, Select
by Query, Select All.

3. Click on the Shape/Simplify Shape menu item - this invokes the Shape simplify dialog box.
4. Enter the simplification factor in the Simplify factor text box.
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5. Click on the OK button.

Shape simplify dialog box.

Associated functions
To smoothen a shape, use the Smooth shape feature.

3.7 Data

Description
The Data menu group contains features used to manipulate the attributes tables of the vector
layers.

3.7.1 Export data

Description
Clicking on the Data/Export data menu item provides for exporting the attributes table of a vector
layer in to a file of non-GIS format. The following file formats are supported: HyperText Markup
Language (HTML), ASCII Text (TXT), Microsoft Excel Spreadsheet (XLS), Extensible Markup
Language (XML).

To export the attributes table of a vector layer in to a file of non-GIS format
1. Activate (highlight) the layer of interest. Do this by clicking on its name in the Legend panel.
2. Open the context menu over the layer name in the Legend panel and click on the Open layer

data item.
3. Click on the Data/Export data menu item - this invokes the Save As dialog box.
4. In the Save As dialog box, select the appropriate drive from the Save in list.
5. Locate the folder where you would like to store the attributes file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

6. Enter a name for the attributes file in the File name list.
7. Choose a file format from the Save as type list.
8. Click on the Save button.

Associated functions
To import attributes from a file of non-GIS format or Open DataBase Connectivity (ODBC)
interface, use the Import data feature.

3.7.2 Import data

Description
Clicking on the Data/Import data menu item provides for importing additional attributes in to the
attributes table of a vector layer. The attributes can be imported from the following sources:
· files of the following formats: Microsoft Excel Spreadsheet (XLS), Data Base File (DBF),

Microsoft Excel 2007 Spreadsheet (XLSX),
· databases by the Open DataBase Connectivity (ODBC) interface.
After the importing procedure is finished the imported attributes become a part of a layer and are
displayed in the Data panel where they can be edited. When the user saves a layer the additional
attributes are saved in the same file. The source from which the additional attributes were
imported are not affected in any way.
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To import additional attributes from a file in to the attributes table of a vector layer
1. Activate (highlight) the layer into which the attributes will be imported. Do this by clicking on its

name in the Legend panel.
2. Click on the Data/Import data menu item - this invokes the Import data dialog box.
3. Within the Import data dialog box, click on the File database (dbf, xls) option in the Select data

list.
4. Click on the Next>> button - this invokes the Open dialog box.
5. Within the Open dialog box, select the appropriate drive from the Look in list.
6. Locate the attributes file by entering the directory that contains this file.
7. Double-click on the file name - this brings back the Import data dialog box.
8. Within the Import data dialog box use the Select table list to choose which database table will be

imported. Then select one attribute from the open layer's table (Layer ID list) and one column
from the table being imported (Database ID list) to define how the records will be assigned.
When finished click on the Next>> button - the Import data dialog box will change its
appearance.

9. Select which columns from the data table will be imported, set the attributes names to which the
data is to be imported and choose if any of the data being imported should replace the values
held by the existing attributes. When finished click on the Next>> button - the Import data dialog
box will change its appearance.

10. A progress bar of the importing process will be shown. When the procedure is completed click
on the OK button.

To import additional attributes via the Open DataBase Connectivity (ODBC) interface into
the attributes table of a vector layer
1. Activate (highlight) the layer to which the attributes will be imported. Do this by clicking on its

name in the Legend panel.
2. Click on the Data/Import data menu item - this invokes the Import data dialog box.
3. Within the Import data dialog box click on the ODBC option in the Select data list.
4. Click on the Next>> button - this invokes the Data Link Properties dialog box.
5. Within the four tabs of the Data Link Properties dialog box you will find a number of options

used to define the ODBC link parameters. Set up a connection with the ODBC interface
appropriately to your computer environment configuration. When finished click on the OK button
- this brings  back the Import data dialog box.

6. Within the Import data dialog box use the Select table list to choose which database table will be
imported. Then select one attribute from the open layer's table (Layer ID list) and one column
from the table being imported (Database ID list) to define how the records will be assigned.
When finished click on the Next>> button - the Import data dialog box will change its
appearance.

7. Select which columns from the data table will be imported, set the attributes names to which the
data is to be imported and choose if any of the data being imported should replace the values
held by the existing attributes. When finished click on the Next>> button - the Import data dialog
box will change its appearance.

8. A progress bar of the importing process will be shown. When the procedure is completed click
on the OK button.
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Initial (data source) appearance of the Import data dialog box.

 Table selection appearance of the Import data dialog box.

Attribute selection appearance of the Import data dialog box.
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Data Link Properties dialog box.

Similar functions
To preview and use the attributes stored in a database, use the Join Database feature.
To add a layer stored in a database, use the Add SQL layer feature.

Note
· The user can always go back to the previous settings by clicking on the <<Previous button.

3.7.3 Join Database

Description
Clicking on the Data/Join Database menu item provides for setting up persistent linkage between a
vector layer and a database table, without importing the table into the layer. When the connection
is established the attributes from the database are displayed in the Data panel along with those
loaded from the layer file. The attributes stored in the database are easily distinguishable by the 
db. prefix in the column names. The values coming from the database cannot be edited from the
Editor, but they will dynamically update whenever the values are changed within the database.

To join a vector layer to a database
1. Activate (highlight) the layer of interest. Do this by clicking on its name in the Legend panel.
2. Click on the Data/Join Database menu item - this invokes the Join Database dialog box.
3. Within the Join Database dialog box, type the connection string in the Connection string field or

click on the Build... button to use an automated method. If you have chosen the second option
the frmJoinDatabase.ADOConnection ConnectionString dialog box will appear.

4. Within the frmJoinDatabase.ADOConnection ConnectionString dialog box select one option on
the Source of Connection list: if you would like to use connection parameters stored in a file,
choose the Use Data Link File option and click on the Browse... button. If you would like to build
a connection string from scratch, choose the Use Connection String option and click on the
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Build... button.
5. (A) If you have chosen the Use Data Link File option in the previous step, the Select Data Link

File dialog box will appear. Within in select the appropriate drive from the Look in list, locate the
data link file by entering the directory that contains this file, and double-click on the file name.
(B) If you have chosen the Use Connection String option in the previous step, the Data Link
Properties dialog box will appear. Within the four tabs of the Data Link Properties dialog box the
user finds a number of options used to define the ODBC link parameters. Set up a connection
with the ODBC interface appropriately to your computer environment configuration. When
finished, click on the OK button.

6. When the step 5 is finished (regardless whether (A) or (B) was performed), the
frmJoinDatabase.ADOConnection ConnectionString dialog box will appear again. Click on the
OK button within this dialog box - this brings back the Join Database dialog box.

7. Now, when the connection with the database is established, the user can set which database
table will be joined to the layer and how its records will be assigned to the attributes from the
layer: (1) select desired database table from the Table list, (2) select from the Order by list the
column to be used to sort the table, (3) select a column from the Join primary list - this column
will be used for assignation on the layer's side, (4) select a column from the Join foreign list -
this column will be used for assignation on the database's side.

8. If all settings seem to be correct, click on the Join button.

Join Database dialog box with sample connection set up.
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frmJoinDatabase.ADOConnection ConnectionString dialog box with sample connection string.

Data Link Properties dialog box.

Similar functions
To import attribute tables from a database or data file, use the Import data feature.
To add a layer stored in a database, use the Add SQL layer feature.

Note
· The user can always go back to the previous settings by clicking on the <<Previous button.
· At the level of the Join Database dialog box, the user can preview the data that will be loaded

from a database. If any settings were changed a new preview can be generated by clicking on
the Preview button.

· In step 7 of the procedure described above, it is possible for the user to manually edit the 
Connection String and SQL Statement text boxes. However, this requires expert knowledge.
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3.7.4 Set column value

Description
Clicking on the Data/Set column value menu item provides for assigning the same value to a
chosen attribute for all shapes belonging to the active vector layer.

To assign the same value to an attribute for all shapes in a vector layer
1. Activate (highlight) the layer of interest. Do this by clicking on its name in the Legend panel.
2. Open the context menu over the layer name in the Legend panel and click on the Open layer

data item.
3. Click on the Shape/Set column value menu item - this invokes the Set column value dialog box.
4. Within the Set column value dialog box, select the attribute from the Fields list.
5. Set a value for the selected attribute in the Value text box.
6. Click on the OK button.

Set column value dialog box.

Associated functions
To add a new attribute to a vector layer, use the Restructure feature.

3.8 Measure

Description
The Measure menu group contains options used for measuring distance and area within the Map
area.

3.8.1 Line

Description
Clicking on the Measure/Line menu item activates the Line measurement tool. The Line
measurement tool is used to measure the length of a user-drawn multi-segment line. The
measurement result is presented in layer units.

To measure the length of a drawn line
1. Activate (highlight) the layer on which the measurement is to be performed. Do this by clicking

on its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to display the area where the measurement is to be performed.
3. Click on the Measure/Line menu item.
4. Within the Map area, move the mouse pointer over any point and click - a starting vertex of the

line will be fixed.
5. To create an intermediate vertex along with a line segment move the mouse pointer over a

different point and click. [OPTIONAL] Repeat this step as many times as needed.
6. As each intermediate vertex is added, the length is calculated and displayed within the Measure

panel.
7. To deactivate the measurement tool, click again on the Measure/Line menu item.
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Measure panel.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the middle  icon on the same toolbar and then on the Line item in the
drop down list.

Similar functions
Other measurement tools: Polygon, Rectangle, Rectangle rotated, Circle.

Note
· The default placement of the Measure panel is above the Selected panel.

3.8.2 Polygon

Description
Clicking on the Measure/Polygon menu item activates the Polygon measurement tool. The
Polygon measurement tool is used to measure the perimeter length and the area of  a user-drawn
polygon. The measurement results are presented in layer units.

To measure the perimeter length and the area of a drawn polygon
1. Activate (highlight) the layer on which the measurement is to be performed. Do this by clicking

on its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to display the area where the measurement is to be performed.
3. Click on the Measure/Polygon menu item.
4. Within the Map area, move the mouse pointer over any point and click - a starting vertex of the

polygon outline will be fixed.
5. To create an intermediate vertex along with an outline segment move the mouse pointer over

different point and click. [OPTIONAL] Repeat this step as many times as needed.
6. As each intermediate vertex is added, the perimeter length and the area is are presented within

the Measure panel.
7. To deactivate the measurement tool, click again on the Measure/Line menu item.

Measure panel.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the middle  icon on the same toolbar and then on the Polygon item on
the drop down list.

Similar functions
Other measurement tools: Line, Rectangle, Rectangle rotated, Circle.

Note
· The default placement of the Measure panel is above the Selected panel.
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3.8.3 Rectangle

Description
Clicking on the Measure/Rectangle menu item activates the Rectangle measurement tool. The
Rectangle measurement tool is used to measure the perimeter length and the area of a
user-drawn rectangle. The measurement results are presented in layer units.

To measure the perimeter length and the area of a drawn rectangle
1. Activate (highlight) the layer on which the measurement is to be performed. Do this by clicking

on its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to display the area where the measurement is to be performed.
3. Click on the Measure/Rectangle menu item.
4. Within the Map area, move the mouse pointer over any point and click - a starting corner vertex

of the rectangle outline will be fixed.
5. Adjust the size of the rectangle by moving the mouse pointer in any direction. Click when

finished.
6. The perimeter length and the area are presented within the Measure panel.
7. To deactivate the measurement tool, click again on the Measure/Line menu item.

Measure panel.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the middle  icon on the same toolbar and then on the Rectangle item
on the drop down list.

Similar functions
Other measurement tools: Line, Polygon, Rectangle rotated, Circle.

Note
· The default placement of the Measure panel is above the Selected panel.

3.8.4 Rectangle rotated

Description
Clicking on the Measure/Rectangle rotated menu item activates the Rectangle rotated
measurement tool. The Rectangle rotated measurement tool is used to measure the perimeter and
the area of an arbitrary rectangle rotated by an arbitrary angle. The measurement results are
presented in layer units.

1. To measure the perimeter length and the area of a drawn rotated rectangle
1. Activate (highlight) the layer on which the measurement is to be performed. Do this by clicking

on its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to display the area where the measurement is to be performed.
3. Click on the Measure/Rectangle rotated menu item.
4. Within the Map area, move the mouse pointer over any point and click - a starting corner vertex

of the rectangle will be fixed.
5. Adjust the rotation of the rectangle and the length of the first face by moving the mouse pointer

in any direction. Click when finished.
6. Adjust the size of the rectangle by moving the mouse pointer perpendicularly to the first face.

Click when finished.
7. The perimeter length and the area are presented within the Measure panel.
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8. To deactivate the measurement tool, click again on the Measure/Line menu item.

Measure panel.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the middle  icon on the same toolbar and then on the Rectangle
rotated item on the drop down list.

Similar functions
Other measurement tools: Line, Polygon, Rectangle, Circle.

Note
· The default placement of the Measure panel is above the Selected panel.

3.8.5 Circle

Description
Clicking on the Measure/Circle menu item activates the Circle measurement tool. The Rectangle
measurement tool is used to measure the perimeter and the area of an arbitrary circle. The
measurement results are presented in layer units.

To measure the perimeter length and the area of a drawn circle
1. Activate (highlight) the layer on which the measurement is to be performed. Do this by clicking

on its name in the Legend panel.
2. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the

Map area to display the area where the measurement is to be performed.
3. Click on the Measure/Circle menu item.
4. Within the Map area, move the mouse pointer over any point and then press and hold the left

mouse button - this fixes the center point of the circle.
5. Adjust the length of the radius by moving the mouse pointer in any direction. Release the left

mouse button when finished.
6. The perimeter length and the area are presented within the Measure panel.
7. To deactivate the measurement tool, click again on the Measure/Line menu item.

Measure panel.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Standard toolbar. If it is not

present there then click on the middle  icon on the same toolbar and then on the Circle item on
the drop down list.

Similar functions
Other measurement tools: Line, Polygon, Rectangle, Rectangle rotated.

Note
· The default placement of the Measure panel is above the Selected panel.
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3.9 Tools

Description
The Tools menu group contains features such as Topology corrector, measurement tools, general
settings, etc.

3.9.1 Topology

Description
Clicking on the Tools/Topology menu item displays the list of features used for correcting the
topology of vector layers.

3.9.1.1 Topology

Description
Clicking on the Tools/Topology menu item invokes the Topology builder and corrector dialog box
used to set up the topology correction task. The Topology builder and corrector feature is capable
of analyzing and correcting the topological properties of both the linear and polygonal vectorial
data. As a result a topology project is created consisting of the corrected layer and, optionally,
report layers each representing the result of different stage of the topology analysis. The Topology
builder and corrector feature is capable of detecting the following types of topology elements or
errors:

· Linear topology

Name Example (red) Description

intersection A point, where the segments of two lines cross.

dangling node Vertex connected with one line segment.

connecting node Vertex connected with two line segments.

node with 3+
edges

Vertex connected with more than two line segments.

line 0 connected Line containing two dangling nodes and any number of
connecting nodes.

line 1 connected Line containing one dangling node, one node with 3+
edges and any number of connecting nodes.

line 2 connected Line containing two nodes with 3+ edges and any number
of connecting nodes.

· Polygonal topology

Name Example (red) Description
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centroid Center point of a polygon; a centroid is always forced to lay
within its polygon.

intersection A point where two segments of some polygons outlines
cross.

correct polygon A polygon that has no topology errors.

overlap A polygon covering the area, where at least two polygons
overlap.

hole A polygon covering the area, where at least two touching
polygons outlines branch off and touch again afterwards;
also, a polygon internal hole.

edge A polygon outline that is topologically correct.

dangling edge An element of the polygon outline that gives no contribution
to the polygon area.

external border If all the polygons in a layer are touching forming one
"island", the outline of that "island"; otherwise, the outline of
the leftmost "island".

To build a topology project for a vector layer
1. Activate (highlight) the vector layer that is to be analyzed. Do this by clicking on its name in the

Legend panel.
2. Click on the Tools/Topology menu item - this invokes the Topology builder and corrector dialog

box.
3. Within the Topology builder and corrector dialog box set the name and path of the topology

project. First, click on the [ ... ] button in the Output project file box - this invokes the Save As
dialog box.

4. Within the Save As dialog box select the appropriate drive from the Save in list.
5. Locate the folder where you would like to store the project file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

6. Enter a name for the project file in the File name list.
7. Click on the Save button - this brings back the Topology builder and corrector dialog box.
8. [OPTIONAL] The Topology builder and corrector feature can analyze only one type of shapes at

a time. If the layer to be analyzed contains more than one type of shapes, e.g. lines and
polygons, then select the appropriate shape type in the Topology input feature.

9. Within the Topology builder and corrector dialog box choose the type of topology to be analyzed
in the Topology type box.

10. [OPTIONAL] If the Topology input feature is set to lines and the Topology type is set to Linear,
the Linear topology options become available and can be used. For detailed information see
Linear topology options below.

11. In the Tolerance (layer units) text box set the tolerance used for topology correction; if zero, the
topology correction will not be performed.

12. In the Additional layers list choose which additional layers should be added to the topology
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project - see Additional layers below.
13. In the Progress information box choose the type of information reported during the topology

analysis process.
14. Click on the OK button - the Progress... message box will appear informing about the progress

of the topology analysis.
15. When the process of topology analysis completes without encountering any error a message

box will appear informing about the success - confirm it by clicking on the OK button.
16. Another message box will appear asking if the user would like to open the newly created

topology project - click on the OK button to open the result of the topology analysis.

Topology builder and corrector dialog box.

Linear topology options
· intersection field - if checked, a crossing of segments of two lines will be regarded as an

intersection only if those lines have a different value of the attribute selected from the list.
· edges merging - if checked, if a dangling node of a line has the same coordinates (up to the

Tolerance) as a dangling node of a different line, then those two lines will be merged to form a
single shape.

· merging field - if checked, if a dangling node of a line has the same coordinates (up to the
Tolerance) as a dangling node of a different line, then those two lines will be merged to form a
single shape only if they have the same value of the attribute selected from the list.

Additional layers
The following additional layers can be added to the topology project:
· intersections - point type layer indicating coordinates in which two lines or polygon outlines

intersect,
· nodes - point type layer indicating coordinates of all vertices belonging to a line or a polygon

outline,
· edges - line type layer containing all lines and polygon outlines,
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· centroids - point type layer containing centroids of all the polygons.

Notes
· The topology project layers are generated to the ArcView Shape Files (SHP) file format. The

attributes are stored in the Data Base File (DBF) type files.
· The correction tolerance is defined in layer units. If the layer has a coordinate system set, the

layer units are assumed to be the units of the coordinate system. Therefore it is necessary to
know something about the coordinate system of the corrected layer in order to set a reasonable
tolerance. 

· Note, that some of the coordinate systems are defined in angular units. However, defining the
tolerance in angular units is not recommended because it is different in points of different
latitude.

3.9.1.2 Show polygons correct

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show polygons correct
menu item selects all the topologically correct polygons from the corrected layer. For detailed
information about topology correction task refer to the Topology help topic.

To select and highlight all the topologically correct polygons
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show polygons correct menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.

3.9.1.3 Show polygons holes

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show polygons holes
menu item selects all the polygons indicating polygon holes detected by the topology correction
task. For detailed information about topology correction task refer to the Topology help topic.

To select and highlight all the polygon holes
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show polygons holes menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.

3.9.1.4 Show polygons overlaps

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show polygons
overlaps menu item selects all the polygons indicating polygon overlaps detected by the topology
correction task. For detailed information about topology correction task refer to the Topology help
topic.

To select and highlight all the polygon overlaps
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show polygons overlaps menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.
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3.9.1.5 Show lines 0 connected

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show lines 0 connected
menu item selects all the zero-connected lines detected by the topology correction task. For
detailed information about topology correction task refer to the Topology help topic.

To select and highlight all the zero-connected lines
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show lines 0 connected menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.

3.9.1.6 Show lines 1 connected

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show lines 1 connected
menu item selects all the one-connected lines detected by the topology correction task. For
detailed information about topology correction task refer to the Topology help topic.

To select and highlight all the one-connected lines
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show lines 1 connected menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.

3.9.1.7 Show lines 2 connected

Description
When a polygonal topology project is open, clicking on the Tools/Topology/Show lines 2 connected
menu item selects all the two-connected lines detected by the topology correction task. For
detailed information about topology correction task refer to the Topology help topic.

To select and highlight all the two-connected lines
1. Use the Topology feature to create a topology project.
2. Click on the Tools/Topology/Show lines 2 connected menu item.

Note
· All the selected shapes are automatically highlighted within the Map area.

3.9.2 Tools Manager

Description
Clicking on the Tools/Tools Manager menu item invokes the Tools Manager dialog box. The Tools
Manager dialog box provides the means to permanently attach a script to the Editor menu so that it
can be used at any time as a standard Editor feature. The attached scripts appear in the Tools
menu beneath the Tools Manager menu item. The Tools Manager dialog box allows also to detach
previously attached script, reorder attached scripts and change their menu items names. For more
information about scripts for the Editor refer to the Scripts and Scripter Studio help topics.
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Tools Manager dialog box.

To change the default scripts folder
1. Click on the Tools/Tools Manager menu item - this invokes the Tools Manager dialog box.
2. Within the Tools Manager dialog box click on the [ ... ] button - this invokes the Browse For

Folder dialog box.
3. Within the Browse For Folder dialog box locate and select the desired folder.
4. Click on the OK button.
5. The Tools library list will be automatically updated with the list of scripts found in the new scripts

root directory.

To attach a script to the Editor Tools menu
1. Click on the Tools/Tools Manager menu item - this invokes the Tools Manager dialog box.
2. Within the Tools Manager dialog box select the desired script in the Tools library list.

3. Click on the  button.

4. Click on the OK button.

To detach a script from the Editor Tools menu
1. Click on the Tools/Tools Manager menu item - this invokes the Tools Manager dialog box.
2. Within the Tools Manager dialog box select the desired script in the Extended tools menu list.

3. Click on the  button.
4. Click on the OK button.

To change a script position in the Editor Tools menu
1. Click on the Tools/Tools Manager menu item - this invokes the Tools Manager dialog box.
2. Within the Tools Manager dialog box select the desired script in the Extended tools menu list.
3. To move the script up click the Up button. To move the script down click the Down button.

Repeat this step until the script is placed in the desired position.
4. Click on the OK button.
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To rename the menu item of an attached script
1. Click on the Tools/Tools Manager menu item - this invokes the Tools Manager dialog box.
2. Within the Tools Manager dialog box select the desired script in the Extended tools menu list.
3. Enter a new name in the text box below the Extended tools menu list.
4. Click on the Rename button.
5. Click on the OK button.

Note
· A short information about a script selected in the Tools library list can be found below that list.

3.9.3 Desktops

Description
Clicking on the Tools/Desktops menu item displays the list of options for managing the Editor's
layout settings files.

3.9.3.1 Save Desktop

Description
Clicking on the Tools/Desktops/Save Desktop menu item provides for saving the current Editor's
layout settings to a configuration file.

To save the current Editor's layout settings to a configuration file
1. Click on the Tools/Desktops/Save Desktop menu item - this invokes the Save Desktop dialog

box.
2. Within the Save Desktop dialog box select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the configuration file. A new folder can be

created by clicking on the  icon at the top-right corner of the Export to image dialog box,
entering its name and pressing the Enter key.

4. Enter a name for the configuration file in the File name list.
5. Click on the Save button.

Associated functions
To load the previously saved configuration file of the Editor's layout settings, use the Load Desktop
feature.
To load the default Editor layout settings, use the Default feature.

3.9.3.2 Load Desktop

Description
Clicking on the Tools/Desktops/Load Desktop menu item provides for loading the Editor's layout
settings from a configuration file.

To load the Editor's layout settings from a configuration file
1. Click on the Tools/Desktops/Load Desktop menu item - this invokes the Load Desktop dialog

box.
2. Within the Load Desktop dialog box select the appropriate drive from the Look in list.
3. Locate the configuration file by entering the directory that contains this file.
4. Double-click on the file name.

Associated functions
To save the current Editor layout settings to a configuration file, use the Save Desktop feature.
To load the default Editor layout settings, use the Default feature.

3.9.3.3 Default

Description
Clicking on the Tools/Desktops/Default menu item provides for loading the Editor default layout
settings.
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To load the Editor default layout settings, click on the Tools/Desktops/Default menu item.

3.9.4 Language

Description
Clicking on the Tools/Language menu item displays the list of available Editor's localizations (user
interface languages) and allows to switch between them.

To change the Editor's interface language
1. Click on the Tools/Language menu item - this displays the list of available languages.
2. Click on a desired language name.

Associated functions
To edit the currently used Editor localization, use the Edit Language feature.

Note
· The language set in the Language list is preserved until it is manually changed.

3.9.4.1 Edit Language

Description
Clicking on the Tools/Language/Edit Language menu item invokes the Edit Language dialog box.
The Edit Language dialog box is a tool that can be used to edit/adjust the currently used
localization (interface language).

IMPORTANT
The Edit Language is an expert level feature. Use it with caution as it may severely affect the
Editor usability.

The Edit Language dialog box displaying English localization script file.
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To make changes in the current Editor localization
1. Click on the Tools/Language/Edit Language menu item - this invokes the Edit Language dialog

box.
2. Within the Edit Language dialog box apply your changes in the text box displaying the

localization script. To search for a specific phrase to be changed click on the Find button, type
the phrase in the Find dialog box and click the Find next button.

3. Click on the Save button.
4. Click on the Close button.

To send improved localization to TatukGIS
1. Activate the desired localization using the Language feature.
5. Click on the Tools/Language/Edit Language menu item - this invokes the Edit Language dialog

box.
6. Within the Edit Language dialog box click on the Send via e-mail button - this invokes your

default e-mail management application with a message ready to be send to TatukGIS.
7. [OPTIONAL] Include your remarks in the e-mail text.
8. Send the message using your e-mail management application.

Associated functions
To change the Editor localization, use the Language feature.

3.9.5 GUI Style

Description
Clicking on the Tools/GUI Style menu item displays the list of visual styles available in the Editor.
Switching between the options in the GUI Style list affects the visual style (shape, color, etc.) of the
toolbars and menus.

To change the visual style of the Editor
1. Click on the Tools/GUI Style menu item - this displays the list of available visual styles.
2. Choose one of the styles by clicking on its name.

Note
· The style set in the GUI Style list is preserved until it is manually changed.

3.9.6 Options

Description
Clicking on the Tools/Options menu item invokes the Options dialog box. The Options dialog box
is used to customize the Editor general settings as: file type associations, color theme, rendering
quality and performance, etc. It consists of 6 tabs:
· General tab,
· Map tab,
· Editor tab,
· Selection tab,
· Data panel tab,
· Files tab.
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3.9.6.1 General

Options dialog box, General tab.

General tab
· Hints color - color of the Map hint balloons; to choose another color click on the colored

rectangle.
· Application Update Check (days period) - number of days between which the Editor should

automatically check if a new version is available for download.
· Welcome page - if checked, the Welcome page is displayed each time the Editor is started.
· Default button - restores the default settings on the General tab.

3.9.6.2 Map

Options dialog box, Map tab.
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Map tab
· Background color - background color of the Map area.
· Auto center - if checked, the extent visible in the Map area is automatically centered on the most

recently selected shape when using the Localize or the Select by Point selection methods.
· Cached paint - if unchecked, the rendering is performed directly on the Map area, which can

dramatically improve performance with very large and complicated vector data sets but causes 
Map area flickering.

· Restricted drag - if checked, restricts the extent in which the user can drag in Map area to the
current project extent.

· Incremental paint - if checked, the rendering in Drag mode is performed only after the mouse
button is released, which can dramatically improve performance with very large and complicated
vector data sets.

· Use R Tree - if checked, a spatial indexing tree is built for each layer, which can dramatically
improve performance with very large and complicated vector data sets.

· Antialiasing - if checked, the vector data is rendered in the Map area with antialiasing; can
severely decrease the rendering performance.

· Default button - restores the default settings on the Map tab.

3.9.6.3 Editor

Options dialog box, Editor tab.

Editor tab
· Show snapping points - if checked, the vertices markers are displayed in the edit mode.
· Show dragging track - if checked, a line is drawn between the original position of the vertex

being edited and its new position.
· Show points numbers - if checked, the vertices numeration is displayed for the shape being

edited.
· Show points 3D - if checked, a label with value of the Z coordinate is displayed for each vertex of

the shape being edited.
· Wire mode - if checked, a thin black line shows how the shape being edited looked before the

most recent edit operation.
· Default button - restores the default settings on the Editor tab.
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3.9.6.4 Selection

Options dialog box, Selection tab.

Selection tab
· Selection color - color used to highlight the selected shapes; to choose another color click on the

colored rectangle.
· Transparency - transparency of the selection highlight; can vary from 0 to 100, where 0 means

invisible and 100 means opaque.
· Outline only - if checked, only the outline of the selected shapes is highlighted.
· Default button - restores the default settings on the Selection tab.

3.9.6.5 Data panel

Options dialog box, Data panel tab.
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Data panel tab
· Auto cached mode if record count is less than [limit] - if checked and if the number of records of

the current layer is less than the limit, the columns header menu in the Data panel display
additional selection lists which can be used for attribute values filtering; the layers with the record
count greater than the limit are treated as if this feature was unchecked; in cases when this
feature is inactive (i.e. it is unchecked or the record count of the current layer exceeds the limit)
the performance with very large and complicated vector data sets can be dramatically improved.

· Display record count - if checked, the total number of records loaded in the currently active tab
of the Data panel is displayed on the status bar.

· Tables captions - indicates which layer identificator is displayed in the Data panel: name, caption
or both; while the layer name is a read-only property the layer caption can be set using the 
Properties feature.

· Persistent data panel - if checked, the state and layout of the Data panel is saved to the project
file and restored whenever the project is being opened.

· Default button - restores the default settings on the Data panel tab.

3.9.6.6 Files

Options dialog box, Files tab.

Files tab
· Select all button - selects all formats from the File format list.
· Deselect all button - deselects all formats from the File format list.
· Associate files button - associates all formats selected in the File format list with the Editor.

Note
· To select/deselect any file format, click on its checkbox in the State column of the File format

list.

3.10 Scripts

Description
The Scripts menu group provides the means for creating and executing scripts for the Editor. For
detailed information refer to the Scripter Studio help topic.
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3.10.1 Run

Description
Clicking on the Scripts/Run menu item displays a list of 8 recently executed scripts.

To execute a recently executed script
1. Click on the Scripts/Run menu item - a list of the 8 most recently executed scripts will appear.
2. Search for the desired script project file name on the list - if the script is not present on the list,

this means that the script has never been executed or at least 8 other scripts have been
executed since this script was last executed. 

3. Click on the script project file name.

Associated functions
To execute a script that is not present on the list of recent scripts, use the Open feature.
To clear the list of 16 recently executed scripts, use the Clear list feature.
To create, edit or execute a script, use the Scripter Studio feature.

Note
· The script project file has the SSPROJ extension.
· The Editor comes with a collection of sample scripts that are available in the Scripts folder

located in the Editor installation folder.

3.10.1.1 Open

Description
Clicking on the Scripts/Run/Open menu item provides for the execution of a script.

To execute a script
1. Click on the Scripts/Run/Open menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
3. Locate the script by entering the directory that contains its files.
4. For a normal script double-click on the script project file name. For a binary script double-click

on the main unit binary file. For a script package double-click on the package file.
5. If a script package was chosen in the previous step and the package is password protected, a 

Package password dialog box will be invoked. To execute such a script  the user has to provide
a valid password and click on the OK button.

Package password dialog box.

Associated functions
To execute a script that has been recently executed, use the Run feature.
To create, edit or execute a script, use the Scripter Studio feature.

Note
· A script project file has the SSPROJ extension.
· A binary script file has the CODE extension.
· A script package file has the SSPKG extension.
· A script package may be password protected. To execute such a script the user has to provide a

valid password after opening the package.
· The Editor comes with a collection of sample scripts that are available in the Scripts folder

located in the Editor installation folder.
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3.10.1.2 Clear list

Description
Clicking on the Scripts/Run/Clear list menu item clears the list of the 16 most recently executed
scripts that is available under the Scripts/Run menu item.

To clear the list of the 16 most recently executed scripts, click on the Scripts/Run/Clear list
menu item.

3.10.2 Scripter Studio

Description
Clicking on the Scripts/Scripter Studio menu item displays the three methods of invoking the
Scripter Studio:
· New Pascal project,
· New Basic project,
· Open.
It also displays a list of 8 scripts recently edited in the Scripter Studio.

IMPORTANT
The Scripter Studio is a complete solution for creating,editing and executing the scripts for the
Editor. For detailed information refer to the Scripter Studio help topic.

To open a script recenlty edited in the Scripter Studio
1. Click on the Scripts/Scripter Studio menu item - a list of the 8 most recently edited scripts will

appear.
2. Search for the desired script project file name on the list - if the script is not present on the list,

this means that the script has never been executed or at least 8 other scripts have been edited
since this script was last edited. 

3. Click on the script project file name.

Note
· The script project file has the SSPROJ extension.

3.10.2.1 New project (Pascal)

Description
Clicking on the Scripts/Scripter Studio/New Pascal project menu item invokes the Scripter Studio
with a new blank Pascal script project.

To invoke the Scripter Studio with a new Pascal script project, click on the Scripts/Scripter
Studio/New Pascal project menu item.

Associated functions
To invoke the Scripter Studio with a new Basic script project, use the New Basic project feature.
To invoke the Scripter Studio with an existing script project, use the Open feature.
To run a script without invoking the Scripter Studio, use the Run feature.

3.10.2.2 New project (Basic)

Description
Clicking on the Scripts/Scripter Studio/New Basic project menu item invokes the Scripter Studio
with a new blank Basic script project.

To open the Scripter Studio with a new Basic script project, click on the Scripts/Scripter
Studio/New Basic project menu item.

Associated functions
To invoke the Scripter Studio with a new Pascal script project, use the New Pascal project feature.
To invoke the Scripter Studio with an existing script project, use the Open feature.
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To run a script without invoking the Scripter Studio, use the Run feature.

3.10.2.3 Open

Description
Clicking on the Scripts/Scripter Studio/Open menu item provides for opening of an existing script in
the Scripter Studio.

To open a script in the Scripter Studio
1. Click on the Scripts/Scripter Studio/Open menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
3. Locate the script by entering the directory that contains its files.
4. Double-click on the script project file name.

Associated functions
To invoke the Scripter Studio with a new Pascal script project, use the New Pascal project feature.
To invoke the Scripter Studio with a new Basic script project, use the New Basic project feature.
To run a script without invoking the Scripter Studio, use the Run feature.

Note
· The script project file has the SSPROJ extension.
· The Editor comes with a collection of sample scripts that are available in the Scripts folder

located in the Editor installation folder.

3.10.2.4 Clear list

Description
Clicking on the Scripts/Scripter Studio/Clear list menu item clears the list of the 8 scripts most
recently opened in the Scripter Studio. The list is available under the Scripts/Scripter Studio menu
item.

To clear the list of the 16 scripts most recently opened in the Scripter Studio, click on the
Scripts/Scripter Studio/Clear list menu item.

3.10.3 Scripts Manager

Description
Clicking on the Scripts/Scripts Manager menu item invokes the Scripts Manager tool. The Scripts
Manager provides a list of all running scripts executed through the Run or Open features and gives
the possibility to force script termination. This is especially useful when user encounters a script
malfunction.
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Scripts Manager displaying a list of running scripts.

To force termination of a malfunctioned script
1. Click on the Scripts/Scripts Manager menu item - this invokes the Scripts Manager dialog box.
2. Within the Scripts Manager dialog box locate the script on the Currently running scripts list.
3. Click on the script path on the Currently running scripts list.
4. Click on the Terminate button.
5. Click on the Close button.

3.10.4 Reset Interface

Description
Clicking on the Scripts/Reset Interface menu item loads the default Editor interface layout. The
default Editor interface layout is stored within a script file ttkEDT.psc located in the Editor
installation folder. This script can be edited, however, this is not recommended without expert
knowledge.

To load the default Editor interface layout, click on the Scripts/Reset Interface menu item.

3.11 Help

Description
The Help menu group contains options used to bring up this help system, Editor version
information, and the check for updates feature.

3.11.1 Help

Description
Clicking on the Help/Help menu item invokes help system. The Editor help system provides a brief
description of all features and functionalities found in the Editor  and basic instructions how to
perform standard operations using each feature.

To invoke the Editor help system, click on the Help/Help menu item.

Key shortcut
This function can be initiated by pressing the F1 key.
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3.11.2 Tutorials

Description
Clicking on the Help/Tutorials menu item invokes Editor's tutorial system. Tutorials are designed to
guide the user through some procedures performed with the Editor.

To invoke Editor's tutorial system, click on the Help/Tutorials menu item.

3.11.3 Check for updates

Description
Clicking on the Help/Check for updates menu item provides for checking if a new version of the
Editor is available for downloading.

To check if a new version of the Editor is available
1. Click on the Help/Check for updates menu item - this invokes the Check for updates dialog box.
2. Within the Check for updates dialog box, click on the Check button.
3. When the checking procedure is finished, one of the following messages will appear: New

version - a version of the Editor that is newer than the one installed on your computer is
available for downloading, No new version - the version installed on your computer is the latest
one, The update site cannot be reached - there is a problem with connecting to the TatukGIS
update server, check your internet connection.

4. [OPTIONAL] If a new version of the Editor is available, the Click to download link will appear in
the Check for updates dialog box. Clicking on this link will navigate directly to the TatukGIS
website using your default web browser. There you can download the package containing the 
Editor and use it to upgrade to the newest version.

Check for updates dialog box as it appears when
the latest Editor version is already installed.

3.11.4 About

Description
Clicking on the Help/About menu item displays information about the installed version of the Editor
and its external components.

To display information about the installed version of the Editor and its external
components, click on the Help/About menu item.

4 Map area

Description
The Map area is a part of the Editor window where all the geometric data is being displayed and
edited. 
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Editor window with Map area indicated.

4.1 Context menu

Context menu item Appears when Equivalent menu item Help 

selection no selection edit mode topic

Previous extent X X View/Previous extent link

End editing X link

Copy coordinates to
clipboard

X X X link

Edit shape X X Shape/Edit shape link

Draw MiniMap X View/MiniMap/Draw
MiniMap

link

Locate record X Select/Locate record link

Selected extent X View/Selected extent link

Invert selection X Select/Invert selection link

Deselect all X Select/Deselect all link

Copy X Edit/Copy link

Copy special... X Edit/Copy special... link

Add part X Shape/Add part link

Delete part X Shape/Delete part link

Delete shape X Shape/Delete shape link

Revert shape X Shape/Revert shape link

Change winding X Shape/Change winding link
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4.1.1 Copy coordinates to clipboard

Description
Clicking on the Copy coordinates to clipboard context menu item displays the list of methods for
copying the coordinates of the point on the Map area indicated by the mouse pointer to the system
clipboard.

4.1.1.1 Degrees:Minutes:Seconds (DMS)

Description
Clicking on the Copy coordinates to clipboard/Degrees:Minutes:Seconds (DMS) context menu item
copies the coordinates of the point indicated by the mouse pointer to the system clipboard in the
following format

DDD° MM' SS.SSSS" λ        DD° MM' SS.SSSS" φ ,

where D stands for degrees, M for minutes, S for seconds, λ is the longitude symbol (E if east, W if
west) and φ is the latitude symbol (N if north, S if south). The coordinates depend on the
coordinate system set for the open project. To set, change or adjust the coordinate system of the
open project, use the Coordinate Systems feature.

To copy point coordinates in the Degrees:Minutes:Seconds format to the system clipboard
1. Within the Map area move the mouse pointer over the desired point.
2. Expand the context menu by clicking with the right mouse button.
3. Click on the Copy coordinates to clipboard/Degrees:Minutes:Seconds (DMS) context menu

item.

4.1.1.2 Decimal Degrees (DD)

Description
Clicking on the Copy coordinates to clipboard/Decimal Degrees (DD) context menu item copies
the coordinates of the point indicated by the mouse pointer to the system clipboard in the following
format

DDD.MMMM        DD.MMMM ,

where D stands for degrees and M for minutes. The first number is the longitude and the second is
the latitude. Note, that in the Decimal Degrees format minutes are represented as decimal fraction,
that is, 1' = 0.1666(6) . The coordinates depend on the coordinate system set for the open project.
To set, change or adjust the coordinate system of the open project, use the Coordinate Systems
feature.

To copy point coordinates in the Decimal Degrees format to the system clipboard
1. Within the Map area move the mouse pointer over the desired point.
2. Expand the context menu by clicking with the right mouse button.
3. Click on the Copy coordinates to clipboard/Decimal Degrees (DD) context menu item.

4.1.1.3 Map Units

Description
Clicking on the Copy coordinates to clipboard/Map Units context menu item copies the coordinates
of the point indicated by the mouse pointer to the system clipboard. The coordinates are
represented in the internal project units defined by the layers it consists of. The units are always
represented as a decimal number. The first number is the longitude and the second is the latitude.
The coordinates depend on the coordinate system set for the open project. To set, change or
adjust the coordinate system of the open project, use the Coordinate Systems feature.

To copy point coordinates represented in map units to the system clipboard
1. Within the Map area move the mouse pointer over the desired point.
2. Expand the context menu by clicking with the right mouse button.
3. Click on the Copy coordinates to clipboard/Map Units context menu item.
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4.1.2 End editing

Description
Clicking on the End editing context menu item leaves the edit mode. To enter the edit mode use
the Edit shape feature or any of the New shape subfeatures.

To leave the edit mode
· click on the End editing Map area context menu item,

· click on the  icon on the Standard toolbar,
· click on the Shape/Edit shape menu item.

5 Panels

Description
The Editor panels are window components providing many crucial functionalities mostly related to
management of layers and vector layer attributes.

5.1 Scale

Description
The Scale panel displays the scale of the extent visible in the Map area in the open project units.
The scale is always computed for the center of the visible extent. The Scale panel is visible only
when the open project has the coordinate system defined. To set, change or adjust the coordinate
system of the open project, use the Coordinate Systems feature.

Editor window with Scale panel indicated.
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5.2 Selected

Description
The Selected panel is the Editor window component designed for the ease of analysis of the vector
layers. It consists of four tabs, each displaying different type of information:
· Attributes tab,
· Stats tab,
· Points tab - appears only in the edit mode,
· COGO-360 tab - appears only in the edit mode.
The Selected panel displays the information concerning the currently selected shape or shapes. In
order to select a shape or multiple shapes use one of the following features: Localize, Select by
Point, Select by Line, Select by Polygon, Select by Circle, Select by Rectangle, Select by
Clipboard, Select by Query, Select All. To enter the edit mode use the Edit shape feature or any of
the New shape subfeatures. 

5.2.1 Attributes

Description
The Attributes tab of the Selected panel displays the values of the attributes of the currently
selected shape or, if multiple shapes are selected, the minimal, maximal and average value of the
NUMBER and FLOAT type attributes.

Attributes tab of the Selected panel displaying attributes of a sample shape.

To display/edit the values of the attributes of all shapes belonging to some vector layer, use
the Data panel.

Associated features
To add a new attribute to a vector layer, use the Restructure feature.
To set the value of some attribute for all shapes belonging to a vector layer, use the Set column
value feature.
To import attributes from a file of non-GIS format or Open DataBase Connectivity (ODBC)
interface, use the Import data feature.
To preview and use the attributes stored in a database, use the Join Database feature.
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5.2.2 Stats

Description
The Stats tab of the Selected panel displays the information about the geometry of the currently
selected shapes.

Stats tab of the Selected panel displaying attributes of a sample shape.

The table below explains the meaning of information displayed within the Stats tab:

Name Appears when selection is Description

one shape many shapes

Count X X Total number of selected shapes.

Points X Number of vertices of the selected shape.

sum( Points ) X Total number of vertices of the selected shapes.

avg( Points ) X Average number of vertices of the selected shapes.

Parts X Number of parts of the selected shape.

sum( Parts ) X Total number of parts of the selected shapes.

avg( Parts ) X Average number of parts of the selected shapes.

Length X Zero if the shape type is point or multipoint; for line
type shapes displays the length of the line; for
polygon type shapes displays the length of the
outline.

sum
( Length )

X The total length of all selected shapes; is greater
than zero only if some line or polygon type shapes
are selected.

avg( Length ) X The average length of all selected shapes; is greater
than zero only if some line or polygon type shapes
are selected.

Area X Zero if the shape type is point, multipoint or line; for
polygon type shapes displays the area of the
polygon.

sum( Area ) X The total area of all selected shapes; is greater than
zero only if some polygon type shapes are selected.

avg( Area ) X The average area of all selected shapes; is greater
than zero only if some polygon type shapes are
selected.

Note
· All values are displayed in the layer units.

5.2.3 Points

Description
The Points tab of the Selected panel displays the coordinates list of all vertices of the currently
edited/created shape. It also allows to edit the vertices by entering their coordinates by hand.
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Points tab of the Selected panel displaying vertices coordinates of a sample shape.

5.2.4 COGO-360

Description
The COGO-360 tab of the Selected panel displays the coordinates list of all vertices of the
currently edited/created shape in the COGO-360 representation.

COGO-360 tab of the Selected panel displaying vertices coordinates of a sample shape.

5.3 Legend

Description
The Legend panel is the Editor window component holding the basic information about open layers
and their visual properties. It consists of two tabs differing in information arrangement:
· Layers tab,
· Hierarchy tab.

5.3.1 Context menu

Context menu item Equivalent menu item Help topic

Show attributes table Layer/Show attributes table link

Add Layer/Add link
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Remove Layer/Remove link

Move up Layer/Move up link

Move down Layer/Move down link

Hierarchy File/Hierarchy link

Save layer properties Layer/Save layer properties link

Load layer properties Layer/Load layer properties link

Properties Layer/Properties link

5.3.2 Layers

Description
The Layer tab of the Legend panel displays the list of all open layers and the list of sections for
each layer (if defined). The order of layers on the Layer tab determines the order of rendering on
the Map area. For information about changing the order of layers on the Layer tab refer to the
Move up and Move down help topics. For detailed information about defining layer sections and
layer visual properties refer to the Properties help topic.

Layer tab of the Legend panel displaying sample data.

5.3.3 Hierarchy

Description
The Hierarchy tab of the Legend panel displays the content that is entirely managed by the user.
For detailed information about managing the Hierarchy tab refer to the  Hierarchy help topic and its
subtopics.
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Hierarchy tab of the Legend panel displaying sample data.

5.4 MiniMap

Description
The MiniMap panel is the Editor window component that localizes the extent visible within the Map
area with respect to the extent set in this panel. It consists of two tabs differing in the set of
fearures:
· Map tab,
· World tab.
The size, shape and position of the Map area extent is indicated on the MiniMap panel extent by
the red semi-transparent rectangle. The center of the extent is where the red vertical and
horizontal lines cross. The rectangle combined with the vertical and horizontal line is called the 
View-finder.

To drag the extent of the Map area using the MiniMap panel
1. Move the mouse pointer over the View-finder in the MiniMap panel.
2. Press and hold the left mouse button.
3. Move the mouse pointer to any place within the MiniMap panel and release the left mouse

button - both the MiniMap panel and the Map area will be updated immediately.

5.4.1 Map

Description
The Map tab of the MiniMap panel localizes the extent visible within the Map area with respect to
the extent previously transferred from the Map area.

Map tab of the MiniMap panel displaying sample data.

To transfer the extent visible on the Map area to the Map tab
1. Use the Zoom mode, Zoom extended mode and Drag mode to adjust the extent visible on the
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Map area.
2. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
3. Open the context menu over the MiniMap panel and click on the Draw MiniMap item.

To clear the Map tab
1. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the Clear item.

To export the extent visible within the Map tab into a web quality image file of JPG format
1. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the Export to image... item - this

invokes the Export to image dialog box.
3. Within the Export to image dialog box select the appropriate drive from the Save in list.
4. Locate the folder where you would like to store the image file. A new folder can be created by

clicking on the  icon at the top-right corner of the Export to image dialog box, entering its
name and pressing the Enter key.

5. Enter a name for the image file in the File name list.
6. Click on the Save button.

IMPORTANT
Changing colors will take effect only when the extent of the Map tab has been transfered via the
Legend panel (see To transfer any layer listed in the Legend panel to the Map tab above).

To change the background color of the Map tab
1. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the Colors/Background color item -

this invokes the Color dialog box.
3. Pick or define a custom color and click on the OK button.

To change the color of the layer open in the Map tab
1. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the Colors/Layer color item - this

invokes the Color dialog box.
3. Pick or define a custom color and click on the OK button.

To change the color of the View-finder on the Map tab
1. Make sure that the Map tab is the active tab of the MiniMap panel. If not, click on its name at the

bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the Colors/View-finder color item -

this invokes the Color dialog box.
3. Pick or define a custom color and click on the OK button.

5.4.2 World

Description
The World tab of the MiniMap panel localizes the extent visible within the Map area with respect to
one of the seven predefined vector layers. The predefined layers show the filled contour of 
· World (as all continents),
· Europe,
· North America,
· South America,
· Asia,
· Africa,
· Australia.
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World tab of the MiniMap panel displaying sample data.

To switch the extent of the World tab to any of the seven predefined layers
1. Make sure that the World tab is the active tab of the MiniMap panel. If not, click on its name at

the bottom of the MiniMap panel.
2. Open the context menu over the MiniMap panel and click on the name of the desired layer.

5.5 Data

Description
The Data Panel is the Editor window component that provides the means to preview and edit the
attributes tables of the vector layers.

Data Panel displaying sample attributes tables.

To toggle the visibility of the Data panel, click on the View/Panels/Data menu item.

5.5.1 [+]

Description
Clicking on the [ + ] tab displays the list of vector layers which attribute tables are not open in the
Data panel.

To show the attributes table of a vector layer in the Data panel
1. Make sure that the Data panel is open. If not, click on the View/Panels/Data menu item.
2. Click on the [ + ] tab at the top of the Data panel - this displays the list of vector layers which are

not loaded into the Data panel.
3. Click on the desired layer name on the drop down list.

Equivalent actions
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The same function can be activated by selecting the desired layer in the Legend panel and clicking
on the Layer/Show attributes table menu item. Another way is to expand the context menu over
the desired layer name in the Legend panel and clicking on the Show attributes table item on the
drop down list.

5.5.2 Operations and Contex menu

Description
In the case of the Data panel the Operations button and the context menu display the same set of
features.

5.5.2.1 Flash current shape

Description
Clicking on the Operations/Flash current shape menu item makes the shape which record is
selected in the Data panel blink for a second within the Map area. Despite the layer color settings
the selected shape will blink sequentially in red and yellow.

To make a shape selected in the Data panel blink within the Map area
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Within the Data panel select the attributes record of the desired shape.
3. Click on the Operations/Flash current shape menu item.

5.5.2.2 Zoom to current shape

Description
Clicking on the Operations/Zoom to current shape menu item sets the extent visible in the Map
area to cover the shape which record is selected in the Data panel.

To zoom to the shape selected in the Data panel
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Within the Data panel select the attributes record of the desired shape.
3. Click on the Operations/Zoom to current shape menu item.

5.5.2.3 Copy selected row(s) to clipboard

Description
Clicking on the Operations/Copy selected row(s) to clipboard menu item copies the records
selected in the Data panel to the system clipboard. The records are copied as a text in separate
lines with tab-separated attributes values.

To copy a record or multiple records from the Data panel to the system clipboard
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. [OPTIONAL] If multiple records are to be selected press and hold the Ctrl key.
3. Within the Data panel click on the desired record. [OPTIONAL] Repeat this step until all desired

records are selected.
4. [OPTIONAL] Release the Ctrl key.
5. Click on the Operations/Copy selected row(s) to clipboard menu item.

5.5.2.4 Auto zoom

Description
Clicking on the Operations/Auto zoom menu item toggles the automatic zooming to the shape
which record is selected in the Data panel.

To toggle the Auto zoom feature, click on the Operations/Auto zoom menu item.
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5.5.2.5 Select group and zoom to

Description
Clicking on the Operations/Select group and zoom to menu item selects all shapes from the active
attribute group and sets the extent of the Map area to cover the selected shapes. For more
information about grouping shapes by attributes refer to the Grouping help topic.

To select all shapes from the active attribute group and zoom to them, click on the
Operations/Select group and zoom to menu item.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

5.5.2.6 Selections

Description
Clicking on the Operations/Selections menu item displays the list of features used for automatic
shape selecting.

To display the list of features used for automatic shape selecting, click on the
Operations/Selections menu item.

5.5.2.6.1  Select group

Description
Clicking on the Operations/Selections/Select group menu item selects all shapes from the active
attribute group. For more information about grouping shapes by attributes refer to the Grouping
help topic.

To select all shapes from the active attribute group, click on the Operations/Selections/Select
group menu item.

Associated functions
To transfer the selected shapes to the temporary clipboard layer, use one of the following
functions: Cut, Copy, Copy Special, Load Clipboard.
To remove the selected shapes from the layer, use the Delete Shape feature.
To cancel all previously made selections, use the Deselect all feature.

Note
· All currently selected shapes are highlighted on the Map area.
· Values (or averages, maximal and minimal numeric values) of attributes of the selected shape

(or shapes) are displayed in the Attributes tab of the Selected panel.

5.5.2.6.2  Deselect group

Description
Clicking on the Operations/Selections/Deselect group menu item deselects all shapes from the
active attribute group. For more information about grouping shapes by attributes refer to the 
Grouping help topic.

To deselect all shapes from the active attribute group, click on the
Operations/Selections/Deselect group menu item.
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Note
· All currently selected shapes are highlighted on the Map area.
· Changing the active layer cancels all previously made selections.

5.5.2.6.3  Select all

Description
The Select all item of the Data panel Operations menu is equivalent to the Select/Select all menu
item. For detailed information see the Select all help topic.

5.5.2.6.4  Invert Selection

Description
The Invert selection item of the Data panel Operations menu is equivalent to the Select/Invert
selection menu item. For detailed information see the Invert selection help topic.

5.5.2.6.5  Deselect all

Description
The Deselect all item of the Data panel Operations menu is equivalent to the Select/Deselect all
menu item. For detailed information see the Deselect all help topic.

5.5.2.7 Show only current group

Description
Clicking on the Operations/Show/Hide/Show group menu item makes the shapes belonging to the
active attribute group the only shapes visible within the Map area. The visibility of layers other than
the active vector layer is not affected in any way. For more information about grouping shapes by
attributes refer to the Grouping help topic.

To make the Map area display only the shapes belonging to the active attribute group, click
on the Operations/Show/Hide/Show group menu item.

Associated functions
See Show Selected, Hide Selected, Show group, Hide group, Show all, Hide all.

5.5.2.8 Show/Hide

Description
Clicking on the Operations/Show/Hide menu item displays the list of features used for managing
the visibility of shapes within the Map area.

To display the list of features used for managing the visibility of shapes, click on the
Operations/Show/Hide menu item.

5.5.2.8.1  Show selected

Description
The Show selected item of the Data panel Operations menu is equivalent to the Select/Show
selected menu item. For detailed information see the Show selected help topic.

5.5.2.8.2  Hide selected

Description
The Hide selected item of the Data panel Operations menu is equivalent to the Select/Hide
selected menu item. For detailed information see the Hide selected help topic.



159Panels

(c)2000-2010 TatukGIS. All rights Reserved

5.5.2.8.3  Show group

Description
Clicking on the Operations/Show/Hide/Show group menu item makes the shapes belonging to the
active attribute group visible within the Map area. If all of this shapes are  already visible then no
action is taken. The visibility of layers other than the active vector layer is not affected in any way.
For more information about grouping shapes by attributes refer to the Grouping help topic.

To make the Map area display only the shapes belonging to the active attribute group, click
on the Operations/Show/Hide/Show group menu item.

Associated functions
See Show Selected, Hide Selected, Show only current group, Hide group, Show all, Hide all.

5.5.2.8.4  Hide group

Description
Clicking on the Operations/Show/Hide/Hide group menu item makes the shapes belonging to the
active attribute group invisible within the Map area. The visibility of layers other than the active
vector layer is not affected in any way. For more information about grouping shapes by attributes
refer to the Grouping help topic.

To make the Map area hide all the shapes belonging to the active attribute group, click on
the Operations/Show/Hide/Hide group menu item.

Associated functions
See Show Selected, Hide Selected, Show only current group, Show group, Show all, Hide all.

5.5.2.8.5  Show all

Description
The Show all item of the Data panel Operations menu is equivalent to the Select/Show all menu
item. For detailed information see the Show all help topic.

5.5.2.8.6  Hide all

Description
The Hide all item of the Data panel Operations menu is equivalent to the Select/Hide all menu
item. For detailed information see the Hide all help topic.

5.5.2.9 Set column value

Description
The Set column value item of the Data panel Operations menu is equivalent to the Data/Set
column value menu item. For detailed information see the Set column value help topic.

5.5.2.10 Cached mode

Description
Clicking on the Operations/Cached mode menu item toggles the cached mode of the Data panel. If
the Operations/Cached mode menu item is checked, the columns header menu in the Data panel
display additional selection lists which can be used for attribute values filtering. In cases when this
feature is inactive the performance with very large and complicated vector data sets can be
dramatically improved.

To toggle the cached mode of the Data panel, click on the Operations/Cached mode menu
item.

Associated functions
See the Options Data panel help topic for information about automatic cached mode handling.
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5.5.3 Grouping

Description
The Data panel supports automatic shape grouping by the user specified attribute. Each group
created by the Grouping feature consists of shapes with the same attribute value.

To group shapes belonging to a vector layer according to some attribute
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Move the mouse pointer over the desired attribute column header and press the left mouse

button.
3. Holding the left mouse button move the mouse pointer over the blue field at the top of the

attributes table, i.e. the one indicated by "Drag a column header here to group by that column"
text.

4. Release the left mouse button.

To cancel the grouping
1. Make sure that the Data panel displays the attributes table of the desired layer. If not then click

on the tab with the right layer name at the top of the Data panel.
2. Move the mouse pointer over the rectangle with the attribute name on the blue field at the top of

the attributes table and press the left mouse button.
3. Holding the left mouse button move the mouse pointer over the attributes table.
4. Release the left mouse button.

5.5.4 Toolbar

Description
The Data panel toolbar provides quick access to the basic functions used to operate and filter
records within an attribute table.

Icon Name Description

First record Jumps to the first record within the current attribute table.

Prior page Jumps n records backward within the current attribute table; n is the
number of records visible at the current Data panel height.

Prior record Moves one record backward within the current attribute table.

Next record Moves one record forward within the current attribute table.

Next page Jumps n records forward within the current attribute table; n is the number
of records visible at the current Data panel height.

Last record Jumps to the last record within the current attribute table.

Edit record Starts editing of the selected cell.

Post edit Confirms changes done within the edited cell.

Cancel edit Cancels changes done within the edited cell.

Save Bookmark Bookmarks the selected record within the current attribute table; the
bookmark is preserved as long as the attribute table is open within the Data
panel.

Go to Bookmark Jumps to the bookmarked record.

Query Invokes the Data panel Query builder dialog box; refer to the Query builder
help topic for more information.

5.5.4.1 Query builder

Description
The Query builder is a component of the Data panel designed for records filtering. It provides the
means for graphical creation of a query filter. When executed, only the records for which the query
statement has the logical value TRUE remain visible within the records table.
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Data panel Query builder displaying sample query.

To create a query filter
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Click on the  icon on the Data panel Toolbar - this invokes the Query builder dialog box.
3. Within the Query builder dialog box use the graphical tool to create the query filter.
4. [OPTIONAL] Click on the Apply button to preview the result within the attributes table.
5. Click on the OK button.

To use a query filter stored in a file
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Click on the  icon on the Data panel Toolbar - this invokes the Query builder dialog box.
3. Within the Query builder dialog box click on the Open... button - this invokes the Open an

existing query dialog box.
4. Within the Open an existing query dialog box select the appropriate drive from the Look in list.
5. Locate the query filter file by entering the directory that contains this file.
6. Double-click on the file name - this loads the query filter and brings back the Query builder

dialog box.
7. [OPTIONAL] Click on the Apply button to preview the result within the attributes table.
8. Click on the OK button.

To save a query filter to a file
1. Open the attributes table of the desired layer using the [ + ] button (see here) or the Show

attributes table feature.
2. Click on the  icon on the Data panel Toolbar - this invokes the Query builder dialog box.
3. Within the Query builder dialog box use the graphical tool to create the query filter.
4. [OPTIONAL] Click on the Apply button to preview the result within the attributes table.
5. Click on the Save As... button - this invokes the Save the active query to file dialog box.
6. Within the Save the active query to file dialog box select the appropriate drive from the Save in

list.
7. Locate the folder where you would like to store the query filter file. A new folder can be created 

by clicking on the  icon at the top-right corner of the Save the active query to file dialog box,
entering its name and pressing the Enter key.

8. Enter a name for the query filter file in the File name list.
9. Click on the Save button - this brings back the Query builder dialog box.
10. Click on the OK button.

To activate/deactivate a query filter, check/uncheck the checkbox on the blue field containing
the query over the Data panel Toolbar.

To remove a query filter, click on the X button on the blue field containing the query over the
Data panel Toolbar.
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6 Scripter Studio

Scripter Studio window.

Description
The Scripter Studio is an Integrated Development Environment (IDE) - a complete solution for
creating, editing and executing scripts for the Editor. It can be invoked by clicking on any of the
Scripts/Scripter Studio menu items. The Scripter Studio allows to utilize the capabilities of almost
all Object Pascal and TatukGIS Developer Kernel procedures and functions using each of the two
supported scripting languages: Pascal and Basic. Moreover, the user can create advanced
Graphical User Interfaces (GUIs) with the power of Visual Component Library and TatukGIS
Developer Kernel Components.

Structure of a script
The code of the script is stored in the unit files. There are two types of unit files: non-GUI unit - raw
code file, GUI unit - code file with associated Graphical User Interface file. The default extension of
the Pascal unit files is PSC and of the Basic unit files is BSC. The GUI files default extension is
SFM. A script for the Editor consists of at least two files: a script project file - SSPROJ extension,
and a non-GUI main unit file. The script project file is automatically created and governed by the
Scripter Studio - the user never edits it directly. The GUI files are being edited indirectly using the
Scripter Studio form editor.

Binary scripts
The Scripter Studio provides the means to convert any script into binary form. This can be
especially useful when the user wants to publish a script without the source code. Moreover, a
script can be automatically converted into a package containing all necessary data in one file. For
more information on generating a binary script or making a package refer to the Compile and
Make package features help topics.
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6.1 Languages

IMPORTANT
This chapter of the Editor help system is entirely imported from the TMS Software (http://www.
tmssoftware.com/) Scripter Studio Pro help system. It covers all the languages and language
features that can be used to write scripts, language syntax, constructors, etc.

6.1.1 Pascal syntax

6.1.1.1 Overview

Current Pascal syntax supports:

· begin .. end constructor

· procedure and function declarations

· if .. then .. else constructor

· for .. to .. do .. step constructor

· while .. do constructor

· repeat .. until constructor

· try .. except and try .. finally blocks

· case statements

· array constructors, e.g. x := [ 1, 2, 3 ] ; 

· exit statement

· ^ , * , / , and , + , - , or , <> , >= , <= , = , > , < , div , mod , xor , shl , shr  operators

· access to object properties and methods, e.g. ObjectName.SubObject.Property 

6.1.1.2 Script structure

Script structure is made of two major blocks: a) procedure and function declarations, and b) main
block. Both are optional, but at least one should be present in script. There is no need for main
block to be inside begin .. end. It could be a single statement. Examples:

SCRIPT 1:

procedure DoSomething ;
begin
  CallSomething ;
end ;

begin
  CallSomethingElse ;
end ;

SCRIPT 2:

begin
  CallSomethingElse ;
end ;

SCRIPT 3:

function MyFunction ;
begin
  Result := 'Ok!' ;
end ;

SCRIPT 4:

http://www.tmssoftware.com/
http://www.tmssoftware.com/
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CallSomethingElse ;

Like in Pascal, statements should be terminated by ";" character. begin .. end blocks are
allowed to group statements.

6.1.1.3 Identifiers

Identifier names in script (variable names, function and procedure names, etc.) follow the most
common rules in Pascal: should begin with a character (a..z or A..Z), or '_', and can be followed by
alphanumeric chars or '_' char. Cannot contain any other character or spaces.

Valid identifiers:

VarName
_Some
V1A2
_____Some____

Invalid identifiers:

2Var
My Name
Some-more
This,is,not,valid

6.1.1.4 Assign statements

Just like in Pascal, assign statements (assign a value or expression result to a variable or object
property) are built using ":=". Examples:

MyVar := 2 ;
Button.Caption := 'This ' + 'is ok.' ;

6.1.1.5 Character strings

Strings (sequence of characters) are declared in pascal using single quote (') character. Double
quotes (") are not used. You can also use #nn to declare a character inside a string. There is no
need to use '+' operator to add a character to a string. Some examples:

A := 'This is a text' ;
Str := 'Text ' + 'concat' ;
B := 'String with CR and LF char at the end' + #13 + #10 ;
C := 'String with ' + #33 + #34 + ' characters in the middle' ;

6.1.1.6 Comments

Comments can be inserted inside script. You can use // chars or (* *) or { } blocks. Using //
char the comment will finish at the end of line. 

//This is a comment before ShowMessage
ShowMessage( 'Ok' ) ;

(* This is another comment *)
ShowMessage( 'More ok!' ) ;

{ And this is a comment
 with two lines }
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ShowMessage( 'End of okays' ) ;

6.1.1.7 Variables

There is no need to declare variable types in script. Thus, a variable can be declared just using 
var directive and its name. Examples:

SCRIPT 1:

procedure Msg ;
var 
  S : String ;
begin
  S := 'Hello world!' ;
  ShowMessage( S ) ;
end ;

SCRIPT 2:

var 
  A : Integer ;
begin
  A := 0 ;
  A := A + 1 ;
end ;

SCRIPT 3:

var S : String ;
S := 'Hello World!' ;
ShowMessage( S ) ;

6.1.1.8 Indexes

Strings, arrays and array properties can be indexed using "[" and "]" characters. For example, if
Str is a String variable, the expression Str[3] returns the third character in the string denoted
by Str, while Str[i + 1] returns the character immediately after the one indexed by i. More
examples:

MyChar := MyStr[2] ;
MyStr[1] := 'A' ;
MyArray[1,2] := 1530 ;
Lines.Strings[2] := 'Some text' ;

6.1.1.9 Arrays

To construct an array, use "[" and "]" characters. You can construct multi-index array by nesting
the array constructors. You can then access arrays using indexes. If an array is multi-index,
separate indexes using ",". If a variable is a variant array, script automatically supports indexing in
that variable. A variable is a variant array if it was assigned using an array constructor, if it is a
direct reference to a Delphi variable which is a variant array (see Delphi integration later) or if it
was created using VarArrayCreate procedure. 
Arrays in scripts have indexes starting from zero. Examples:

NewArray := [ 2, 4, 6, 8 ] ;
Num := NewArray[1] ; //Num receives "4"
MultiArray := [ ['green','red','blue'] , ['apple','orange','lemon'] ] ;
Str := MultiArray[0,2] ; //Str receives 'blue'
MultiArray[1,1] := 'new orange' ;
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6.1.1.10 If statements

There are two forms of if statements: if .. then and if .. then .. else. Like in normal
Pascal, if the if expression is true, the statement (or block) is executed. If there is the else part
and the expression is false, statement (or block) after else is executed. Examples:

if J <> 0 then Result := i / j ;

if J = 0 then exit else Result := i / j ;

if J <> 0 then
begin
  Result := i / j ;
  Count  := Count + 1 ;
end
else begin 
  Done := True ;
end ;

6.1.1.11 while statements

The while statement is used to repeat a statement or a block, while a control condition
(expression) is evaluated as true. The control condition is evaluated before the statement. Hence,
if the control condition is false at first iteration, the statement sequence is never executed. The
while statement executes its constituent statement (or block) repeatedly, testing expression before
each iteration. As long as expression returns true, execution continues. Examples:

while Data[i] <> x do i := i + 1 ;

while i > 0 do
begin
  if Odd( i ) then z := z * x ;
  i := i div 2 ;
  x := Sqr( x ) ;
end ;

while not Eof( InputFile ) do
begin
  ReadLn( InputFile, Line ) ;
  Process( Line ) ;
end ;

6.1.1.12 repeat statements

The syntax of a repeat statement is repeat statement_1 ; .. statement_n ; until
expression ; where expression returns a boolean value. The repeat statement executes its
sequence of constituent statements continuously, testing expression after each iteration. When
expression returns true, the repeat statement terminates. The sequence is always executed at
least once because expression is not evaluated until after the first iteration. Examples:

repeat
  k := i mod j ;
  i := j ;
  j := k ;
until j = 0 ;



167Scripter Studio

(c)2000-2010 TatukGIS. All rights Reserved

repeat
  Write( 'Enter a value (0..9): ' ) ;
  ReadLn( i ) ;
until ( i >= 0 ) and ( i <= 9 ) ;

6.1.1.13 for statements

Scripter Studio supports for statements with the following syntax: for counter :=
initial_value to final_value do statement ;. for statement sets counter to the
initial_value, repeats execution of statement (or block) and increments value of counter
until counter reaches the final_value. Examples:

SCRIPT 1:

for c := 1 to 10 do a := a + c ;

SCRIPT 2:

for i := a to b do
begin
  j := i ^ 2 ;
  sum := sum + j ;
end ;

6.1.1.14 case statements

Scripter Studio supports case statements with the following syntax:

case expression of
  case_1 : statement_1 ;
  ..
  case_i : statement_i ;
  ..
  case_n : statement_n ;
else
  else_statement ;
end ;

if expression matches the result of one of case_i expressions, the respective statement_i
(or block) will be executed. Otherwise,  else_statement will be executed. else part of case
statement is optional. Different from Delphi, case statement in script doesn't need to use only
ordinal values. You can use expressions of any type in both expression and case_i. Example:

case Uppercase( fruit ) of
  'lime'   : ShowMessage( 'green'  ) ;
  'orange' : ShowMessage( 'orange' ) ;
  'apple'  : ShowMessage( 'red'    ) ;
else
             ShowMessage( 'black'  ) ;
end ;

6.1.1.15 function and procedure declaration

Declaration of functions and procedures are similar to Object Pascal (Delphi), but there is no need
to specify variable types of the parameters and the return value. To return function value, use
implicitly declared Result variable. Examples:

procedure HelloWord ;
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begin
  ShowMessage( 'Hello world!' ) ;
end ;

procedure UpcaseMessage( msg : String ) ;
begin
  ShowMessage( Uppercase( msg ) ) ;
end ;

function TodayAsString : String ;
begin
  Result := DateToStr( Date ) ;
end ;

function Max( A, B ) ;
begin
  if A > B then
    Result := A
  else
    Result := B ;
end ;

procedure SwapValues( A, B ) ;
var 
  Temp ;
begin
   Temp := A    ;
   A    := B    ;
   B    := Temp ;
end ;

6.1.2 Basic syntax

6.1.2.1 Overview

Current Basic syntax supports:

· SUB .. END SUB and FUNCTION .. END FUNCTION declarations

· BYREF and DIM directives

· IF .. THEN .. ELSE .. END constructor

· FOR .. TO .. STEP .. NEXT constructor

· DO .. WHILE .. LOOP and DO .. LOOP .. WHILE constructors

· DO .. UNTIL .. LOOP and DO .. LOOP .. UNTIL constructors

· ^ , * , / , AND , + , - , OR , <> , >= , <= , = , > , < , DIV , MOD , XOR , SHL , SHR  operators

· TRY .. EXCEPT .. END and TRY .. FINALLY .. END blocks

· SELECT CASE .. END SELECT constructor

· array constructors, e.g. x = [ 1, 2, 3 ]

· EXIT statement

· access to object properties and methods, e.g. ObjectName.SubObject.Property

6.1.2.2 Script structure

Script structure is made of two major blocks: a) function and sub declarations and b) main block.
Both are optional, but at least one should be present in script. Some examples:

SCRIPT 1:

SUB DoSomething
  CallSomething
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END SUB

CallSomethingElse

SCRIPT 2:

CallSomethingElse

SCRIPT 3:

FUNCTION MyFunction
  MyFunction = "Ok!"
END FUNCTION

Like in normal Basic, statements in a single line can be separated by ":" character. 

6.1.2.3 Identifiers

Identifier names in script (variable names, function and procedure names, etc.) follow the most
common rules in Basic: should begin with a character (a..z or A..Z), or '_', and can be followed by
alphanumeric chars or '_' char. Cannot contain any other character or spaces.

Valid identifiers:

VarName
_Some
V1A2
_____Some____

Invalid identifiers:

2Var
My Name
Some-more
This,is,not,valid

6.1.2.4 Assign statements

Assign statements (assign a value or expression result to a variable or object property) are built
using "=". Examples:

MyVar = 2
Button.Caption = "This " + "is ok."

6.1.2.5 New statement

Scripter Studio provides the NEW statement for Basic syntax. Since you don't provide the method
name in this statement, Scripter Studio looks for a method named CREATE in the specified class. If
the method doesn't exist, the statement fails. Example:

MyLabel = NEW TLabel( Form1 )

MyFont = NEW TFont

In the above examples, a method named CREATE for TLabel and TFont class will be called. The
method must be registered. If the method receives parameters, you may pass the parameters in
parenthesis, like the TLabel example above.
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6.1.2.6 Character strings

Strings (sequence of characters) are declared in basic using double quote (") character. Examples:

A = "This is a text"
Str = "Text " + "concat"

6.1.2.7 Comments

Comments can be inserted inside script. You can use ' character or REM. Comment will finish at
the end of a line. Examples:

' This is a comment before ShowMessage
ShowMessage( "Ok" )

REM This is another comment
ShowMessage( "More ok!" )

' And this is a comment
' with two lines
ShowMessage( "End of okays" )

6.1.2.8 Variables

There is no need to declare variable types in script. Thus, you declare variable just using DIM
directive and its name. Examples:

SCRIPT 1:

SUB Msg
  DIM S
  S = "Hello world!"
  ShowMessage( S )
END SUB

SCRIPT 2:

DIM A
A = 0
A = A + 1
ShowMessage( A )

You can also declare global variables as private or public using the following syntax:

SCRIPT 3:

PRIVATE A
PUBLIC B
B = 0
A = B + 1
ShowMessage( A )

Variable declared with DIM statement are public by default. Private variables are not acessible
from other scripts.

Variables can be initialized using the following syntax:

DIM A = "Hello world"
DIM B AS Integer = 5
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6.1.2.9 Indexes

Strings, arrays and array properties can be indexed using "[" and "]" chars. For example, if Str is
a string variable, the expression Str[2] returns the third character in the string denoted by Str,
while Str[i + 1] returns the character immediately after the one indexed by i.  Examples:

MyChar = MyStr[2]
MyStr[1] = "A"
MyArray[1,2] = 1530
Lines.Strings[2] = "Some text"

6.1.2.10 Arrays

To construct an array, use "[" and "]" chars. You can construct multi-index array by nesting the
array constructors. You can then access arrays using indexes. If an array is multi-index, separate
indexes using ",". If a variable is a variant array, script automatically supports indexing in that
variable. A variable is a variant array if it was assigned using an array constructor, if it is a direct
reference to a Delphi variable which is a variant array (see Delphi integration later) or if it was
created using VarArrayCreate procedure. 
Arrays in scripts have indexes starting from zero. Examples:

NewArray = [ 2, 4, 6, 8 ]
Num = NewArray[1] 'Num receives "4"
MultiArray = [ ["green","red","blue"] , ["apple","orange","lemon"] ]
Str = MultiArray[0,2] 'Str receives 'blue'
MultiArray[1,1] = "new orange"

6.1.2.11 If statements

There are two forms of IF statement: IF .. THEN .. END IF and IF .. THEN .. ELSE
.. END IF. Like normal basic, if the if expression is true, the statements are executed. If there is
else part and expression is false, statements after else are executed. Examples:

IF j <> 0 THEN Result = i / j END IF

IF j = 0 THEN EXIT ELSE Result = i / j END IF

IF j <> 0 THEN
  Result = i / j
  Count = Count + 1
ELSE
  Done = True
END IF

If the IF statement is in a single line, you don't need to finish it with END IF:

IF j <> 0 THEN Result = i / j

IF j = 0 THEN EXIT ELSE Result = i / j

6.1.2.12 while statements

The WHILE statement is used to repeat a statement or a block, while a control condition
(expression) is evaluated as true. The control condition is evaluated before the statement. Hence,
if the control condition is false at first iteration, the statement sequence is never executed. The
while statement executes its constituent statement (or block) repeatedly, testing expression before
each iteration. As long as expression returns true, execution continues. Examples:

WHILE ( Data[i] <> x ) 
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  i = i + 1 
END WHILE

WHILE ( i > 0 )
  IF Odd( i ) THEN z = z * x END IF
  x = Sqr( x )
END WHILE

WHILE ( NOT Eof( InputFile ) )
  Readln( ReadLn, Line )
  Process( Line )
END WHILE

6.1.2.13 loop statements

Scripter Studio supports loop statements. The possible syntax is:

DO WHILE expression statements LOOP
DO UNTIL expression statements LOOP
DO statements LOOP WHILE expression
DO statement LOOP UNTIL expression

The statements will be executed WHILE expression is true, or UNTIL expression is true. If
expression is before statements, then the control condition will be tested before iteration.
Otherwise, control condition will be tested after iteration. Examples:

DO
  k = i MOD j
  i = j
  j = k
LOOP UNTIL j = 0

DO UNTIL i >= 0
  Write( "Enter a value (0..9): " )
  ReadLn( i )
LOOP

DO 
  k = i MOD j
  i = j
  j = k
LOOP WHILE j <> 0

DO WHILE i < 0 
  Write( "Enter a value (0..9): " )
  ReadLn( i )
LOOP

6.1.2.14 for statements

Scripter Studio supports for statements with the following syntax: FOR counter =
initial_value TO final_value STEP step_value statements NEXT. FOR
statement sets counter to the initial_value, repeats execution of statement until NEXT and
increments value of counter by step_value, until counter reachs final_value. The STEP
part is optional, and if omitted step_value is considered 1. Examples:

SCRIPT 1:

FOR c = 0 TO 10 STEP 2
  a = a + c
NEXT

SCRIPT 2:
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FOR i = a TO b
  j = i ^ 2
  sum = sum + j
NEXT

6.1.2.15 select case statements

Scripter Studio supports SELECT CASE statements with the following syntax:

SELECT CASE expression
  CASE case_1 statement_1
  ..
  CASE case_i statement_i
  ..
  CASE case_n statement_n
  CASE ELSE
    else_statement
END SELECT

If expression matches the result of one of case_i expressions, the respective statement_i
will be executed. Otherwise, else_statement will be executed. CASE ELSE part of SELECT
CASE statement is optional. Example:

SELECT CASE Uppercase( fruit )
  CASE "lime"   ShowMessage( "green"  )
  CASE "orange" ShowMessage( "orange" )
  CASE "apple"  ShowMessage( "red"    )
  CASE ELSE
                 ShowMessage( "black"  )
END SELECT

6.1.2.16 function and sub declaration

Declaration of functions and procedures are similar to Basic. To return function values, use
implicitly declared variable which has the same name  as the function, or use Return statement.
Parameters by reference can also be used, using BYREF directive. Examples:

SUB HelloWord
   ShowMessage( "Hello world!" )
END SUB

SUB UpcaseMessage( Msg )
   ShowMessage( Uppercase( Msg ) )
END SUB

FUNCTION TodayAsString
   TodayAsString = DateToStr( Date )
END FUNCTION

FUNCTION Max( a, b )
   IF a > b THEN
      Max = a
   ELSE
      Max = b
   END IF
END FUNCTION

SUB SwapValues( BYREF a, b )
   DIM temp
   temp = a
   a    = b
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   b    = temp
END SUB

You can also declare functions and procedures as private or public using the following syntax:

PRIVATE SUB Hello
END SUB

PUBLIC FUNCTION Hello
END FUNCTION

Procedures and functions are public by default. Private subs and functions are not accessible from
other scripts.

You can use Return statement to exit subs and functions. For functions, you can also return a
valid value. Examples:

SUB UpcaseMessage( Msg )
   ShowMessage( Uppercase( Msg ) )
   Return
   'This line will be never reached
   ShowMessage( "never displayed" )
END SUB

FUNCTION TodayAsString
   Return DateToStr( Date )
END FUNCTION

6.1.3 Calling dll functions

6.1.3.1 Overview

Scripter Studio allows importing and calling functions from external DLL libraries, by inserting
special directives in declaration of script routines, indicating library name and, optionally, the calling
convention, beyond the function signature.

External libraries are loaded by Scripter Studio on demand, before function calls, if not loaded yet
(dynamically or statically). To load and unload libraries explicitly, functions LoadLibary and
FreeLibrary from unit Windows can be used.

Note: to enable DLL function calls, you must set AllowDLLCalls property to true.

6.1.3.2 Pascal syntax

function function_name( arguments ) : result_type ; calling_convention ;
 external 'libName.dll' name external_function_name ;

For example, the following declaration:

function MyFunction( arg : integer ) : integer ; external
'CustomLib.dll' ;

imports a function called MyFunction from CustomLib.dll. Default calling convention, if not
specified, is register. Scripter Studio also allows to declare a different calling convention (
stdcall, register, pascal, cdecl or safecall) and to use a different name for DLL
function, like the following declaration:

function MessageBox( hwnd : pointer ; text, caption : String ; msgtype :
Integer ) : Integer ; stdcall ;external 'User32.dll' name 'MessageBoxA'
;

The above function imports function MessageBoxA from User32.dll (Windows API library),
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and names it MessageBox for usage in script.

Declaration above can be used for functions and procedures (routines without result value).

6.1.3.3 Basic syntax

FUNCTION LIB "libName.dll" ALIAS external_function_name
calling_convention function_name( arguments ) AS result_type

For example, the following declaration:

FUNCTION LIB "CustomLib.dll" MyFunction( arg AS Integer ) AS Integer

imports a function called MyFunction from CustomLib.dll. Default calling convention, if not
specified, is stdcall. Scripter Studio also allows to declare a different calling convention (stdcall,
register, pascal, cdecl or safecall) and to use a different name for DLL function, like the
following declaration:

FUNCTION MessageBox LIB "User32.dll" ALIAS "MessageBoxA" stdcall ( hwnd
AS pointer, text AS String, caption AS String, msgtype AS Integer ) AS
Integer

The above function imports function MessageBoxA from User32.dll (Windows API library),
and names it MessageBox for usage in script.

Declaration above can be used for functions and procedures (routines without result value).

6.1.3.4 Supported types

Scripter Studio supports following basic data types:

· Integer
· Boolean
· Char
· Extended
· String
· Pointer
· PChar
· Object
· Class
· WideChar
· PWideChar
· AnsiString
· Currency
· Variant
· Interface
· WideString
· Int64
· Longint
· Cardinal
· Longword
· Single
· Byte
· Shortint
· Word
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· Smallint
· Double
· Real
· DateTime
· Comp
· TObject descendants (class must be registered in scripter with DefineClass)

Others types (records, arrays, etc.) are not supported yet. Arguments of above types can be
passed by reference, by adding var (Pascal) or 
BYREF (Basic) in function parameters declaration.

6.2 Edit area

Description
The Edit area is a part of the Scripter Studio window where the script units are being edited. The
Edit area has two tabs: the Code tab used for editing code and the Design tab used for GUI
creation.

6.2.1 Code tab

Description
The Code tab of the Edit area is a part of the Scripter Studio window where the script code is being
edited.
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6.2.1.1 Context menu

Context menu item Equivalent menu item Help topic

Undo Edit/Undo link

Redo Edit/Redo link

Copy Edit/Copy link

Cut Edit/Cut link

Paste Edit/Paste link

Delete Edit/Delete link

Select All Edit/Select All link

6.2.2 Design tab

Description
The Design tab of the Edit area is a part of the Scripter Studio window where the script GUI form is
being created.

To add a component to the script GUI form, use the Tool Palette panel.

To edit the properties/events of a component, use the Object Inspector panel.

6.3 Menu

Description
The Scripter Studio menu is used to activate any of the Scripter Studio features.
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6.3.1 File

Description
The File menu group contains basic features used to manage unit and project files.

6.3.1.1 New Unit

Description
Clicking on the File/New Unit menu item provides for adding a new non-GUI unit to the current
script project. If no project is currently open then a standalone unit is created.

To add a new non-GUI unit to the current script project or create a standalone non-GUI unit
1. Click on the File/New Unit menu item - this invokes the Select language dialog box.
2. Within the Select language dialog box choose the desired scripting language from the drop

down list.
3. Click on the OK button.

Select language dialog box.

Equivalent actions

The same function can be initiated by clicking on the  icon on the File toolbar.

Associated functions
To create a new script project, use the New project feature.

Similar functions
To add a new GUI unit to the current script project, use the New Form feature.
To add an existing unit to the current script project, use the Open (add to project) feature.

6.3.1.2 New Form

Description
Clicking on the File/New Form menu item provides for adding a new GUI unit to the current script
project. If no project is currently open then a standalone unit is created.

To add a new GUI unit to the current script project or create a standalone GUI unit
1. Click on the File/New Form menu item - this invokes the Select language dialog box.
2. Within the Select language dialog box choose the desired scripting language from the drop

down list.
3. Click on the OK button.

Select language dialog box.
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Equivalent actions

The same function can be initiated by clicking on the  icon on the File toolbar.

Associated functions
To create a new script project, use the New project feature.

Similar functions
To add a new non-GUI unit to the current script project, use the New Unit feature.
To add an existing unit to the current script project, use the Open (add to project) feature.

6.3.1.3 New project

Description
Clicking on the File/New project menu item prepares the Scripter Studio for a new script project. It
closes all open units and resets project file settings.

To create a new script project
1. Click on the File/New project menu item - this invokes the Select language dialog box.
2. Within the Select language dialog box choose the desired scripting language from the drop

down list.
3. Click on the OK button.

Select language dialog box.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Project toolbar.

Associated functions
To add a new non-GUI unit to the current script project, use the New Unit feature.
To add a new GUI unit to the current script project, use the New Form feature.
To add an existing unit to the current script project, use the Open (add to project) feature.

Similar functions
To open an existing script project, use the Open project feature.

Note
· If the New project function is initiated while some project is open, the Scripter Studio will prompt

for saving any changes made to the current project before closing it.
· By default the Scripter Studio creates a two-units project: the main Unit1 is a non-GUI unit which

is used to activate the Unit2 GUI unit.

6.3.1.4 Open project

Description
Clicking on the File/Open project menu item provides for opening of a script project. Because a
script typically contains multiple units, this function opens all the unit files contained in a project,
along with all the GUI files, in a single step.

To open a script project
1. Click on the File/Open project menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
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3. Locate the project file by entering the directory that contains this file.
4. Double-click on the file name.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Project toolbar.

Associated functions
To add a new non-GUI unit to the current script project, use the New Unit feature.
To add a new GUI unit to the current script project, use the New Form feature.

Similar functions
To create a new script project, use the New project feature.
To add an existing unit to the current script project, use the Open (add to project) feature.

6.3.1.5 Open (add to project)

Description
Clicking on the File/Open (add to project) menu item provides for adding an existing unit file to the
current script project.

To add an existing unit file to the current project
1. Click on the File/Open (add to project) menu item - this invokes the Open dialog box.
2. Within the Open dialog box select the appropriate drive from the Look in list.
3. Locate the unit file by entering the directory that contains this file.
4. Double-click on the file name.

Equivalent actions

The same function can be initiated by clicking on the  icon on the File toolbar.

Similar functions
To open a script project, use the Open project feature.
To add a new non-GUI unit to the current script project, use the New Unit feature.
To add a new GUI unit to the current script project, use the New Form feature.

6.3.1.6 Remove from project

Description
Clicking on the File/Remove from project menu item closes the currently edited unit and removes it
from script project. The currently edited unit is the one displayed within the Edit area.

To remove a unit from a script project
1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. Click on the File/Remove from project menu item.
3. A message box will appear asking for confirmation of removal - click on the OK button.

Similar functions
To close a unit without removing it from a script project, use the Close file feature.

Note
· If the Scripter Studio detects unsaved changes in the unit being removed, it will prompt the user

to save the changes before continuing.

6.3.1.7 Save

Description
Clicking on the File/Save menu item provides for saving the current state of the currently edited
unit to the file to which it was previously saved. This overwrites the existing file destroying the
previous state of the unit. The currently edited unit is the one displayed within the Edit area.

To save the current state of a unit
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1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. Click on the File/Save menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the File toolbar.

Similar functions
To save a unit to a new location, use the Save as feature.
To save a script project, use the Save project as feature.
To save all open units and the script project in one step, use the Save all feature.

Key shortcut
This function can be initiated by pressing the Ctrl+S key combination.

6.3.1.8 Save as

Description
Clicking on the File/Save menu item provides for saving the current state of the currently edited
unit to a file. The currently edited unit is the one displayed within the Edit area.

To save the current state of a unit
1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. Click on the File/Save as menu item - this invokes the Save [unit name] as dialog box.
1. Within the Save [unit name] as dialog box select the appropriate drive from the Save in list.
2. Locate the folder where you would like to store the unit file. A new folder can be created by

clicking on the  icon at the top-right corner of the Save As dialog box, entering its name and
pressing the Enter key.

3. Enter a name for the unit file in the File name list.
4. Click on the Save button.

Similar functions
To save a unit to a previously specified file, use the Save feature.
To save a script project, use the Save project as feature.
To save all open units and the script project in one step, use the Save all feature.

6.3.1.9 Save project as

Description
Clicking on the File/Save project as menu item provides for saving the open script project to a file.
The project file contains all the information required to pull the project together. This includes the
list of units which compose the project, the paths to the files containing each unit, etc.

To save a new script project
1. Click on the File/Save project as menu item - this invokes the Save As dialog box.
2. Within the Save As dialog box select the appropriate drive from the Save in list.
3. Locate the folder where you would like to store the script project file. A new folder can be

created by clicking on the  icon at the top-right corner of the Save As dialog box, entering its
name and pressing the Enter key.

4. Enter a name for the project file in the File name list.
5. Click on the Save button.

To overwrite an existing project
1. Click on the File/Save Project As menu item - this invokes the Save As dialog box.
2. Within the Save As dialog box select the appropriate drive from the Save in list.
3. Locate the folder from which the script project has been opened.
4. Double-click on the project file name. A message box will appear asking for confirmation of the

overwrite operation - click on the OK button.
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Similar functions
To save a unit to a previously specified file, use the Save feature.
To save a unit to a new location, use the Save as feature.
To save all open units and the script project in one step, use the Save all feature.

Note
· If the units of the script project being saved were not saved before, the Scripter Studio will ask to

save them first. The procedure of saving the unit is the same as for the project.

6.3.1.10 Save all

Description
Clicking on the File/Save all menu item provides for saving both the changes to all the open units
since the last save operation and the script project file, in one step.

To save the current state of all open units and script project file, click on the File/Save all
menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Project toolbar.

Similar functions
To save a unit to a previously specified file, use the Save feature.
To save a unit to a new location, use the Save as feature.
To save a script project, use the Save project as feature.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+S key combination.

Note
· If the units or the project were never saved before, the Scripter Studio will ask to specify the

saving paths.

6.3.1.11 Close file

Description
Clicking on the File/Close file menu item closes the currently edited unit. The currently edited unit
is the one displayed within the Edit area.

To close a unit
1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. Click on the File/Close file menu item.

Associated functions
To remove a unit from a script project, use the Remove from project feature.

Similar functions
To close the project along with all units, use the Close all feature.

Note
· If the Scripter Studio detects unsaved changes in the unit being closed, it will prompt the user to

save the changes before continuing.

6.3.1.12 Close all

Description
Clicking on the File/Close all menu item closes the current script project along with all units. After
performing this action the Scripter Studio is ready for opening or creating a  new script
project/standalone unit.
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To close the current project along with all units, click on the File/Close all menu item.

Similar functions
To close only a single unit, use the Close file feature.

Note
· If the Scripter Studio detects unsaved changes in any of the open units, it will prompt the user to

save the changes before closing the project.

6.3.1.13 Exit

Description
Clicking on the File/Exit menu item closes the Scripter Studio.

To leave the Scripter Studio, click on the File/Exit menu item.

Note
· If the Scripter Studio detects unsaved changes in any of the open units, it will prompt the user to

save the changes before closing.

6.3.2 Edit

Description
The Edit menu group contains standard code and form editing features.

6.3.2.1 Undo

Description
Clicking on the Edit/Undo menu item cancels the most recent edit operation performed on script
code.

To undo the most recent edit operation, click on the Edit/Undo menu item.

Associated functions
To cancel the Undo operation, use the Redo feature.

Key shortcut
This function can be initiated by pressing the Ctrl+Z key combination.

Note
· If the context of the situation is such that it is impossible to Undo the most recent edit operation,

the Edit/Undo menu item will be inactive.

6.3.2.2 Redo

Description
Clicking on the Edit/Redo menu item restores the state before the Undo operation was performed.

To cancel the Undo operation, click on the Edit/Redo menu item.

Key shortcut
This function can be initiated by pressing the Shift+Ctrl+Z key combination.

Note
· If the context of the situation is such that it is impossible to Redo the most recent Undo

operation, the Edit/Redo menu entry will be inactive.
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6.3.2.3 Cut

Description
Clicking on the Edit/Cut menu item provides the means to transfer a piece of code or a GUI
component to the system clipboard. This operation removes the object being cut from its unit.

To cut a piece of code
1. Switch to the unit containing the desired code by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Within the Edit area find the piece of code, move the mouse pointer to its beginning and press

the left mouse button.
4. Move the mouse pointer to the end of the piece of code and release the left mouse button.
5. Click on the Edit/Cut menu item.

To cut a GUI component
1. Switch to the unit containing the desired component by clicking on its name at the top of the Edit

area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area find the component, move the mouse pointer over it and click.
4. Click on the Edit/Cut menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Edit toolbar.

Associated functions
To transfer a piece of code/component from the system clipboard to a unit, use the Paste feature.
To remove a piece of code/component from a unit, use the Delete feature.

Similar functions
To transfer a piece of code/component to the system clipboard without removing it from the unit,
use the Copy feature.

Key shortcut
This function can be initiated by pressing the Ctrl+X key combination.

6.3.2.4 Copy

Description
Clicking on the Edit/Copy menu item provides the means to transfer a piece of code or a GUI
component to the system clipboard. This operation does not remove the object being copied from
its unit.

To copy a piece of code
1. Switch to the unit containing the desired code by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Within the Edit area find the piece of code, move the mouse pointer to its beginning and press

the left mouse button.
4. Move the mouse pointer to the end of the piece of code and release the left mouse button.
5. Click on the Edit/Copy menu item.

To copy a GUI component
1. Switch to the unit containing the desired component by clicking on its name at the top of the Edit

area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area find the component, move the mouse pointer over it and click.
4. Click on the Edit/Copy menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Edit toolbar.
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Associated functions
To transfer a piece of code/component from the system clipboard to a unit, use the Paste feature.
To remove a piece of code/component from a unit, use the Delete feature.

Similar functions
To transfer a piece of code/component to the system clipboard and remove it from the unit, use
the Cut feature.

Key shortcut
This function can be initiated by pressing the Ctrl+C key combination.

6.3.2.5 Paste

Description
Clicking on the Edit/Paste menu item provides the means to transfer a piece of code or a GUI
component from the system clipboard to a unit.

To paste a piece of code
1. Switch to the destination unit by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Within the Edit area click on a place where you would like to insert the code.
4. Click on the Edit/Paste menu item.

To paste a GUI component
1. Switch to the destination unit by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area click on a place where you would like to insert the component.
4. Click on the Edit/Paste menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Edit toolbar.

Associated functions
To transfer a piece of code/component to the system clipboard and remove it from the unit, use
the Cut feature.
To transfer a piece of code/component to the system clipboard without removing it from the unit,
use the Copy feature.
To remove a piece of code/component from a unit, use the Delete feature.

Key shortcut
This function can be initiated by pressing the Ctrl+V key combination.

6.3.2.6 Delete

Description
Clicking on the Edit/Paste menu item provides the means to remove a piece of code or a GUI
component from a unit.

To delete a piece of code
1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Within the Edit area find the piece of code, move the mouse pointer to its beginning and press

the left mouse button.
4. Move the mouse pointer to the end of the piece of code and release the left mouse button.
5. Click on the Edit/Delete menu item.

To delete a GUI component
1. Switch to the destination unit by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area find the component, move the mouse pointer over it and click.
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4. Click on the Edit/Delete menu item.

Key shortcut
This function can be initiated by pressing the Ctrl+Del key combination.

6.3.2.7 Select All

Description
Clicking on the Edit/Select all menu item selects the whole code from the currently edited unit (Edit
area Code tab) or all the components from the currently edited GUI (Edit area Design tab).

To select the entirety of the edited code/all the components, click on the Edit/Select all menu
item.

6.3.2.8 Find

Description
Clicking on the Edit/Find menu item provides the means to search for a specific text within the
script code.

To search for a specific text within the script code
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Clicking on the Edit/Find menu item - this invokes the Find dialog box.
4. Within the Find dialog box enter the desired search phrase in the Find what text box.
5. Choose the direction of search from the Direction box - upward (Up) or downward (Down) from

the current cursor position.
6. To search only for whole words check the Match whole word only option. To make the search

case sensitive check the Match case option.
7. Click on the Find Next button.

Find dialog box.

Associated functions
To find the next match for the search defined in Find dialog box, use the Search again feature.

Similar functions
To search and replace a text within the script code, use the Replace feature.

Key shortcut
This function can be initiated by pressing the Ctrl+F key combination.

6.3.2.9 Replace

Description
Clicking on the Edit/Find menu item provides the means to search and replace a specific text
within the script code.

To search and replace a specific text within the script code
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Clicking on the Edit/Replace menu item - this invokes the Replace dialog box.
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4. Within the Replace dialog box enter the desired search phrase in the Find what text box.
5. Enter the replacement text in the Replace with text box.
6. Choose the direction of search from the Direction box - upward (Up) or downward (Down) from

the current cursor position.
7. To search only for whole words check the Match whole word only option. To make the search

case sensitive check the Match case option.
8. To perform only the search click on the Find Next button. To replace only the first match click on

the Replace button. To replace all matches in the current code click on the Replace All button.

Replace dialog box.

Similar functions
To search for a text within the script code, use the Find feature.

Key shortcut
This function can be initiated by pressing the Ctrl+R key combination.

6.3.2.10 Search again

Description
Clicking on the Edit/Search again menu item finds the next match for the search defined in the
Find dialog box (see the Find feature).

To find the next match for the search defined in the Find dialog box, click on the Edit/Search
again menu item.

6.3.2.11 Align to Grid

Description
Clicking on the Edit/Align to Grid menu item snaps all the components of the currently edited GUI
form to the closest grid points.

To align all the components to the grid points
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Click on the Edit/Align to Grid menu item.

6.3.2.12 Bring to Front

Description
Clicking on the Edit/Bring to Front menu item gives the selected GUI component the highest
visibility priority, i.e. this component will always be visible as on top of all the other components.

To put a GUI component on top of all the other components
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area click on the desired component to make a selection.
4. Click on the Edit/Bring to Front menu item.
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Associated functions
To move a GUI component behind all the other components, use the Send to Back feature.

6.3.2.13 Send to Back

Description
Clicking on the Edit/Send to Back menu item gives the selected GUI component the lowest
visibility priority, i.e. this component will always be visible as behind all the other components.

To put a GUI component behind all the other components
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Edit area click on the desired component to make a selection.
4. Click on the Edit/Send to Back menu item.

Associated functions
To put a GUI component on top all the other components, use the Bring to Front feature.

6.3.2.14 Align

Description
Clicking on the Edit/Align menu item provides the means to change the alignment of the selected
GUI components. The user can choose between predefined 6 horizontal and 6 vertical alignments.

To change the alignment of some GUI components
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Hold down the Shift key.
4. Within the Edit area click on the desired components to make a selection.
5. Release the Shift key.
6. Click on the Edit/Align menu item - this invokes the Alignment dialog box.
7. Choose appropriate horizontal and vertical alignment.
8. Click on the OK button.

Alignment dialog box.

Similar functions
To change the size of some GUI components, use the Size feature.

6.3.2.15 Size

Description
Clicking on the Edit/Size menu item provides the means to change the size of the selected GUI
components. The user can choose between predefined 4 horizontal and 4 vertical size modifiers.

To change the size of some GUI components
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1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Hold down the Shift key.
4. Within the Edit area click on the desired components to make a selection.
5. Release the Shift key.
6. Click on the Edit/Size menu item - this invokes the Size dialog box.
7. Choose appropriate horizontal and vertical size modifier.
8. Click on the OK button.

Size dialog box.

Similar functions
To change the alignment of some GUI components, use the Align feature.

6.3.2.16 Tab Order

Description
Clicking on the Edit/Tab Order menu item provides the means to rearrange the GUI components
tab ordering. The tab order is the order of switching between the components using the Tab key.

To rearrange the tab order list
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Click on the Edit/Tab Order menu item - this invokes the Edit tab order dialog box.
4. Within the Edit tab order dialog box click on the desired component name.
5. To move the component upwards on the tab order list click on the up arrow button. To move the

component downwards on the tab order list click on the down arrow button.
6. Repeat the steps from 4 to 5 until the desired result is achieved.
7. Click on the OK button.
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Edit tab order dialog box.

6.3.2.17 Lock controls

Description
Clicking on the Edit/Lock controls menu item locks the size and the alignment of all the GUI
components.

To lock the size and the alignment of all the GUI components
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Click on the Edit/Lock controls menu item.

6.3.3 View

Description
The View menu group contains features used to manage the appearance of the Scripter Studio.

6.3.3.1 Object Inspector

Description
Clicking on the View/Object inspector menu item opens the Object inspector panel.

IMPORTANT
All information concerning the Object inspector is available in the Scripter Studio/Panels/Object
inspector section of this help system (see here).

To open the Object inspector panel, click on the View/Object inspector menu item.

6.3.3.2 Tool Palette

Description
Clicking on the View/Tool Palette menu item opens the Tool Palette panel.

IMPORTANT
All information concerning the Tool Palette is available in the Scripter Studio/Panels/Tool Palette
section of this help system (see here).

To open the Tool Palette panel, click on the View/Tool Palette menu item.

6.3.3.3 Watches

Description
Clicking on the View/Watches menu item opens the Watches panel.

IMPORTANT
All information concerning the Watches is available in the Scripter Studio/Panels/Watches section
of this help system (see here).

To open the Watches panel, click on the View/Watches menu item.

6.3.3.4 Toggle Form/Unit

Description
Clicking on the View/Toggle Form/Unit menu item switches between the Code and the Design edit
mode of a GUI unit.

To switch between the Code and the Design edit mode of a GUI unit, click on the View/Toggle
Form/Unit menu item.
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Equivalent actions
The same can be achieved by clicking on the Code or Design tab at the bottom of the Edit area.

6.3.4 Run

Description
The Run menu group contains features used to execute and debug a script.

6.3.4.1 Run

Description
Clicking on the Run/Run menu item executes the currently open script and starts the debug
process. The debug process informs the user about any errors that may occur during the
execution. If there are no bugs in the script code then the script produces its result and terminates
in the proper way.

To execute a script/start the debug process, click on the Run/Run menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Key shortcut
This function can be initiated by pressing the F9 key.

6.3.4.2 Compile

Description
Clicking on the Run/Compile menu item checks the currently open script for the correctness of
code structure, semantics and syntax. If the script passes the test a 'Project compiled' message
appears and the binary version of the script is generated. The binary version of the script consists
of all files with CODE extension found in the script project directory. It can be executed as the
normal, source code version through the Editor scripts Open
feature.

To compile the currently open script, click on the Run/Compile menu item.

Key shortcut
This function can be initiated by pressing the Ctrl+F9 key combination.

Similar functions
To make a binary script package (single file), use the Make package feature.

6.3.4.3 Make package

Description
Clicking on the Run/Make package menu item provides for creation of a package from the
currently open script project. A script package is a single file containing the binary version of a
script along with all other necessary data. 

To make a package from the currently open script
1. Click on the Run/Make package menu item - this invokes the Make package dialog box.
2. If the script package should be password protected, click on the Password protected check box

within the Make package dialog box and type the password in the text area below the check
box.

3. If the script package should contain basic information (name, group (type), author, contact
and/or description) click on the Generate info file and fill in all desired fields in the Info file
settings group box.

4. Click on the OK button.
5. If the script package was successfully created a 'Make successful' message box appears. To

show the path to the newly created package click on the arrow beside 'Click to see more' label.
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Make package dialog box.

Message box displayed after successful package creation.

Associated functions
To execute a script package, use the Open feature.

Similar functions
To produce the binary version of a script, use the Compile feature.

Note
· A script package file has the SSPKG extension.
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6.3.4.4 Step over

Description
Clicking on the Run/Step over menu item provides for line-by-line script execution. When using
the Step over feature the Scripter Studio executes the procedures/functions called from the
procedure/function being debugged without pausing.

To execute a procedure/function line-by-line without entering the called
procedures/functions
1. Use the Toggle breakpoint feature to add a breakpoint inside the procedure/function of interest.
2. Execute the script up to the breakpoint by using the Run feature.
3. Click on the Run/Step over menu item to continue with the line-by-line execution. Repeat this

step as many times as needed.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Associated functions
To abort the execution of a script, use the Script reset feature.

Similar functions
To perform the line-by-line script execution with entering the called procedures/functions, use the 
Trace into feature.

Key shortcut
This function can be initiated by pressing the F8 key.

6.3.4.5 Trace into

Description
Clicking on the Run/Trace into menu item provides for line-by-line script execution. When using
the Trace into feature the Scripter Studio executes line-by-line the procedures/functions called
from the procedure/function being debugged.

To execute a procedure/function line-by-line with entering the called procedures/functions
1. Use the Toggle breakpoint feature to add a breakpoint inside the procedure/function of interest.
2. Execute the script up to the breakpoint by using the Run feature.
3. Click on the Run/Trace into menu item to continue with the line-by-line execution. Repeat this

step as many times as needed.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Associated functions
To abort the execution of a script, use the Script reset feature.
To execute a called procedure/function without pausing, use the Run until return feature.

Similar functions
To perform the line-by-line script execution without entering the called procedures/functions, use
the Step over feature.

Key shortcut
This function can be initiated by pressing the F7 key.

6.3.4.6 Run to cursor

Description
Clicking on the Run/Run to cursor menu item executes the currently open script up to the point in
the code indicated by the text cursor in the Edit area.
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To execute a script up to a desired point
1. Switch to the desired unit by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Within the Edit area move the mouse pointer over the place, where you would like to pause the

execution and click.
4. Click on the Run/Run to cursor menu item.

Key shortcut
This function can be initiated by pressing the F4 key.

6.3.4.7 Run until return

Description
When a procedure/function has been entered using the Trace into feature then clicking on the
Run/Run until return menu item executes the rest of the current procedure/function without
pausing.

To execute the rest of a procedure/function entered using the Trace into feature without
pausing, click on the Run/Run until return menu item.

Associated functions
To abort the execution of a script, use the Script reset feature.

Key shortcut
This function can be initiated by pressing the Shift+F11 key combination.

6.3.4.8 Pause

Description
Clicking on the Run/Pause menu item suspends the execution of a script. To continue the
execution of a script use the Run feature.

To suspend the execution of a script, Clicking on the Run/Pause menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Key shortcut
This function can be initiated by pressing the Shift+F9 key combination.

6.3.4.9 Script reset

Description
Clicking on the Run/Script reset menu item terminates the execution of a script at any time.

To abort the execution of a script, click on the Run/Script reset menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Key shortcut
This function can be initiated by pressing the Ctrl+F2 key combination.

6.3.4.10 Add watch

Description
Clicking on the Run/Add watch menu item provides the means to add a variable watch for the
debug process. By adding a watch the user can monitor the value of a variable during the
execution of a script.
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To add a watch
1. Click on the Run/Add watch menu item - this invokes the Scripter Studio Watch Properties

dialog box.
2. Within the Scripter Studio Watch Properties dialog box write the name of a desired variable in

the Expression text box.
3. Make sure that the Enabled check box is checked.
4. Click on the OK button.

Scripter Studio Watch Properties dialog box.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Key shortcut
This function can be initiated by pressing the Ctrl+F5 key combination.

6.3.4.11 Toggle breakpoint

Description
Clicking on the Run/Toggle breakpoint menu item toggles a breakpoint at the code line indicated
by the text cursor within the Edit area. The breakpoint is a virtual flag informing the Scripter Studio
to pause the execution process after reaching the indicated line.

To toggle a breakpoint at some line of a script unit
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. If the unit is of GUI type then click on the Code tab at the bottom of the Edit area.
3. Move the mouse pointer over the desired line and click to place the text cursor.
4. Click on the Run/Toggle breakpoint menu item.

Equivalent actions

The same function can be initiated by clicking on the  icon on the Run toolbar.

Key shortcut
This function can be initiated by pressing the F5 key.

6.3.5 Project

Description
The Project menu group contains features used to manage a script project.

6.3.5.1 Select Main Unit

Description
Clicking on the Edit/Select Main Unit menu item provides the means to set which unit is the script
main unit. The script main unit is the unit which the Scripter Studio uses to start the execution of a
script.

To set the script main unit
1. Clicking on the Edit/Select Main Unit menu item - this invokes the Select unit dialog box.
2. Within the Select unit dialog box choose the main unit from the Select main unit of the project

dropdown list.
3. Click on the OK button.
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Select unit dialog box.

6.3.6 Tools

Description
The Tools menu group contains options used to manage the basic settings of the Scripter Studio.

6.3.6.1 Designer Options

Description
Clicking on the Edit/Designer Options menu item provides the means to adjust the basic settings
of the Scripter Studio.

To adjust the settings of the Scripter Studio
1. Click on the Edit/Designer Options menu item - this invokes the Designer Options dialog box.
2. Within the Designer Options dialog box adjust the desired settings.
3. Click on the OK button.

Designer Options dialog box.

6.3.7 Help

Description
The Help menu group contains options used to bring up this help system and the TatukGIS
Developer Kernel help system.

6.3.7.1 Scripter Studio help

Description
Clicking on the Help/Scripter Studio help menu item opens the Scripter Studio section in the Editor
help system. It provides a brief description of all features and functionalities found in the Scripter
Studio as well as instructions to perform basic operations.

To invoke the Scripter Studio help system, click on the Help/Scripter Studio help menu item.
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6.3.7.2 Developer Kernel help

Description
Clicking on the Help/Developer Kernel help menu item opens the TatukGIS Developer Kernel help
system. It provides a brief description of all the classes and methods defined within the TatukGIS
Developer Kernel.

To invoke the TatukGIS Developer Kernel help system, click on the Help/Developer Kernel
help menu item.

6.4 Toolbars

Description
The Scripter Studio toolbars are used for quick access to most frequently used Scripter Studio
features.

6.4.1 Project

Description
The Project toolbar provides quick access to the project management features.

Icon Equivalent menu item Help topic

File/New project link

File/Open project link

File/Save all link

6.4.2 File

Description
The File toolbar provides quick access to the unit management features.

Icon Equivalent menu item Help topic

File/New Unit link

File/New Form link

File/Open (add to project) link

File/Save link

6.4.3 Edit

Description
The Edit toolbar provides quick access to the standard editing features.

Icon Equivalent menu item Help topic

Edit/Cut link

Edit/Copy link

Edit/Paste link
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6.4.4 Run

Description
The Run toolbar provides quick access to the script execution and debug features.

Icon Equivalent menu item Help topic

Run/Run link

Run/Pause link

Run/Script reset link

Run/Trace into link

 Run/Step over link

 Run/Toggle breakpoint link

 Run/Add watch link

6.5 Panels

Description
The Scripter Studio panels are window components providing many crucial functionalities related
to GUI creation and script debugging.

6.5.1 Object Inspector

Description
The Object Inspector panel provides the means to display and edit the properties/events of the
component currently selected on the GUI form displayed in the Design tab of the Edit area.
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Object Inspector panel displaying properties of the object named Form2 of TScriptForm class.

To add a component to the script GUI form, use the Tool Palette panel.
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6.5.2 Tool Palette

Description
The Tool Palette panel holds the list of all components available in the Scripter Studio. 

Tool Palette panel.

To add a component to the script GUI form
1. Switch to the unit of interest by clicking on its name at the top of the Edit area.
2. Click on the Design tab at the bottom of the Edit area.
3. Within the Tool Palette panel search for the desired component and click on it.
4. Click within the GUI form displayed on the Design tab of the Edit area to place the component.

To edit the properties/events of a component, use the Object Inspector panel.

6.5.3 Watches

Description
The Watches panel holds the list of script variables added by the user to the watch list and
monitors their values during the debugging process.

Watches panel monitoring the value of a variable named test_variable.

To add a variable to the watch list, use the Add watch feature.
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To remove a variable from the watch list
1. Click on the variable name within the Watches panel.
2. Press the Del key.

7 Standard toolbar

Description
The Standard toolbar provides quick access to the most frequently used Editor features.

Icon Equivalent menu item Help topic

File/New Project link

File/Open link

Layer/Add link

Layer/Remove link

File/Save All link

View/Panels/Data link

Edit/Undo link

Edit/Redo link

Edit/Cut link

Edit/Copy link

Edit/Copy Special link

Edit/Paste link

View/Full Extent link

View/Layer Extent link

View/Selected Extent link

View/Previous Extent link

View/Refresh map link

View/Zoom mode link

View/Zoom extended mode link

View/Drag mode link

Select/Localize
Select/Select by Point
Select/Select by Line
Select/Select by Polygon
Select/Select by Circle
Select/Select by Rectangle
Select/Clear Selection

link
link
link
link
link
link
link

Select/Deselect All link

Measure/Line
Measure/Polygon
Measure/Rectangle
Measure/Rectangle rotated
Measure/Circle

link
link
link
link
link

Shape/Edit shape link

Shape/New shape/Point
Shape/New shape/Multipoint
Shape/New shape/Line
Shape/New shape/Line 90°
Shape/New shape/Line free

link
link
link
link
link
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Shape/New shape/Close line
Shape/New shape/Close line 90°
Shape/New shape/Rectangle [line]
Shape/New shape/Rectangle rotated [line]
Shape/New shape/Circle [line]
Shape/New shape/Circle 3point base [line]
Shape/New shape/Polygon
Shape/New shape/Polygon 90°
Shape/New shape/Rectangle [polygon]
Shape/New shape/Rectangle rotated [polygon]
Shape/New shape/Circle [polygon]
Shape/New shape/Circle 3point base [polygon]

link
link
link
link
link
link
link
link
link
link
link
link

Shape/Revert shape link

8 Command Line parameters

Description
The Editor can be executed with a number of different command line parameters. The command
line parameters make the Editor act in different way in comparison to the default execution (without
parameters).

To execute the Editor with a command line parameter
1. Click on the Start button on the Windows taskbar - this invokes the Windows main menu.
2. Within the Windows main menu click on the Run... item - this invokes the Run dialog box.
3. Within the Run dialog box type cmd and press the Enter key - this invokes the Windows

Command Line.
4. Within the Windows Command Line type [drive letter]: , where the [drive letter] is the letter of the

drive on which the Editor is installed, and press the Enter key.
5. Type cd [Editor installation path] , where [Editor installation path] is the path to the folder where

the Editor is installed, and press the Enter key.
6. Type ttkEDT.exe /[parameter]=[path] and press the Enter key. For the list of available

parameters see Editor command line parameters below.

Editor command line parameters

Parameter Example Description

ss or StartupScript ttkEDT.exe /ss=C:\TatukGIS\startup.psc Force the Editor to use different
startup script for building the user
interface.

es or ExecuteScript ttkEDT.exe /es=C:\TatukGIS\sample.
ssproj

Executes the user specified script
immediately after the Editor
startup; terminates the Editor after
finishing the execution.

rs or RunScript ttkEDT.exe /rs=C:\TatukGIS\sample.
ssproj

Executes the user specified script
immediately after the Editor
startup.

sc or SyntaxCheck ttkEDT.exe /sc=C:\TatukGIS\sample.
ssproj > C:\TatukGIS\result.txt

Compiles a user specified script
and saves the compilation result to
a user specified text file.

c or Compile ttkEDT.exe /c=C:\TatukGIS\sample.ssproj Compiles a user specified script
and, if the compilation returns no
errors, generates the binary
version of the script.

Note
· The default Editor installation path is C:\Program Files\TatukGIS\Editor.
· The default Editor startup script is the file ttkEDT.psc located in the Editor installation path.
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